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Important precautions

Translation policy
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Damage in transportation

All packages should be closely examined at time of delivery. If 
damage is apparent, write “Damage In Shipment” on ALL copies 
of the freight or express bill BEFORE delivery is accepted or 
“signed for” by a GE representative or hospital receiving agent. 
Whether noted or concealed, damage MUST be reported to the 
carrier immediately upon discovery, or in any event, within 14 
days after receipt, and the contents and containers held for 
inspection by the carrier. A transportation company will not pay a 
claim for damage if an inspection is not requested within this 14 
day period.

Certified electrical contractor statement - For USA Only

All electrical Installations that are preliminary to positioning of 
the equipment at the site prepared for the equipment shall be 
performed by licensed electrical contractors. Other connections 
between pieces of electrical equipment, calibrations and testing 
shall be performed by qualified GE personnel. In performing all 
electrical work on these products, GE will use its own specially 
trained field engineers. All of GE’s electrical work on these 
products will comply with the requirements of the applicable 
electrical codes.

The purchaser of GE equipment shall only utilize qualified 
personnel (i.e., GE’s field engineers, personnel of third-party 
service companies with equivalent training, or licensed 
electricians) to perform electrical servicing on the equipment.
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Omission and errors

If there are any omissions, errors or suggestions for improving 
this documentation, contact the GE Global Documentation 
Group with specific information listing the system type, manual 
title, part number, revision number, page number and 
suggestion details.

Mail the
information to:

GE Medical Systems (China) Co., Ltd. 
No. 19 ChangJiang Road
Wuxi National Hi-Tech Dev.Zone
214028 Jiangsu China
TEL: +86 510 85225888; FAX: +86 510 85226688

GE employees should use TrackWise to report service 
documentation issues. 

These issues will then be in the internal problem reporting tool 
and communicated to the writer.

Service Safety Considerations

For a complete review of all safety requirements, refer to 
Chapter 1 in the Service Manual.

DANGER DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH, 
ARE PRESENT IN THIS EQUIPMENT. USE EXTREME 
CAUTION WHEN HANDLING, TESTING AND ADJUSTING.

WARNING Use all Personal Protection Equipment (PPE) such as gloves, 
safety shoes, safety glasses, and kneeling pad, to reduce the 
risk of injury. 
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Legal notes

The contents of this publication may not be copied or duplicated 
in any form, in whole or in part, without prior written permission 
of GE. 

GE may revise this publication from time to time without written 
notice.

Proprietary to GE

Permission to use this Advanced Service Software and related 
documentation (herein called the material) by persons other 
than GE employees is provided only under an Advanced 
Service Package License relating specifically to this Proprietary 
Material. This is a different agreement from the one under which 
operating and basic service software is licensed. A license to 
use operating or basic service software does not extend to or 
cover this software or related documentation.

If you are a GE employee or a customer who has entered into 
such a license agreement with GE to use this proprietary 
software, you are authorized to use this Material according to 
the conditions stated in your license agreement.

However, you do not have the permission of GE to alter, 
decompose or reverse-assemble the software, and unless you 
are a GE employee, you may not copy the Material. The 
Material is protected by Copyright and Trade Secret laws; the 
violation of which can result in civil damages and criminal 
prosecution.

If you are not party to such a license agreement or a GE 
Employee, you must exit this Material now.

Trademarks

All products and their name brands are trademarks of their 
respective holders.

Copyrights

All Material Copyright © 2020-2025 by 
General Electric Company Inc. All Rights Reserved.
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Chapter 1

Introduction

This chapter describes important issues related to 
safely servicing the Ultrasound system. The service 
provider must read and understand all the information 
presented here before installing or servicing the units. 
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1-1 Overview

1-1-1 Contents in this chapter

• 1-1 ‘Overview’ on page 1-2
• 1-2 ‘Manual Overview’ on page 1-3
• 1-3 ‘Important conventions’ on page 1-6
• 1-4 ‘Product icons’ on page 1-10
• 1-5 ‘Labels locations’ on page 1-11
• 1-6 ‘Safety considerations’ on page 1-13
• 1-7 ‘Dangerous procedure warnings’ on page 1-23
• 1-8 ‘Lockout/Tagout (LOTO) requirements’ on page 1-24
• 1-9 ‘Returning probes and repair parts’ on page 1-25
• 1-10 ‘EMC, EMI and ESD’ on page 1-26
• 1-11 ‘Customer assistance’ on page 1-28
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1-2 Manual Overview

This manual provides installation and service information for the 
Versana Active Ultrasound system. It is divided in ten chapters 
as shown below.

1-2-1 Contents in this manual

The manual is divided into ten chapters.

In the beginning of the manual, before chapter 1, you will find 
the Revision overview, the Important precautions including 
Translation policy, Damage in transportation, Certified electrical 
contractor statement, Omission & errors, Service safety 
considerations and Legal notes, and the Table of Contents 
(TOC).

An Index has been included after Chapter 10.

Table 1-1:  Contents in this manual 

Chapter 
number

Chapter title Description

1. Introduction Contains a content summary and warnings.

2. Site preparations Contains pre-setup requirements for the Versana 
Active.

3. System Setup Contains setup procedure with procedure 
checklist for the system.

4. General Procedures 
and Functional 
Checks

Contains functional checks that must be 
performed as part of the installation, or as 
required during servicing and periodic 
maintenance.

5. Components and 
Functions (Theory)

Contains block diagrams and functional 
explanations of the electronics.

6. Service Adjustments Contains instructions on how to make any 
available adjustments to the Versana Active.
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1-2-2 Typical users of the Proprietary Service Manual

• GEHC Service Personnel (setup, maintenance, etc.)
• GEHC Online Center Personnel
• Licensed Hospital’s Service Providers

1-2-3 Purpose of Operator Manual(s)
The Operator Manual(s) should be fully read and understood 
before operating the Versana Active and also kept near the unit 
for quick reference.

NOTE: Probe information displayed on screen does not necessarily 
reflect the probes available on your ultrasound system. Please 
refer to the probe list for available probes and features.

1-2-4 Versana Active models covered by this manual

NOTE: When not otherwise specified, the contents of this manual 
applies to all Versana Active models.

7. Diagnostics/
Troubleshooting

Provides procedures for running diagnostic or 
related routines for the Versana Active.

8. Replacement 
procedures

Provides disassembly procedures and 
reassembly procedures for all changeable FRU.

9. Renewal Parts Contains a complete list of replacement parts for 
Versana Active.

10. Care & Maintenance Provides periodic maintenance procedures for 
Versana Active.

N/A Index A quick way to the topic you’re looking for.

Table 1-1:  Contents in this manual  (Continued)

Chapter 
number

Chapter title Description

Table 1-2:  Versana Active Model Designations

Model Name System SW

Versana Active R1.1.x
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1-2-5 Smart Manual Function

On each page of this Proprietary Service Manual, there is a 
smart manual icon to bring you back to Overview of Versana 
Active. 

Figure 1-1. Smart Manual Icon
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1-3 Important conventions

1-3-1 Conventions used in book

Important conventions, used in this document, are described 
next.

1-3-1-1 Model designations

This manual covers the Versana Active Ultrasound systems 
listed in: 

1-2-4 ‘Versana Active models covered by this manual’ on 
page 1-4.

1-3-1-2 Icons

Pictures, or icons, are used wherever they will reinforce the 
printed message. The icons, labels, and conventions used on 
the product and in the service information are described in this 
chapter.
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1-3-1-3 Safety precaution messages

Various levels of safety precaution messages may be found on 
the equipment and in the service information. The different 
levels of concern are identified by a flag word that precedes the 
precautionary message. Known or potential hazards to 
personnel are labeled in one of three ways:

• DANGER
• WARNING
• CAUTION

NOTE: Notes are used to provide important information about an item 
or a procedure. 

NOTE: Be sure to read the notes; the information contained in a note 
can often save you time or effort.

DANGER
 

Danger is used to indicate the presence of a hazard that will 
cause severe personal injury or death if the instructions are 
ignored.

WARNING Warning is used to indicate the presence of a hazard that can 
cause severe personal injury and property damage if 
instructions are ignored.

CAUTION Caution is used to indicate the presence of a hazard that will or 
can cause minor personal injury and property damage if 
instructions are ignored. Equipment damage possible.
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1-3-2 Standard hazard icons

Important information will always be preceded by either the 
exclamation point (!) contained within a triangle, or the symbols 
for “Danger”, “Warning” or “Caution”, as seen throughout this 
chapter. In addition to text, several different graphical icons 
(symbols) may be used to make you aware of specific types of 
hazards that could possibly cause harm.

NOTE: Even if a symbol isn’t used on the product or in this manual, it 
may be included for your reference.

Table 1-3:   Standard hazard icons

ELECTRICAL

 

MECHANICAL

 

RADIATION

 

LASER

 

HEAT

 

PINCH
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1-3-2-1 Standard Icons that indicate that a special procedure is to be used

Some others icons make you aware of specific procedures that 
should be followed.

Be sure to read the notes; the information contained in a note 
can often save you time or effort.

Table 1-4:  Standard Icons that indicates that a special procedure is to be used

Avoid Static Electricity Tag and Lock Out Wear Eye Protection

 

 

 

Hand Protection Foot Protection Wear Eye Protection 

   



Introduction

1-10 Versana Active – Basic Service Manual
5840775-100 English Rev.10

1-4 Product icons

It is important to refer to the current revision of the Ultrasound 
system’s Basic User Manual for a full list of product labels prior 
to servicing the system.
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1-5 Labels locations

It is important to refer to the current revision of the Ultrasound 
system’s Basic User Manual for a full list of product labels prior 
to servicing the system.

1-5-1 Rating Plate Location

Versana Active labels are provided in English.

The labels are at the rear of the system. The label content may 
be different for different regions. Please refer to the labels on the 
system for the actual content.

Figure 1-2. Versana Active Rating Plate Label Location

NOTE: The rating plate in the graphic is only for illustration purpose.
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1-5-1 Rating Plate Location(continued)

1. Rating Plate

NOTE: If the new label is needed during the service activities, please 
click “Ask an Expert” to submit the case in the support central: 
http://supportcentral.ge.com/products/sup_products.asp?prod_ 
id=44177. And please use Internet Explorer to open the link.

Table 1-5:  Label Icons

Label/Icon Purpose/Meaning Location

Every system has a unique 
marking for identification, the 
Unique Device Identification 
(UDI) Label. The UDI label 
consists of a series of 
alpha-numeric characters and 
barcode which uniquely identify 
the Versana Active system as a 
medical device manufactured by 
General Electric. Scan or enter 
the UDI information into the 
patient health record as required 
by country-specific laws.

Rating plate

Serial Number. Rating plate
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1-6 Safety considerations

1-6-1 Contents in this section

• 1-6-2 ‘Introduction’ on page 1-13
• 1-6-3 ‘Human Safety’ on page 1-13
• 1-6-4 ‘Mechanical safety’ on page 1-16
• 1-6-5 ‘Electrical safety’ on page 1-19

1-6-2 Introduction

The following safety precautions must be observed during all 
phases of operation, service and repair of this equipment. 
Failure to comply with these precautions or with specific 
warnings elsewhere in this manual, violates safety standards of 
design, manufacture and intended use of the equipment.

1-6-3 Human Safety

• Operating personnel must not remove the system covers.
• Servicing should be performed by authorized personnel 

only. 

Only personnel who have participated in a Versana Active 
Training Seminar are authorized to service the equipment.

DANGER
 

DANGEROUS VOLTAGES, CAPABLE OF CAUSING 
DEATH, ARE PRESENT IN THIS EQUIPMENT. USE 
EXTREME CAUTION WHEN HANDLING, TESTING 
AND ADJUSTING.

WARNING If the covers are removed from an operating Versana Active, 
some metal surfaces may be warm enough to pose a potential 
heat hazard if touched, even while in shutdown mode.
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1-6-3 Human Safety(continued)

WARNING Because of the limited access to cabinets and equipment in the 
field, placing people in awkward positions, GE has limited the 
lifting weight for one person in the field to 16 KG (35 LBS). 
Anything over 16 KG (35 LBS) requires 2 people.

WARNING Have two people available to deliver and unpack the Versana 
Active. 

Attempts to move the Ultrasound system considerable 
distances or on an incline by one person could result in injury 
or damage or both.

WARNING Explosion Warning

DO NOT operate the equipment in an explosive atmosphere. 
Operation of any electrical equipment in such an environment 
constitutes a definite safety hazard.

WARNING DO NOT substitute parts or modify equipment

Because of the danger of introducing additional hazards, ONLY 
install GE approved parts. DO NOT perform any unauthorized 
modification of the equipment. 

WARNING Ensure that the Ultrasound system is turned off and unplugged.

Wait for at least 20 seconds for capacitors to discharge as 
there are no test points to verify isolation. The amber light on 
the OP panel ON/OFF button will turn off.

Ultrasound system components may be energized. Always 
refer to the Ultrasound system's Proprietary Service Manual for 
LOTO warnings and cautions.
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1-6-3 Human Safety(continued)

WARNING Risk of electrical shock, Ultrasound system must be turned off 
and disconnected from power source. Cord must be controlled 
at all times.

Wait for at least 20 seconds for capacitors to discharge as 
there are no test points to verify isolation. The amber light on 
the OP panel on/off button will turn off.

Ultrasound System components may be energized. Always 
refer to the Ultrasound system's Proprietary Service Manual for 
LOTO warnings and cautions

WARNING Use all Personal Protection Equipment (PPE) such as gloves, 
safety shoes, safety glasses, and kneeling pad, to reduce the 
risk of injury. 

WARNING Beware of possible sharp edges on all mechanical parts. If 
sharp edges are encountered, the appropriate PPE should be 
used to reduce the risk of injury.

WARNING Wear all PPE including gloves as indicated in the chemical 
MSDS.
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1-6-4 Mechanical safety

NOTE: Special care should be taken when transporting the Ultrasound 
system in a vehicle:

• Before transporting, place the system in its special storage 
case.

• Ensure that the system is firmly secured while inside the 
vehicle.

• Secure system with straps or as directed otherwise to 
prevent motion during transport.

• Prevent vibration damage by driving cautiously. Avoid 
unpaved roads, excessive speeds, and erratic stops or 
starts.

WARNING While the software install procedure is designed to preserve 
data, you should save any patient data, images, system setups 
to removable media or hardcopy before doing a software 
upgrade.

WARNING Ultrasound probes are highly sensitive medical instruments 
that can easily be damaged by improper handling. Use care 
when handling and protect from damage when not in use. Do 
NOT use a damaged or defective probe. Failure to follow these 
precautions can result in serious injury and equipment 
damage.

WARNING Never use a probe that has fallen to the floor. Even if it looks 
OK, it may be damaged.

CAUTION Take extra care when moving the system. 

The Versana Active weighs approximately 6kg or more, 
depending on installed peripherals, when ready for use. To 
avoid possible injury and equipment damage when 
transporting from one area of use to another:

• Use the handle to move the Ultrasound system.
• Do not let the Ultrasound system strike walls or door frame.
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1-6-4 Mechanical safety(continued)

WARNING When the Ultrasound system is raised for a repair or moved 
along any incline, use extreme caution since it may become 
unstable and tip over.

CAUTION To avoid inquiry when you move the monitor and the monitor 
arm, do not put your finger, hand, or object on the joint of the 
monitor or the monitor arm. 

CAUTION Use protective glasses during drilling, filing smooth surfaces, 
and during all other work where eyes need protection.

CAUTION Use safety shoes when doing work where there is any chance 
of foot injury.



Introduction

1-18 Versana Active – Basic Service Manual
5840775-100 English Rev.10

1-6-4 Mechanical safety(continued)

CAUTION Use protective gloves when working with sharp edges or when 
directed to wear PPE during a removal/replacement procedure.

CAUTION Be careful not to pinch any of the cables.
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1-6-5 Electrical safety

1-6-5-1 Safe practices

Follow these guidelines to minimize shock hazards whenever 
you are using the Ultrasound system:

• To minimize shock hazard, the equipment chassis must be 
connected to an electrical ground. 

• The Ultrasound system is equipped with a three-conductor 
AC power cable. This must be plugged into an approved 
electrical outlet with safety ground.

• The power outlet used for this equipment should not be 
shared with other types of equipment.

• Both the system power cable and the power connector must 
meet international electrical standards.

WARNING Connecting a Versana Active to the wrong voltage level will 
most likely destroy it.

WARNING DO NOT SERVICE OR DISASSEMBLE PARTS UNDER FRU 
UNIT LEVEL AT ANY CIRCUMSTANCES.
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1-6-5-2 Probes

Follow these guidelines before connecting a probe to the 
Ultrasound system:

• Inspect the probe prior to each use for damage or 
degradation to the:
• housing
• cable strain relief
• lens
• seal
• connector pins
• locking mechanism

• Do not use a damaged or defective probe. 
• Never immerse the probe connector or adapter into any 

liquid. 
• The system has more than one type of probe port. Use the 

appropriate probe port designed for the probe you are 
connecting. 

1-6-5-3 Peripherals

Refer to the Patient Safety Environment section of the User’s 
Manual for peripheral isolation information. 
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1-6-6 Battery Safety

NOTE: Battery in this section only refers to the battery pack applicable 
for Versana Active system. For Versana Active Advanced Cart 
Battery (optional), please refer to Versana Active Advanced Cart 
Battery User Instruction for detailed descriptions.

To avoid the risk of injury, follow the warning and cautions to 
make sure that the battery does not burst, ignite, or generate 
heat of fumes.

WARNING • The battery has a safety device. Do not disassemble or 
alter the battery.

• Charge and discharge the batteries only when the ambient 
temperature is between 10° and 40° C (50° F and 104° F).

• Do not short-circuit the battery by directly connecting the 
negative terminals with metal objects.

• Do not heat the battery or discard it in a fire.
• Do not expose the battery to temperature over 50° C 

(122° F). Keep it away from fire and other heat sources.
• Do not charge the battery near a heat source, such as a 

fire or heater.
• Do not leave the battery in direct sunlight.
• Do not drop packs from height to prevent them from 

possible malfunction damage.
• Do not pierce the battery with a sharp object, hit it, or step 

on it.
• Do not use a damaged battery.
• Do not solder a battery.
• Do not connect the battery to an electrical power outlet.
• Do not contact PCM (Power Control and Monitor, it’s a 

small board in the battery) directly to prevent packs from 
ESD damage.

• In case of longer non-use of the Versana Active, please 
make sure the battery is removed.
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1-6-6 Battery Safety(continued)

NOTE: The battery shall be shipped in about 30% charged state. Those 
packs have to be fully charged and discharged up to 3 times to 
utilize Li-lon smart packs before use.

NOTE: The label on service part will provided the information of expiry 
date. This date is only used for shelf life management. If it is 
expired, the battery needs to do a complete discharge and 
charge operation to extend shelf life. After the battery is installed 
on ultrasound system for using, the expiry date is no longer 
valid.

CAUTION To avoid the battery bursting, igniting, or fumes from the 
battery causing equipment damage, observe the following 
precautions:

• Do not immerse the battery in water or allow it to get wet.
• Do not put the battery into a microwave oven or pressurized 

container.
• If the battery leaks or emits an odor, remove it from all possible 

flammable sources.
• If the battery emits an odor or heat, is deformed or discolored, or 

in a way appears abnormal during use, recharging or storage, 
immediately remove it and stop using it. If you have any questions 
about the battery, consult GE or your local representative.

• Short term (less than one month) storage of battery pack:
• Store the battery in a temperature range between -5° C (23° 

F) and 50° C (122°F).

• Use only GE recognized batteries.
• In case of the long term (3 months or more) storage:

• Store the battery in a temperature range of -5° C (23° F) and 
50° C (122°F).

• When charging for the first time after long-term storage. 
Recover such packs to original performance through 
repeating several cycles of full charging and discharging.

• When store packs for more than 6 months, charge at lease 
once charging require per 6 months to prevent leakage and 
deterioration in performance due to self-discharging.

• When the system isn't powered on continuously more than 6 
months, in order to prevent leakage and deterioration in 
performance of CMOS battery, power on the system at least once 
per 6 months for more than 10 hours to have CMOS battery fully 
charged. Time and date need to be re-setup.
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1-7 Dangerous procedure warnings

Warnings, such as the example below, precede potentially 
dangerous procedures throughout this manual. Instructions 
contained in the warnings must be followed.

DANGER
 

DANGEROUS VOLTAGES, CAPABLE OF CAUSING 
DEATH, ARE PRESENT IN THIS EQUIPMENT. USE 
EXTREME CAUTION WHEN HANDLING, TESTING 
AND ADJUSTING.

WARNING If the covers are removed from an operating Versana Active, 
some metal surfaces may be warm enough to pose a potential 
heat hazard if touched, even while in shutdown mode.

WARNING Explosion Warning

DO NOT operate the equipment in an explosive atmosphere. 
Operation of any electrical equipment in such an environment 
constitutes a definite safety hazard.

WARNING DO NOT substitute parts or modify equipment

Because of the danger of introducing additional hazards, ONLY 
install GE approved parts. DO NOT perform any unauthorized 
modification of the equipment. 

WARNING SHUT DOWN FORCEDLY OR PLUG IN/OUT ACDC 
INVALID MAY CAUSE THE DAMAGE OF SYSTEM 
FILES.

WARNING AFTER UNPLUG POWER CORD, WAIT FOR AT LEAST 
20 SECONDS FOR CAPACITORS TO DISCHARGE AS 
THERE ARE NO TEST POINTS TO VERIFY 
ISOLATION.
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1-8 Lockout/Tagout (LOTO)

requirements

Follow Lockout/Tagout requirements by ensuring you are in total 
control of the AC power plug at all times during the service 
process.

To apply Lockout/Tagout (LOTO):

1. Plan and prepare for shutdown.
2. Shutdown the equipment.
3. Isolate the equipment.
4. Remove/disconnect the battery, if present.
5. Apply Lockout/Tagout Devices.
6. Control all stored and residual energy.
7. Verify isolation.

All potentially hazardous stored or residual energy is relieved.

WARNING Energy Control and Power Lockout for Versana Active.

When servicing parts of the Ultrasound system where there is 
exposure to voltage greater than 30 volts:

1. Follow LOCK OUT/TAG OUT procedures. 
2. Turn off the breaker.
3. Unplug the Ultrasound system.
4. Maintain control of the Ultrasound system power plug.
5. Wait for at least 30 seconds for capacitors to discharge as 

there are no test points to verify isolation.   

Ultrasound System components may be energized. 
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1-9 Returning probes and repair

parts

Equipment being returned must be clean and free of blood and 
other infectious substances. GE policy states that body fluids 
must be properly removed from any part or equipment prior to 
shipment. GE employees, as well as customers, are responsible 
for ensuring that parts/equipment have been properly 
decontaminated prior to shipment. Under no circumstance 
should a part or equipment with visible body fluids be taken or 
shipped from a clinic or site (for example, body coils or an 
ultrasound probe). 
The purpose of the regulation is to protect employees in the 
transportation industry, as well as the people who will receive or 
open this package.

NOTE: The US Department of Transportation (DOT) has ruled that 
“items that were saturated and/or dripping with human blood 
that are now caked with dried blood; or which were used or 
intended for use in patient care” are “regulated medical waste” 
for transportation purposes and must be transported as a 
hazardous material.

NOTE: The USER/SERVICE staff should dispose of all the waste 
properly, per federal, state, and local waste disposal regulations. 
The Ultrasound system is not meant to be used for long-term 
storage of patient data or images. The user is responsible for the 
data on the system and a regular backup is highly 
recommended.
If the system is sent for repair, please ensure that any patient 
information is backed up and erased from the system before 
shipping. It is always possible during system failure and repair to 
lose patient data. GE is not responsible for the loss of this data.
If PHI (Patient Healthcare Information) data needs to be sent to 
GE employees for service purposes, GE will ascertain 
agreement from the customer. Patient information shall only be 
transferred by approved service processes, tools and devices 
restricting access, protecting or encrypting data where required, 
and providing traceability in the form of paper or electronic 
documents at each stage of the procedure while maintaining 
compliance with cross-border restrictions of patient information 
transfers. 
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1-10 EMC, EMI and ESD

1-10-1 Electromagnetic Compatibility (EMC)

Electromagnetic compatibility describes a level of performance 
of a device within its electromagnetic environment. This 
environment consists of the device itself and its surroundings 
including other equipment, power sources and persons with 
which the device must interface. Inadequate compatibility results 
when a susceptible device fails to perform as intended due 
interference from its environment or when the device produces 
unacceptable levels of emission to its environment. This 
interference is often referred to as radio–frequency or 
electromagnetic interference (RFI/EMI) and can be radiated 
through space or conducted over interconnecting power of 
signal cables. In addition to electromagnetic energy, EMC also 
includes possible effects from electrical fields, magnetic fields, 
electrostatic discharge and disturbances in the electrical power 
supply.

1-10-2 CE Compliance 

Versana Active conforms to all applicable conducted and 
radiated emission limits and to immunity from electrostatic 
discharge, radiated and conducted RF fields, magnetic fields 
and power line transient requirements.

For applicable standards, refer to the Safety Chapter of the 
Ultrasound system User’s Manual. 

NOTE: For CE Compliance, it is critical that all covers, screws, 
shielding, gaskets, mesh, clamps, are in good condition, 
installed tightly without skew or stress. Proper installation 
following all comments noted in this service manual is required 
in order to achieve full EMC performance.
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1-10-3 Electrostatic discharge (ESD) prevention 

WARNING DO NOT touch any boards with integrated circuits prior to 
taking the necessary ESD precautions.

Always connect yourself, via an arm-wrist strap, to the advised 
ESD connection point located on the rear of the Ultrasound 
system (near the power connector).

Follow general guidelines for handling of electrostatic sensitive 
equipment.

WARNING Risk of electrical shock, Ultrasound system must be turned off. 
Avoid all contact with electrical contacts, conductors and 
components. Always use non-conductive handles designed for 
the removal and replacement of ESD sensitive parts. All parts 
that have the potential for storing energy must be discharged or 
isolated before making contact.
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1-11 Customer assistance

1-11-1 Contact information

If this equipment does not work as indicated in this service 
manual or in the basic user manual, or if you require additional 
assistance, please contact the local distributor or appropriate 
support resource, as listed below.

Before you call, identify the following information, and acquire 
log (Alt+D) to send to the Customer Care team:

1. System ID / serial number.
2. Software version.
3. Date and time of occurrence.
4. Sequence of events leading to issue.
5. Is the issue repeatable?
6. Imaging mode, probe, preset/application.
7. Media brand, speed, capacity, type.
8. Save secondary image capture, cine loop.

NOTE: Restart the application before resuming clinical scanning. 

NOTE: The serial number can be found at the rear of the system. 
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1-11-2 Phone numbers for Customer Assistance

1-11-3 System manufacturer

Table 1-6:  Phone numbers for Customer Assistance

LOCATION PHONE NUMBER

USA
GE Healthcare - GE Medical Systems 
Ultrasound Service Engineering
9900 Innovation Drive
Wauwatosa, WI 53226

Service: On-site 1-800-437-1171

Service Parts 1-800-558-2040

Application Support 1-800-682-5327 or
1-262-524-5698

Canada Phone: 1-800-668-0732

Latin America Service
Application Support

1-800-321-7937
1-262-524-5698

OLC - EMEA
Phone: +49 (0) 211 73744789

+33 1 3083 1300

Fax: +49 (0) 211 73744685

Online Services Ultrasound Asia Phone:
• Australia
• China
• India
• Japan
• Korea
• Singapore

+(61) 1-800-647-855
+(86) 800-810-8188
+(91) 1800-425-8025
+(81) 42-648-2940
+(82) 2620 13585
+(95) 6277-3444

Table 1-7:  Legal manufacturer

MANUFACTURER PHONE NUMBER FAX NUMBER

GE Medical Systems (China) Co., Ltd. 
No.19 Changjiang Road
WuXi National Hi-Tech Dev.Zone
214028 Jiangsu China

+86 510 85225888 +86 510 85226688

Europe (OLC-EMEA)
GE Healthcare GmbH

Peter-Müller-Straße 24-26

40468 Düsseldorf
Germany
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1-11-4 Authorized Representative

1-11-5 Factory Sites

Table 1-8:  Authorized Representative

AUTHORIZED REPRESENTATIVE
TELEPHONE / FAX 

NUMBER

The location of the CE marking is shown in the Safety chapter of the Basic User 
Manual.

Authorized EU Representative:
GE Medical Systems SCS
283 rue de la Minière 78530 BUC, France

Table 1-9:  Factory Sites

Factory Sites

GE Medical Systems (China) Co., Ltd.
No.19, Changjiang Road, Wuxi National Hi-Tech Dev.Zone,
214028 Jiangsu China

Wipro GE Medical Device Manufacturing Private Limited 
No. 4 Kadugodi Industrial Area
Sadarmangala, Whitefield,
Bangalore, Karnataka, India 560067
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Chapter 2

Site Preparations

This chapter provides the information required to plan 
and prepare for the setup of an Ultrasound system. 
Included the descriptions of the facility and electrical 
needs to be met by the purchaser of the units. 
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2-1 Overview

2-1-1 Contents in this chapter

• 2-1 ‘Overview’ on page 2-2
• 2-2 ‘General Ultrasound system requirements’ on page 2-3
• 2-3 ‘Facility needs’ on page 2-11
• 2-4 ‘Environmental Dangers’ on page 2-21
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2-2 General Ultrasound system

requirements

2-2-1 Contents in this section

• 2-2-2 ‘Ultrasound system environmental requirements’ on 
page 2-3

• 2-2-3 ‘Electrical requirements’ on page 2-6
• 2-2-4 ‘EMI limitations’ on page 2-8
• 2-2-5 ‘Probes environmental requirements’ on page 2-10
• 2-2-6 ‘Time and manpower requirements’ on page 2-10

2-2-2 Ultrasound system environmental requirements

2-2-2-1 If the Ultrasound system is very cold or hot 

When unpacking the Ultrasound system, allow the temperature 
of the Ultrasound system to stabilize before powering up. The 
following table describes guidelines for reaching operational 
temperatures from storage or transport temperatures.

CAUTION If the Ultrasound system is very cold or hot, do not turn on its 
power until it has had a chance to acclimate to its operating 
environment.

Table 2-1:  System Acclimation Time Chart

Degree C -4.5 -2 0.5 3 40 42.5 45 47.5 50 55 60

Degree F 23.9 28.4 32.9 37.4 104 108.5 113 117.5 122 131 140

hours 3 2 1 0 0 1 2 3 4 6 8
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2-2-2-2 Environmental specifications for Ultrasound system 

The system should be operated, stored, or transported within 
the parameters outlined below. Either its operational 
environment must be constantly maintained or the unit must be 
turned off.

Table 2-2:  System Environmental Requirements

Operational       
(Versana Active)

Storage         
(Versana Active) 

Transport     
(Versana Active) 

Temperature 10 - 40° C

50 - 104° F

-5 - 50° C

23 - 122° F

-5 - 50° C

23 - 122° F

Humidity 30 - 80% 
non-condensing

10 - 90% 
non-condensing

10 - 90% 
non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

CAUTION Ensure that the probe face temperature does not exceed the 
normal operation temperature range.

CAUTION The Versana Active system and probe connector is not 
waterproof. Do not expose the device to water or any kind of 
liquid.
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2-2-2-3 Cooling

The cooling requirement for a console Ultrasound system with 
monitor and on board peripherals, is up to 3800 BTU/h. This 
figure does not include cooling needed for lights, people, or 
other equipment in the room. 

NOTE: Each person in the room places an additional 300 BTU/h 
demand on the cooling system.

2-2-2-4 Lighting

Bright light is needed for Ultrasound system installation, updates 
and repairs. However, operator and patient comfort may be 
optimized if the room light is subdued and indirect. Therefore a 
combination lighting system (dim/bright) is recommended. Keep 
in mind that lighting controls and dimmers can be a source of 
EMI which could degrade image quality. These controls should 
be selected to minimize possible interference.
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2-2-3 Electrical requirements

2-2-3-1 General requirements

NOTE: GE requires a dedicated power and ground for the proper 
operation of its Ultrasound equipment. This dedicated power 
shall originate at the last distribution panel before the Ultrasound 
system.

Sites with a mains power system with defined Neutral and Live:

The dedicated line shall consist of one phase, a neutral (not 
shared with any other circuit), and a full size ground wire from 
the distribution panel to the Ultrasound outlet.

Sites with a mains power system without a defined Neutral:

The dedicated line shall consist of one phase (two lines), not 
shared with any other circuit, and a full size ground wire from the 
distribution panel to the Ultrasound outlet.

NOTE: Please note that image artifacts can occur, if at any time within 
the facility, the ground from the main facility's incoming power 
source to the Ultrasound system is only a conduit.

2-2-3-2 Electrical requirements for the Ultrasound system

In the table below, the electrical specifications for the Ultrasound 
system includes monitor and on board peripherals.

Table 2-3:  Electrical Specifications for Versana Active system

Voltage Tolerance Power Consumption Frequency

100-240 VAC ±10% Max. 200VA 50/ 60HZ
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2-2-3-3 Site circuit breaker

It is recommended that the branch circuit breaker for the 
Ultrasound system be readily accessible.

2-2-3-4 Site power outlets

A dedicated AC power outlet must be within reach of the 
Ultrasound system without extension cords. Other outlets 
adequate for the external peripherals, medical and test 
equipment needed to support this Ultrasound system must also 
be present within 1 m (3.2 ft.) of the Ultrasound system. 
Electrical installation must meet all current local, state, and 
national electrical codes.

2-2-3-5 Unit power plug

If the Ultrasound system arrives without a power plug, or with 
the wrong plug, you must contact your GE dealer or the 
installation engineer must supply what is locally required.

2-2-3-6 Power stability requirement

CAUTION POWER OUTAGE MAY OCCURE. 

The Versana Active requires a dedicated single branch circuit. 
To avoid circuit overload and possible loss of critical care 
equipment, make sure you DO NOT have any other equipment 
operating on the same circuit.

Table 2-4:  Power stability requirement

IEC 61000-4-11
Voltage dips, short 
interruptions and 
voltage variations on 
mains supply

< 5%T (> 95% dip) for 
0.5 cycle;

< 5%T (> 95% dip) for 
0.5 cycle;

Mains power 
quality should be 
that of a typical 
commercial or 
hospital 
environment.

40%T (60% dip) for 5 
cycles;

40%T (60% dip) for 5 
cycles;

70%T (30 dip) for 25 
cycles;

70%T (30 dip) for 25 
cycles;

< 5%T (>95% dip) for 5 
sec

< 5%T (>95% dip) for 5 
sec
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2-2-4 EMI limitations

Ultrasound systems are susceptible to Electromagnetic 
Interference (EMI) from radio frequencies, magnetic fields, and 
transients in the air or wiring. They also generate EMI. The 
Ultrasound system complies with limits as stated on the EMC 
label. However there is no guarantee that interference will not 
occur in a particular installation.

Possible EMI sources should be identified before the Ultrasound 
system is installed.

Electrical and electronic equipment may produce EMI 
unintentionally as the result of a defect. Some of these sources 
include:

• medical lasers
• scanners
• cauterizing guns
• computers
• monitors
• fans
• gel warmers
• microwave ovens
• light dimmers
• mobile phones
• in-house wireless phones (DECT phones)
• wireless computer keyboard and mouse
• air conditioning system
• High Frequency (HF) surgery equipment
• general AC/DC adapters
• portable phones

The presence of a broadcast station or broadcast van may also 
cause interference.

See: 2-2-4-1 ‘EMI prevention/abatement’ on page 2-9 for EMI 
prevention tips.
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2-2-4-1 EMI prevention/abatement

Table 2-5:  EMI prevention/abatement

EMI RULE DETAILS

Be aware of Radio 
Frequency sources

• Keep the Ultrasound system at least 5 meters (15 feet) away from other EMI 
sources.

• Special shielding may be required to eliminate interference problems caused by 
high frequency, high powered radio or video broadcast signals.

Ground the 
Ultrasound system

Poor grounding is the most likely reason an Ultrasound system will have noisy 
images. Check grounding of the power cord and power outlet.

Replace all screws, 
Radio Frequency 
gaskets, covers, 
cores

• After you finish repairing or updating the Ultrasound system, replace all covers 
and tighten all screws.

• Any cable with an external connection requires a magnet wrap at each end.
• Install all covers. Loose or missing covers or Radio Frequency gaskets allow 

radio frequencies to interfere with the ultrasound signals.

Replace broken 
Radio Frequency 
gaskets

If more than 20% or a pair of the fingers on an Radio Frequency gasket are 
broken, replace the gasket. Do not turn on the Ultrasound system until any loose 
metallic part is removed.

Do not place labels 
where Radio 
Frequency gaskets 
touch metal

Where applicable, never place a label where Radio Frequency gaskets meet the 
Ultrasound system. Otherwise, the gap created will permit Radio Frequency 
leakage. Or, if a label has been found in such a position, move the label.

Use GE specified 
harnesses and 
peripherals

The interconnect cables are grounded and require ferrite beads and other 
shielding. Also, cable length, material, and routing are all important; do not change 
from what is specified.

Take care with 
cellular phones

Cellular phones may transmit a 5 V/m signal; that could cause image artifacts.

Properly route 
peripheral cables

Where applicable, do not allow cables to lie across the top of the Card Rack or 
hang out of the peripheral bays. Loop the excess length for peripheral cables 
inside the peripheral bays. Attach the monitor cables to the frame.
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2-2-5 Probes environmental requirements

2-2-5-1 Operation, storage and transport temperatures for probes

Probes should be operated, stored, or transported within the 
parameters outlined below.

NOTE: Refer to Table 2-1 on page 2-3 to determine the needed 
settlement time.

2-2-6 Time and manpower requirements

Site preparation takes time. Begin site preparation checks as 
soon as possible, if possible, six weeks before delivery, to allow 
enough time to make any changes.

CAUTION Ensure that the probe face temperature does not exceed the 
normal operation temperature range.

Table 2-6:  Probe Environmental Requirements

Operational Storage Transport

Temperature 10° - 40° C
50° - 104° F

-5° - 50° C
23° - 122° F

-5° - 50° C
23° - 122° F

Humidity 30- 80%
non-condensing

10 - 90%
non-condensing

10 - 90%
non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

CAUTION Check the room temperature before you use the probe. 

CAUTION Ensure that the probe face temperature does not exceed the 
normal operation temperature range.
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2-3 Facility needs

2-3-1 Contents in this section 

• 2-3-2 ‘Purchaser responsibilities’ on page 2-12
• 2-3-3 ‘Required facility needs’ on page 2-13
• 2-3-4 ‘Desirable features’ on page 2-14
• 2-3-5 ‘Minimal floor plan suggestion’ on page 2-15
• 2-3-6 ‘Recommended floor plan suggestion’ on page 2-16
• 2-3-8 ‘Networking setup requirements’ on page 2-18
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2-3-2 Purchaser responsibilities

The work and materials needed to prepare the site is the 
responsibility of the purchaser. Delay, confusion, and waste of 
manpower can be avoided by completing pre-installation work 
before delivery. Purchaser responsibility includes:

• Procuring the materials required
• Completing the preparations before delivery of the 

Ultrasound system
• Paying the costs for any alterations and modifications not 

specifically provided in the sales contract

NOTE: All electrical installations that are preliminary to the positioning 
of the equipment at the site prepared for the equipment must be 
performed by licensed electrical contractors. Other connections 
between pieces of electrical equipment, calibrations, and testing 
must also be performed by qualified personnel. The products 
involved (and the accompanying electrical installations) are 
highly sophisticated and special engineering competence is 
required. All electrical work on these products must comply with 
the requirements of applicable electrical codes. The purchaser 
of GE equipment must only utilize qualified personnel to perform 
electrical servicing on the equipment. 

The desire to use a non–listed or customer provided product or 
to place an approved product further from the Ultrasound 
system than the interface kit allows, presents challenges to the 
installation team. To avoid delays during installation, such 
variances should be made known to the individuals or group 
performing the installation at the earliest possible date 
(preferably prior to the purchase).

The ultrasound suite must be clean prior to delivery of the 
Ultrasound system. Carpet is not recommended because it 
collects dust and creates static. Potential sources of EMI 
(electromagnetic interference) should also be investigated 
before delivery. Dirt, static, and EMI can negatively impact 
Ultrasound system reliability.
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2-3-3 Required facility needs

NOTE: GE requires a dedicated power and ground for the proper 
operation of its Ultrasound equipment. This dedicated power 
shall originate at the last distribution panel before the Ultrasound 
system.

Sites with a mains power system with defined Neutral and Live:

The dedicated line shall consist of one phase, a neutral (not 
shared with any other circuit), and a full size ground wire from 
the distribution panel to the Ultrasound outlet.

Sites with a mains power system without a defined Neutral:

The dedicated line shall consist of one phase (two lines), not 
shared with any other circuit, and a full size ground wire from the 
distribution panel to the Ultrasound outlet.
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2-3-3 Required facility needs(continued)

NOTE: Please note that image artifacts can occur, if at any time within 
the facility, the ground from the main facility's incoming power 
source to the Ultrasound unit is only a conduit.

• Dedicated single branch power outlet of adequate 
amperage meeting all local and national codes which is 
located less than 2.5 m (8 ft.) from the unit’s proposed 
location

• Door opening is at least 76 cm (30 in) wide
• Proposed location for unit is at least 0.5m (1.5 ft.) from the 

wall for cooling
• Power outlet and place for any external peripheral are within 

2 m (6.5 ft.) of each other with peripheral within 1 m of the 
unit to connect cables.

• Power outlets for other medical equipment.
• Power outlets for test equipment within 1 m (3.2 ft.) of 

Ultrasound system.
• Clean and protected space to store probes (in their cases or 

on a rack)
• Material to safely clean probes (done with a plastic 

container, never metal)

For the amperage requirements, see: 2-2-3 ‘Electrical 
requirements’ on page 2-6.

2-3-4 Desirable features

• Door is at least 92 cm (3 ft.) wide
• Circuit breaker for dedicated power outlet is easily 

accessible
• Sink with hot and cold water
• Receptacle for bio–hazardous waste, like used probe 

sheaths
• Emergency oxygen supply
• Storage for linens and equipment
• Nearby waiting room, lavatory, and dressing room
• Dual level lighting (bright and dim)
• Lockable cabinet ordered by GE for its software and 

proprietary manuals 
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2-3-5 Minimal floor plan suggestion
CSI 8x10

 Figure 2-1. Minimal floor plan, 2.5 m x 3 m (8 by 10 foot)

Scale: 
Each square equals one square 
foot (app. 31 x 31 cm)

1. Door – at least 762 mm (30 
inches)

2. Film Viewer
3. Counter Top, Sink with hot 

and cold water and Supplies 
Storage

4. Linen Supply
5. Probes/Supplies

6. Examination Table – 1930 x 
610 mm (76 x 24 inches)

7. Footswitch
8. Stool
9. Ultrasound system
10. External Peripherals
11. Dedicated Power Outlet - 

Circuit Breaker protected and 
easily accessible

12. Network Interface
13. 457 mm (18 inches) distance 

of Ultrasound system from 
wall or objects

14. GE Cabinet for Software and 
Manuals

4

1

3

11

6

13

8

10

5

7

9

12

14

2



Site Preparations

2-16 Versana Active – Basic Service Manual
5840775-100 English Rev.10

2-3-6 Recommended floor plan suggestion
CSI 14x17

 Figure 2-2. A 14 by 17 foot recommended floor plan

Scale: Each square equals one square foot (app. 31 x 31 cm)

1. Secretaries or Doctors Desk
2. File Cabinet
3. Film Viewer 
4. Counter Top
5. Counter Top and Sink with 

hot and cold water
6. Overhead Lights Dimmer - 

Dual Level Lighting (bright 
and dim)

7. Emergency Oxygen

8. Suction Line
9. Ultrasound system
10. Dedicated Power Outlet - 

Circuit Breaker protected and 
easily accessible

11. Network Interface
12. 457 mm (18 inches) distance 

of Ultrasound system from 
wall or objects

13. Stool

14. Footswitch
15. Storage for Linens and 

Equipment
16. Examination Table – 1930 x 

610 mm (76 x 24 inches)
17. Lavatory and Dressing Room
18. Door – at least 762 mm (30 

inches)
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2-3-7 Suggested floor plan, Ultrasound system, and PC in same 
room

 Figure 2-3. Suggested Room with EchoPAC PC workstation and Ultrasound Scanner

1. PC workstation parts
2. UPS
3. Ethernet network wall outlet

4. 3x mains power outlets
5. Hot and Cold water
6. Dedicated mains power out-

let

7. Ethernet network wall outlet
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2-3-8 Networking setup requirements

2-3-8-1 Stand alone Ultrasound system (without network connection)

None.

2-3-8-2 Scanner connected to hospital’s network

Supported networks:

100/1000 Mbit Ethernet/DICOM network (option)

2-3-8-3 InSite requirements

InSite requires an Ethernet connection via:

• 100/1000 Mbit Interface 

2-3-8-4 Purpose of the DICOM network function

DICOM services provide the operator with clinically useful 
features for moving images and patient information over a 
hospital network. 

Examples of DICOM services include the transfer of images to 
workstations for viewing or transferring images to remote 
printers. 

As an added benefit, transferring images in this manner frees up 
the on-board monitor and peripherals, enabling viewing to be 
done while scanning continues. 

With DICOM, images can be archived, stored, and retrieved 
faster, easier, and at a lower cost.



Facility needs

Versana Active – Basic Service Manual 2-19
5840775-100 English Rev.10

2-3-8-5 DICOM option setup requirements

To configure the Ultrasound system to work with other network 
connections, the site’s network administrator must provide 
information to complete the form “Worksheet for DICOM 
Network Information”. Ensure that there are no spaces in any 
field of the form. 

See: 

Entries must include: 

• A host name, local port number, AE Title, IP address and 
Net Mask for the Ultrasound system. 

• The IP addresses for the default gateway and other routers 
at the site for ROUTING INFORMATION.

• The host name, IP address, port and AE Title for each 
device the site wants connected to the Ultrasound system 
for DICOM APPLICATION INFORMATION. A field for the 
make (manufacturer) and the revision of the device, is also 
included. This information may be useful for error solving.
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2-3-8-5 DICOM option setup requirements(continued)

 Figure 2-4. Worksheet for DICOM Network Information
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2-4 Environmental Dangers

2-4-1 Patient Vicinity UL60601-1 (USA)

Commercial devices such as laser cameras, printers, VCRs and external monitors, 
usually exceed allowable leakage current limits and, when plugged into separate AC 
outlets, are in violation of patient safety standards. Suitable electrical isolation of such 
external AC outlets, or providing the device with extra protective earth, will be required 
in order to meet UL60601-1 and IEC60601-1 / IEC60601-1-1 standards for electrical 
leakage. 

2.12.20DV (UL60601-1:2003)

In area in which patients are normally cared for, the patient vicinity is the space with 
surfaces likely to be contacted by the patient or attendant who can touch the patient. 
This encloses a space within the room 1.83 m (6 ft.) beyond the perimeter of the bed 
(examination table, dental chair, treatment booth, and the like) in its intended location, 
and extending vertically 2.29 m (7.5 ft.) above the floor.

1. Patient environment
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2-4-2 Patient Environment IEC60601-1 and ANSI AAMI ES60601-1

 Figure 2-5. Patient environment

Sub Clause 3.79 and figure A.9 (IEC60601-1:2005 and ANSI AAMI 
ES60601-1:2005)

Such an area is an environment in which medical diagnosis, monitoring or treatment is 
carried out. It is very difficult to attach unique dimensions to the PATIENT 
ENVIROMENT.

In practice a distance of 2,5 m (8.2 ft.) above the floor on which the medical personnel 
stand and a horizontal distance of 1,5 m (4.9 ft.) have justified themselves as 
indicative of the dimensions of the Patient Environment.

The patient environment/vicinity will be depicted as a dashed line in this procedure. 
See example below.

1. Patient environment
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Chapter 3

System Setup

This chapter contains information needed to install 
Versana Active system.

Included is a procedure that describes how to receive 
and unpack the equipment and how to file a damage or 
loss claim.

How to prepare the facility and unit of the actual 
installation, and how to check and test the unit, probes, 
and external peripherals for electrical safety are also 
included in this procedure.
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3-1 Overview

3-1-1 Contents in this chapter

• 3-1 ‘Overview’ on page 3-2
• 3-2 ‘Setup reminders’ on page 3-3
• 3-3 ‘Receiving and unpacking the equipment’ on page 3-6
• 3-4 ‘Packing materials - recycling information’ on page 3-12
• 3-5 ‘Preparing for setup’ on page 3-13
• 3-6 ‘Completing the setup’ on page 3-14
• 3-7 ‘System Configuration’ on page 3-21
• 3-8 ‘Peripherals Installation’ on page 3-28
• 3-9 ‘Connectivity setup’ on page 3-64
• 3-10 ‘Option Setup’ on page 3-101
• 3-11 ‘Paperwork after setup’ on page 3-104
• 3-12 ‘Cart Setup’ on page 3-106
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3-2 Setup reminders

3-2-1 Average setup time

• Unpacking the Versana Active: 20 minutes
• Set up Versana Active options: 15 minutes
• DICOM Network Configuration: 30 minutes or more, 

depending on the configuration
• Install Insite: 0.5 hour

The Versana Active installation and functional checkout will take 
approximately 1 hour. Versana Active consoles with optional 
equipment may take slightly longer.

3-2-2 Setup warnings

DANGER
 

WHEN USING ANY TEST INSTRUMENT THAT IS CAPABLE 
OF OPENING THE AC GROUND LINE (I.E., METER’S 
GROUND SWITCH IS OPEN), DON’T TOUCH THE 
ULTRASOUND SYSTEM!

CAUTION To prevent electrical shock, connect the unit to a properly 
grounded power outlet. DO NOT use a three to two prong 
adapter. This defeats safety grounding.

CAUTION DO wear the ESD wrist strap when you work on circuits.

CAUTION DO NOT operate this unit unless all board covers and frame 
panels are securely in place. System performance and cooling 
require this.
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3-2-2 Setup warnings(continued)

1. There are no operator serviceable components. To prevent 
shock, do not remove any covers or panels. Should 
problems or malfunctions occur, unplug the power cord. 
Only qualified service personnel should carry out servicing.

NOTE: For information regarding packing labels, refer to LABELS 
ON PACKAGE.

2. After being transported, the unit may be very cold or hot. If 
this is the case, allow the unit to acclimate before you turn it 
on. It requires one hour for each 2.5°C increment it's 
temperature is below 3°C or above 40°C.

The following table describes guidelines for reaching operational 
temperatures from storage or transport temperatures.

DANGER
 

Equipment damage possibility. Turning the system on without 
acclimation after arriving at site may cause the system to be 
damaged.

CAUTION If the Ultrasound system is very cold or hot, do not turn on its power 
until it has had a chance to acclimate to its operating environment.

Table 3-1:  System Acclimation Time Chart

Degree C -4.5 -2 0.5 3 40 42.5 45 47.5 50 55 60

Degree F 23.9 28.4 32.9 37.4 104 108.5 113 117.5 122 131 140

hours 3 2 1 0 0 1 2 3 4 6 8
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3-2-2 Setup warnings(continued)

CAUTION Operator Manual(s)

The User Manual(s) should be fully read and understood 
before operating the Versana Active and kept near the 
Ultrasound system for quick reference.

CAUTION Acoustic Output Hazard 

Although the ultrasound energy transmitted from the Versana 
Active probe is within AIUM/NEMA standards, avoid 
unnecessary exposure. ultrasound energy can produce heat 
and mechanical damage.
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3-3 Receiving and unpacking the

equipment

3-3-1 Purpose of this section

This section describes how to receive and unpack Versana 
Active.

3-3-2 Contents in this section

• 3-3-3 ‘Warnings for receiving and unpacking’ on page 3-6
• 3-3-4 ‘Receiving the Versana Active’ on page 3-7
• 3-3-5 ‘Unpacking the Versana Active’ on page 3-8
• 3-3-6 ‘Packing the Equipment’ on page 3-11

3-3-3 Warnings for receiving and unpacking

CAUTION Remember to use relevant personal protecting equipment 
(PPE) during packing and unpacking. Check with your local 
EHS representative.
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3-3-4 Receiving the Versana Active

3-3-4-1 Overview

Improper handling during transportation may harm the 
equipment inside the package even if the package itself is 
undamaged.

3-3-4-2 Examine all packages

Examine package closely at time of delivery, as described in the 
procedure below.

3-3-4-3 Damage in transportation

Follow this procedure if damage is apparent:

1. Write “Damage In Shipment” on ALL copies of the freight or 
express bill BEFORE delivery is accepted or “signed for “by 
a GE representative or hospital receiving agent.

2. Report the damage to the carrier.

• Whether noted or concealed, damage MUST be 
reported to the carrier immediately upon discovery, or in 
any event, within 14 days after receipt, and the contents 
and containers held for inspection by the carrier.

• A transportation company will not pay a claim for 
damage if an inspection is not requested within this 14 
day period.
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3-3-5 Unpacking the Versana Active

When a new system arrives, check that any components are not 
damaged and are not in short supply. If shipping damage or 
shortage occurs, contact the address shown in Chapter 1

NOTE: Please check the Versana Active console is well assembly after 
unpacking the system.

1. Cut the adhesive tape and open top covers of paper carton.

Figure 3-1. Open Top Covers of Paper Carton

CAUTION Please carefully unpack the system, and do not dispose the 
package of Versana Active, so that it can be reused for service.
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3-3-5 Unpacking the Versana Active(continued)

2. Take out console together with 2 interleavers from console 
package.

3. Take out the interleavers beside Accessories Package
4. Take out Accessories Package.

Figure 3-2. Unpacking the equipment

CAUTION Do not lift the unit by the rubber band. Equipment damage 
may result.
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3-3-5 Unpacking the Versana Active(continued)

5. Remove 2 interleavers.
6. Remove plastic bag.

 Figure 3-3. Removing interleavers and plastic bag
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3-3-5 Unpacking the Versana Active(continued)

NOTE: Check the shipping container for special instructions. Verify that 
the container is intact. In some cases a secondary container 
may be used. If so, ask the carrier for unpacking instructions.

 Figure 3-4. Labels on Package

Moving into Position

In general, a single adult can move the Versana Active. Before 
moving, store all loose parts in original accessory box or in back 
pack. Return probes to original box.

3-3-6 Packing the Equipment

Please pack Versana Active in the reverse order of unpacking.

CAUTION Do not lift the unit by the rubber band. Use handle to move 
system.

CAUTION Equipment Damage Possibility. Lifting the console by holding 
covers may damage the covers. Do not lift the console by 
holding any covers.
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3-4 Packing materials - recycling

information

The packing materials for Versana Active are recyclable:

• The Transportation Box is made of spruce or similar 
material. (“PHYTOSANITARY CERTIFICATE” included in all 
shipments to The People's Republic of China.)

• Lever lockings (hinges) are made of zinc plated steel.
• The inner reinforcements are made of Ethafoam 

(Polyethylene foam).
• The plastic foil is made of LDPE (Low Density 

Polyethylene).
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3-5 Preparing for setup

3-5-1 Verify customer order

Compare items received by the customer to that which is listed 
on the delivery order. Report any items that are missing, back 
ordered, or damaged.

3-5-2 Physical inspection

Verify that the system arrived intact (visual inspection). 

If the system has been damaged, please refer to ‘Damage in 
transportation’ on page i-16 in the beginning of this manual.

3-5-3 EMI protection

The Versana Active has been designed to minimize the effects 
of Electro-Magnetic Interference (EMI). Many of the covers, 
shields, and screws are provided primarily to protect the system 
from image artifacts caused by this interference. For this reason, 
it is imperative that all covers and hardware are installed and 
secured before the unit is put into operation.

See 2-2-4 ‘EMI limitations’ on page 2-8 for more information 
about EMI protection.
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3-6 Completing the setup

3-6-1 Purpose of this section

This section describes how to complete the installation of 
Versana Active.

3-6-2 Contents in this section

• 3-6-3 ‘System specifications’ on page 3-15
• 3-6-4 ‘Electrical specifications’ on page 3-16
• 3-6-6 ‘Connections on Peripheral/Accessories Connector 

Panel’ on page 3-19
• 3-6-7 ‘Connecting probes’ on page 3-20
• 3-6-8 ‘Powering the system’ on page 3-20
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3-6-3 System specifications

3-6-3-1 System requirements verification

• Verify that the site meets the requirements listed in 
Chapter 2. 
(See: 2-3 ‘Facility needs’ on page 2-11.)

• Verify that the specifications below don’t conflict with any 
on-site conditions.

3-6-3-2 Physical dimensions

3-6-3-3 Console Weight

• Weight: less than 6 kg with battery 

Table 3-2:  Physical dimensions of Versana Active

Height Width Depth Unit

58   362 390 mm

2.28       14.25 l5.35 Inches
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3-6-4 Electrical specifications

3-6-4-1 Verification of the system’s voltage setting

Verify that the mains voltage specified for the Versana Active is 
available on-site.

Refer to the latest revision of the Basic User Manual for a full list 
of product labels prior to serving the system.

3-6-4-2 Electrical specifications for Versana Active

In the table below, the electrical specifications for Versana 
Active includes monitor and on board peripherals.

WARNING Connecting a Versana Active to the wrong voltage level will 
most likely destroy it.

Table 3-3:  Electrical specifications for Versana Active

Model Name Voltage Tolerances
Power 

consumption Frequency

Versana Active VA
100-240V ±10%  Max.200VA 50/60 Hz

Versana Active VS
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3-6-5 Peripherals/Accessories Connector Panel

Versana Active peripherals and accessories can be properly 
connected using the side connector panel.

 Figure 3-5. Rear Connector Panel

1. Port for DC In (AC Adapter)
2. 2 general USB 2.0 ports
3. Network Port
4. HDMI port
5. 2 general USB 3.0 prots
6. 1 Probe Connector Port
7. Probe Connector Locking Level
8. Security Lock
9. 4D port (only for Versana Active R1.1.x)
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3-6-5 Peripherals/Accessories Connector Panel(continued)

 Figure 3-6. LED  Indicators

1. Indicates battery status. When the battery is charged, the 
LED is green. When battery power is low, the LED is 
orange.
Color: Green and Orange

2. Indicates hard disk working status. When the LED is 
flashing, the system is writing or reading from the hard disk.
Color: Green

3. Diagnostic LED 2.
4. Diagnostic LED 1.
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3-6-6 Connections on Peripheral/Accessories Connector Panel

NOTE: Accessory equipment connected to the analog and digital 
interfaces must be certified according to the respective IEC 
standards (e.g. IEC60950 for data processing equipment and 
IEC60601-1 for medical equipment). Furthermore, all complete 
configurations shall comply with the valid version of the system 
standard IEC60601-1. Everybody who connects additional 
equipment to the signal input part or signal output part of 
Versana Active, configures a medical system, and is therefore 
responsible that the Ultrasound system complies with the 
requirements of the valid version of IEC60601-1. If in doubt, 
consult the technical service department or your local 
representative for GE.

3-6-6-1 Connect Ethernet

Connect the network cable to the Ethernet connector on the side 
connector panel.

The connector is located on the side of Versana Active.

3-6-6-2 Connect USB Flash Drive 

NOTE: USB Flash Drive approved for Versana Active are verified for 
EMC performance according to EN55011 class B. The use of 
any other USB Flash Drive will compromise this verification, and 
may cause interference on Versana Active itself, or on other 
electronic devices. 

For approved models, please refer to Chapter 9.

Insert the USB Flash Drive in one of the USB ports on the 
Versana Active. 
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3-6-7 Connecting probes

Please refer to Basic User Manual on how to connect/
disconnect a probe.

3-6-8 Powering the system

Please refer to Basic User Manual on how to power the system. 

• The power plug is an isolation means which used to isolate 
its circuits electrically from the SUPPLY MAINS.

• If powered by Advanced Cart, the mains switch is also an 
isolation means which used to isolate its circuits electrically 
from the SUPPLY MAINS.

NOTE: Whether the Advanced Cart is configured with power 
transformer or not depends on the configuration. If the cart 
doesn’t contain the power transformer, it shall be an unpowered 
cart.

NOTE: If power transformer is available on the advanced cart, the main 
cable in the advanced cart can be connected to the power 
transformer at the bottom side of the system, the AC printer will 
be connected to the rear port of the Advanced Cart for power.

NOTE: If power transformer is not available on the advanced cart, user 
shall use the power adapter to connect the console to wall 
outlet. The AC printer shall be connected to wall outlet with 
another power adapter.
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3-7 System Configuration

3-7-1 Purpose of this section

This section describes how to configure the Versana Active.

3-7-2 Versana Active configuration

For complete instructions, refer to the latest revision of the 
Versana Active Basic User Manual, Chapter 16.

Information includes Entering Location, Adjusting Date and 
Time, Selecting User interface Language, Selecting Online 
Manual Language, Selecting Unites of Measure.



System Setup

3-22 Versana Active – Basic Service Manual
5840775-100 English Rev.10

3-7-2-1 User Configurable Key 

When the system is received, please check the software option 
installed on the system.

• Power on the system.
• Enter Utility -> Admin -> System Admin -> Option 

Information to check the option status.

 Figure 3-7. Check SW Option Status
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3-7-2-1 User Configurable Key(continued)

To configure the user configurable key, enter Utility-> System-> 
User Configurable Key and assign the user configurable key.

 Figure 3-8. Assign User Configurable Key
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3-7-3 LDAP

Versana Active Ultrasound System support integration with 
LDAP compliant directory servers. If the system is configured to 
use LDAP (Utility/LDAP), the access control and user 
authentication is performed with use of services from the 
connected directory server. The authentication will be done by 
the directory server, while the access control to the system is 
done with data received from the directory server.

3-7-3-1 Identity Provisioning

3-7-3-1-1 Management of user accounts
When using LDAP, the user accounts on the directory server 
(DS) must be managed outside the Versana Active Ultrasound 
System. It will not be possible to change user passwords or any 
other properties of the user accounts from the Versana Active 
Ultrasound System.

3-7-3-1-2 User information stored on the system
In general, there should be no user information stored on the 
system if LDAP is used. Users that are defined in the local user 
management system will remain on the system, with exception 
of the ADM user, these accounts will not be active.

To be able to log on to the system with no network connectivity, 
the system has an option for caching of LDAP user information. 
This can be enabled by a system administrator.

If caching is enabled, the system will have time limited storage 
of user information received from the DS. See 3-7-3-5 ‘Caching 
of users’ on page 3-25 for more information.

3-7-3-1-3 Username and password restrictions
The systems restrictions for usernames and passwords are:

• Usernames can be 1 - 32 characters long.
• Password can be 0 - 256 characters long.

3-7-3-2 Username and password policies

When using LDAP, username and password policies are 
managed by the DS. The local username and password policy 
on the system will then have no effect on LDAP users.
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3-7-3-3 User Authentication

When a user is logging in, the system will send an 
authentication request with the entered user credentials to the 
configured DS. If the authentication is successful and the user 
has access rights to the system, the user will be granted access.

3-7-3-4 Assigning Access Rights

The access right to the system is controlled by the DS 
authentication of the user, together with use of the user’s DS 
group membership. To get access to a system, a user must be a 
member of one or more DS groups specified on the Versana 
Active Ultrasound system.

DS group membership is used to assign the user privileges on 
the system.

When configuring a Versana Active Ultrasound System to use 
LDAP, proper user groups must be created or identified on the 
DS. The users of the system must be assigned the proper DS 
group membership. 

For example, users that are going to use the system as 
“Sonographer” can be part of a 
“Versana_Active_Utrasound_Sonographers” DS group, while 
users going to be have “Sys admin” rights could be part of a 
“SysAdmin” group.

There is a group mapping tool in the system’s Utility/LDAP page. 
Use this tool to map DS groups to operator groups on the 
Versana Ultrasound system.

3-7-3-5 Caching of users

To enable off line usage, the systems support caching of user 
information and off-line authentication. The caching can be 
turned on / off by a system administrator.

For a user to be able to log on when off line, he/she must 
previously have performed a successful logon on the system 
when on-line, and still have valid (i.e. not timed out) cached user 
information on the system.

The caching is time-limited per individual user. The lifetime of 
the cached information is configurable. If the lifetime has 
expired, the user will not be able to log on when offline. The time 
stamp is reset when a successful on-line authentication is done 
by the user.
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3-7-3-6 Certificate Installation

Press Utility -> LDAP, click Certificates button to open the 
Certmgr-Certification page, import the certificates you need then 
save them to the specific folder.

 Figure 3-9. Utility -> LDAP -> Certificates

 Figure 3-10. Import
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3-7-3-6 Certificate Installation(continued)

 Figure 3-11. Save to folder
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3-8 Peripherals Installation

3-8-1 Overview

This section describes how to install and configure the 
peripherals validated for the Versana Active.

About the operation check-out of peripherals, See 
4-4-19 ‘Peripheral checks’ on page 4-70 for more information.

Table 3-4:  Versana Active Peripherals

Description Control Model

B/W USB Printer USB port Sony UP-D898MD Printer

B/W USB Printer USB port HP Officejet 200 Printer

Color USB Printer USB port Sony UP-D25MD Printer

Network Printer NA HP Universal Printer

3-Pedal Footswitch USB port Footswitch MKF 2-MED USB GP26

1-Pedal Footswitch USB port Whanam FSU-1000

USB Stick USB port USB stick

USB HDD USB port 1TB mobile USB HDD 

ECG USB Port USB ECG Module

Wireless Adaptor USB port Wireless Adaptor

Bluetooth Adaptor USB port Bluetooth Adaptor
Note: The HCAT H48122BT and service part 
5774524-S for Bluetooth Adaptor is not 
orderable now.

DVD RW USB port DVDRW kit

Printer USB Isolator USB port NA

Video Output Adapter for Versana Active-CRU HDMI port VOA

Spare Battery Charger for Versana Active-CRU NA Spare Battery Charger
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3-8-2 Furnished materials

This section describes the materials with the Peripherals and 
with the system.

Retain the original carton and packing materials in case 
transport is needed in the future.

• B/W USB Printer

• B/W USB Printer

• Color USB Printer

• Printer USB Isolator

• USB Stick

Table 3-5:  Materials furnished with B/W Printer

Item Description Quantity Note

1 Sony UP-D898MD Printer 1

2 Paper Roll 1

3 USB cable 1

Table 3-6:  Materials furnished with Printer

Item Description Quantity Note

1 HP Officejet 200 Printer 1

2 Paper Roll 1

3 USB cable 1

Table 3-7:  Materials furnished with Color USB Printer

Item Description Quantity Note

1 Sony UP-D25MD Printer 1

2 Paper Roll 1

3 AC Power Cord (local purchase) 1

4 USB cable 1

Table 3-8:  Materials furnished with printer USB Isolator

Item Description Quantity Note

1 Printer USB Isolator 1

Table 3-9:  Materials furnished with USB Stick

Item Description Quantity Note

1 USB Stick 1
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3-8-2 Furnished materials(continued)

• USB HDD

• Wireless Adaptor

• Bluetooth Adaptor

• Footswitch

• DVD RW

Table 3-10:  Materials furnished with the USB HDD

Item Description Quantity Note

1 USB HDD 1

2 USB Cable 1

Table 3-11:  Materials furnished with the Wireless Adaptor

Item Description Quantity Note

1 1 Wireless Adaptor 1

Table 3-12:  Materials furnished with the Bluetooth Adaptor

Item Description Quantity Note

1 1 Bluetooth Adaptor 1

Table 3-13:  Materials furnished with the Footswitch

Item Description Quantity Note

1 1 Pedal Footswitch 1

2 3 Pedal Footswitch 1

Table 3-14:  Materials furnished with the DVD RW

Item Description Quantity Note

1 DVD RW 1

2 USB cable 1
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3-8-3 Peripherals Installation Instructions

3-8-3-1 Sony UP-D898MD Printer Installation

3-8-3-1-1 Tools
No special tools needed.

3-8-3-1-2 Manpower
One person 5 minutes.

3-8-3-1-3 Preparations
1. Unpack B/W Printer.
2. Ensure no physical damage.

3-8-3-1-4 Installation Procedure
1. Place the device in a suitable place.
2. Connect the USB cable and power cable on the Printer.
3. Connect the power cord in the wall outlet, then turn on the 

printer.
4. Connect USB cable to Versana Active USB port.

Figure 3-12. Sony UP-D898MD Connection
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3-8-3-1 Sony UP-D898MD Printer Installation(continued)

5. Press Utility-->Connectivity-->Service. 
6. Select Standard Print under Service box by default or 

Select Standard Print from drop-down menu and click Add.

 Figure 3-13. Connectivity->Service

NOTE: The print key configured in this step also can be used as Print 
key in Worksheet.

7. Select the printer from the Printer pull-down Properties 
menu. Type the printer name in the Name Field. This name 
is used on the Button screen. Press Save. 

 Figure 3-14. Select the Printer
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3-8-3-1 Sony UP-D898MD Printer Installation(continued)

8. Select Button. Select the appropriate print key (Print1, 
Print2 or Print3) from the Physical Print Buttons selection. 
Select the printer from MyComputer column and press >> 
to move it to the Printflow View column. PressSave.

 Figure 3-15. Select Button
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3-8-3-1-5 Set up Paper Size
Follow these steps to set up the paper size of the printer, take 
Sony UP-D898 as an example.

• Press Utility-->System-->Peripherals. Select the UP-D898 
from the pull-down menu under. Then Click Properties.

 Figure 3-16. Peripherals Setting

• Click Printer -> Printing Preferences at the menu of 
Properties Window.

Figure 3-17. Properties
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3-8-3-1 Sony UP-D898MD Printer Installation(continued)

• Select Paper Size. Press Apply. Press OK.

Figure 3-18. Printing Preferences

• Press Save, then Exit.

3-8-3-1-6 Adjust Printer Brightness for Sony UP-D898MD Printer
1. The first setting method is to adjust by “BRIGHT” button on 

printer.

Figure 3-19. BRIGHT button on printer
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3-8-3-1 Sony UP-D898MD Printer Installation(continued)

2. The second setting method is to adjust brightness by Printer 
properties on Versana Active user interface. Please refer to 
below steps to set.
• Press Utility-->System-->Peripherals. Select the 

UP-D898 from the pull-down menu under. Then Click 
Properties.

 Figure 3-20. Peripherals Setting

• Click Printer -> Printing Preferences at the menu of 
Properties Window.

Figure 3-21. Properties
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3-8-3-1 Sony UP-D898MD Printer Installation(continued)

3. Select Density Adjust, adjust Light to the desired value. 
Then press OK to save.

Figure 3-22. Density Adjust
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3-8-3-2 HP Officejet 200 Printer Installation

3-8-3-2-1 Tools
No special tools needed.

3-8-3-2-2 Manpower
One person 5 minutes.

3-8-3-2-3 Preparations
1. Unpack the Printer.
2. Ensure no physical damage.

3-8-3-2-4 Installation Procedure
1. Connect Printer USB Isolator to the Versana Active System, 

see ‘Printer USB Isolator’ on page 3-55 .
2. Place the device in a suitable place.
3. Connect the USB cable and power cable on the Printer.
4. Connect the power cord in the wall outlet, then turn on the 

printer.
5. Connect USB cable to Printer USB Isolator.

Figure 3-23. HP Officejet 200 Connection

6. Refer to the Connectivity configure steps of 3-8-3-1 ‘Sony 
UP-D898MD Printer Installation’ on page 3-31.
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3-8-3-3 Sony UP-D25MD Printer Installation

3-8-3-3-1 Tools
No special tools needed.

3-8-3-3-2 Manpower
One person 5 minutes.

3-8-3-3-3 Preparations
1. Unpack the Sony UP-D25MD Printer.
2. Ensure no physical damage.

3-8-3-3-4 Installation Procedure
1. Place the device in a suitable place.
2. Connect the USB cable and power cable on the Printer.
3. Connect the power cord in the wall outlet, then turn on the 

printer.
4. Connect USB cable to Versana Active USB port.

Figure 3-24. Sony UP-D25MD Connection

5. Refer to the Connectivity configure steps of 3-8-3-1 ‘Sony 
UP-D898MD Printer Installation’ on page 3-31.
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3-8-3-4 HP Universal Printer Installation

3-8-3-4-1 Tools
No special tools needed.

3-8-3-4-2 Manpower
One person 5 minutes.

3-8-3-4-3 Preparations
1. Prepare the network connection.

3-8-3-4-4 Installation Procedure
1. Press Utility-->Connectivity-->Service. Select MyComputer 

as Destination Device. And Select Standard Print under 
Service box by default or Select Standard Print from 
drop-down menu and click Add.

Figure 3-25. Connectivity->Service
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3-8-3-4 HP Universal Printer Installation(continued)

2. Select HP Universal Printing PCL 6 in the Properties 
category.

Figure 3-26. Select the network printer
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3-8-3-4 HP Universal Printer Installation(continued)

3. Select Button. Select the appropriate print key (Print1, 
Print2 or Print3) from the Physical Print Buttons selection. 
Select Standard Printer from MyComputer column and 
press >> to move it to the Printflow View column.  
Click to assign Standard Print in the Active Images Page 
category. PressSave.

 Figure 3-27. Select Button
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3-8-3-4 HP Universal Printer Installation(continued)

4. Press Utility-->System-->Peripherals. Select HP Universal 
Printing PCL 6 as the default printer.
Click Save and exit Ultility page.

 Figure 3-28. Peripherals Setting 

5. The first time the print button configured is pressed, a HP 
Universal Printing PCL 6 menu pops up. Select “Enter a 
Printer Address...”.

 Figure 3-29. Enter a Printer Address...
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3-8-3-4 HP Universal Printer Installation(continued)

6. A window will pop out. Input a printer address and select 
OK.

Figure 3-30. Input Printer Address

7. A confirmation will be displayed when the printer address is 
accepted.

 Figure 3-31. Confirmation
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3-8-3-5 Footswitch Installation

3-8-3-5-1 Tools
No special tools needed.

3-8-3-5-2 Manpower
One person 2 minutes.

3-8-3-5-3 Preparations
1. Unpack the Footswitch.
2. Ensure no physical damage.

3-8-3-5-4 Installation Procedure
1. Connect the Footswitch to the USB port on the Versana 

Active system.

Figure 3-32. Connect Footswitch to the system (1)

Figure 3-33. Connect Footswitch to the system (2)
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3-8-3-5-5 Configuring Footswitch
Footswitch supports these configurations: No Function, Freeze, 
Store, Print, Update, Next Step (Scan Coach), Previous Step 
(Scan Coach), Scan Coach Pause/Resume.

Enter Utility -> Application-> Settings to configure the 
Footswitch functions. 

NOTE: For single footswitch, please use Middle to do setting.

 Figure 3-34. Configuring Footswitch Functions
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3-8-3-6 USB HDD Installation

3-8-3-6-1 Tools
No special tools needed.

3-8-3-6-2 Manpower
One person 1 minute.

3-8-3-6-3 Preparations
1. Unpack the USB HDD.
2. Ensure no physical damage.

3-8-3-6-4 Installation Procedure
1. Connect the USB HDD to the USB port on the Versana 

Active system.

Figure 3-35. Connect HDD to the system
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3-8-3-7 ECG Installation

3-8-3-7-1 Tools
No special tools needed.

3-8-3-7-2 Manpower
One person 1 minute.

3-8-3-7-3 Preparations
1. Unpack the ECG Assy.
2. Ensure no physical damage.

3-8-3-7-4 Installation Procedure
1. Connect the ECG to the USB port on the Versana Active 

system.

Figure 3-36. Connect ECG to the system

CAUTION Use GE provided ECG cable to ensure the protection 
performance against the effects of a discharge of a cardiac 
defibrillator to the patient.
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3-8-3-8 DVDRW Installation

3-8-3-8-1 Tools
No special tools needed.

3-8-3-8-2 Manpower
One person 1 minute.

3-8-3-8-3 Preparations
1. Unpack the DVDRW.
2. Ensure no physical damage.

3-8-3-8-4 Installation Procedure
1. Take out the DVDRW and USB cable and connect the USB 

cable to the DVDRW.

Figure 3-37. Connect USB cable

2. Connect both of the USB cables to the USB ports on the 
Versana Active system.

Figure 3-38. Connect DVDRW to the system
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3-8-3-9 Wireless Adapter

3-8-3-9-1 Tools
No special tools needed.

3-8-3-9-2 Manpower
One person 1 minute.

3-8-3-9-3 Preparations
1. Unpack the wireless adapter
2. Ensure no physical damage.

3-8-3-9-4 Installation Procedure
1. Connect the wireless adapter to the USB port on the 

Versana Active system.

Figure 3-39. Connect Wireless Adapter
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3-8-3-10 Bluetooth Adapter

3-8-3-10-1 Tools
No special tools needed.

3-8-3-10-2 Manpower
One person 1 minute.

3-8-3-10-3 Preparations
1. Unpack the bluetooth adaptor
2. Ensure no physical damage.

3-8-3-10-4 Installation Procedure
1. Connect the Bluetooth Adapter to the USB port on the 

Versana Active system.

Figure 3-40. Connect Bluetooth Adapter
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3-8-3-10 Bluetooth Adapter(continued)

2. Reboot the system.
3. After the power-up sequence is complete, press Utility on 

the Control Panel. Select Connectivity-> Bluetooth, click 
Add New Device.

NOTE: For Bluetooth Adapter connection, the operator must login 
as Administrator.

 Figure 3-41. Add New Device

4. Follow the Bluetooth pairing wizard to turn on Bluetooth on 
your mobile device. Scan for surrounding devices. Then 
select the device name of the Versana Active in your 
surrounding device list to pair.
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3-8-3-10 Bluetooth Adapter(continued)

Figure 3-42. Bluetooth Pairing Wizard (1)

NOTE: Versana Active system does not support to pair with Apple 
device.

5. The Pincode is shown in the dialogue, click Accept to 
continue.

Figure 3-43. Bluetooth Pairing Wizard (2)

6. On your mobile device a dialogue box should appear asking 
for permission to connect to the Versana Active system. 
Click OK and wait for the process to complete.
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3-8-3-10 Bluetooth Adapter(continued)

7. After pairing is done, the mobile device name appears in the 
Authorized Bluetooth Devices field.

 Figure 3-44. Connected Successfully
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3-8-3-11 Printer USB Isolator

3-8-3-11-1 Tools
No special tools needed.

3-8-3-11-2 Manpower
One person 5 min.

3-8-3-11-3 Preparations
1. Unpack the AC isolation USB.
2. Ensure no physical damage.

3-8-3-11-4 Installation Procedure
1. Insert the Mini USB side of the cable into the Printer USB 

Isolator.

Figure 3-45. Insert the USB connector into Printer USB 
Isolator
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3-8-3-11 Printer USB Isolator(continued)

2. Insert the USB cable connector in one of the USB ports on 
the Ultrasound system. 

 Figure 3-46. Insert the USB cable into the Ultrasound system

NOTE: The Ultrasound system in above graphic is only for 
illustrational purposes. You can use the Printer USB Isolator 
on the desired Ultrasound system.
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3-8-3-12 Spare Battery Charger for Versana Active-CRU

3-8-3-12-1 Tools
No special tools needed.

3-8-3-12-2 Manpower
One person 5 mins.

3-8-3-12-3 Preparations
1. Unpack the Spare Battery Charger for Versana Active-CRU.
2. Ensure no physical damage.

3-8-3-12-4 Installation Procedure

Figure 3-47. Scenarios
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3-8-3-12 Spare Battery Charger for Versana Active-CRU(continued)

1. Connect AC adapter - Spare Battery Charger (- Spare 
Battery Charger). If two Spare Battery Chargers are 
connected together, maximum of four spare batteries can be 
charged at the same time, but it will take one more hour 
compared with two batteries in charging. 

NOTE: Do not connect more than two Spare Battery Chargers.

2. Connect Spare Battery Charger - Versana Active system. 
The battery charger with the discharging battery acts as an 
alternative power source for Versana Active.

NOTE: Do not connect more than one Spare Battery Charger.

NOTE: For this use scenario, when the spare battery power is low, please 
connect Spare Battery Charger to AC adapter immediately

3. Connect AC adapter - Spare Battery Charger - Versana 
Active system. In this situation, it can charge the spare 
battery and supply power to Versana Active for scanning at 
the same time.

NOTE: Do not connect two or more Spare Battery Chargers to 
Versana Active system.

NOTE: Only above use scenarios are allowed. DO NOT support Spare 
Battery Charger to be used in other scenarios.

NOTE: Always use Spare Battery Charger on a flat surface.
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3-8-3-12-5 Charging/Discharging Time
1. Charge 1pc or 2pcs of battery at the same time, it needs 3h.

Figure 3-48. Charging: 1pc & 2pcs

2. Charge 3pcs or 4pcs of battery at the same time, it needs 
4h.

Figure 3-49. Charging: 3pcs & 4pcs

3. 1pc of spare battery and console battery together can 
support scanning for 2hours.

Figure 3-50. Discharging: 1pc spare battery + console battery

4. 2pcs of spare battery and console battery together can 
support scanning for 3hours.

Figure 3-51. Discharging: 2pcs spare battery + console battery
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3-8-3-12 Spare Battery Charger for Versana Active-CRU(continued)

5. 2pcs of spare battery and console battery need 6 hours to 
fully charge with AC adapter connected when scanning.

Figure 3-52. Charging: 2pcs spare battery + console battery
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3-8-3-12-6LED Indicators Information

Figure 3-53. 1,2,3,4: LED indicators

Each Versana Active module supports charging of two spare 
batteries concurrently. Charging status of each of the two 
batteries, are displayed through independent LED indicators.

LED battery charge status indications are as follow:

NOTE: “x” means that the LED indicator is off.

Versana Active with the discharging battery acts as an 
alternative power source for the system. Discharging status of 
each of the two batteries, are displayed through independent 
LED indicators.

LED battery discharge status indications are as follow:

NOTE:           When the remaing battery capacity is less than 25%, the 
corresponding four LED lights will flash at the same time till battery 
power is running out. Please charge the battery immediately.

Remaining battery capacity LED1 LED2 LED3 LED4
0% ~ 30% flashing x x x
31% ~ 50% blue flashing x x
51% ~ 75% blue blue flashing x
75% ~ 99% blue blue blue flashing
100% Four LED indicators are lit up successively.

Remaining battery capacity LED1 LED2 LED3 LED4
76% ~ 100% blue blue blue blue
51% ~ 75% blue blue blue x
31% ~ 50% blue blue x x
1% ~ 30% blue x x x
0% Four LED indicators are off.
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3-8-3-13 Video Output Adapter for Versana Active-CRU

3-8-3-13-1 Tools
No special tools needed.

3-8-3-13-2 Manpower
One person 5 min.

3-8-3-13-3 Preparations
1. Unpack the Versana Active Video Adapter Assy.
2. Ensure no physical damage.

3-8-3-13-4 Installation Procedure
1. Connect the HDMI cable to the HDMI port at the front of the 

Video Adapter and plug in the other end of the cable to the 
ultrasound system’s HDMI port. Then the LED light is turned 
to green. 

2. Connect the S-video or CVBS cable to the corresponding 
port at the rear of the Video Adapter and plug in the other 
end of the cable to your Video Device.

 Figure 3-54. Video Output Adapter for Versana Active-CRU

NOTE: The Video Adapter could be connected to the system at any time, 
no matter the system is powered ON or powered Off.
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3-8-3-13-5Code Switch
The Video Output Adapter receives HDMI signals and transfer 
them to S-video and CVBS video which support several TV 
modes and three kinds of image zooming areas.

The HDMI cable is required as power supply.

The default value is 00011(Scan image + PAL-B, PAL-D, PAL-G, 
PAL-B, PAL-I,)

 Figure 3-55. Code Switch

Table 3-15:  Code Switch (1,2)

1 2 Image area

0 0 Scan image

0 1 Scan image with parameter

1 0 Full image

1 1 Full image

Table 3-16:  Code Switch (3,4,5)

3 4 5 Video Standard

0 0 0 NTSC-M

0 0 1 NTSC-J

0 1 0 NTSC-433

0 1 1 PAL-B, PAL-D, PAL-G, PAL-H, PAL-I

1 0 0 PAL-M

1 0 1 PAL-N

1 1 0 PAL-Nc
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3-9 Connectivity setup

3-9-1 EZ configuration Wizard

EZ configuration wizard is a function to enable the operator to 
configure some common system settings when turning on the 
system for the first time after the software installation.

NOTE: Password setting is required when turning on the system for the 
first time after the software installation.

For Versana Active, you can also enter EZ Configuration Wizard 
by clicking the Insite icon at the top right of the screen.

Figure 3-56. Enter EZ Configuration Wizard
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3-9-1 EZ configuration Wizard(continued)

1. Select policy level in Password Policies and then press 
Next.

NOTE: Selecting password policy level is required when turning on 
the system for the first time or after the software installation.

 Figure 3-57. Select password policy level
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3-9-1 EZ configuration Wizard(continued)

User can select the option Lowest, Medium, High or Highest 
for policy level. The complexity of the password will be 
differed by the policy level you selected:

NOTE: Do not use space when creating the password.

NOTE: If user selects Lowest level in password policies, ADM 
password can be empty during Admin Registration.

NOTE: When user selects Lowest level, a warning message will 
display to inform that the current security policy will put your 
system at risk.

Table 3-17:  Password Policy Level and Complexity

Policy Level Complexity

Lowest Minimum password length: 0
Maximum password length: 256
Minimum number of character sets required in the password: 0
- Minimum number of upper case characters: 0
- Minimum number of lower case characters: 0
- Minimum number of digits (0-9): 0
- Minimun number of non-alphanumeric characters (e.g. !$#,%): 0
Password cannot contain user name: No

Medium Minimum password length: 8
Maximum password length: 256
Minimum number of character sets required in the password: 3
- Minimum number of upper case characters: 1
- Minimum number of lower case characters: 1
- Minimum number of digits (0-9): 1
- Minimun number of non-alphanumeric characters (e.g. !$#,%): 0
Password cannot contain user name: Yes

High Minimum password length: 10
Maximum password length: 256
Minimum number of character sets required in the password: 4
- Minimum number of upper case characters: 1
- Minimum number of lower case characters: 1
- Minimum number of digits (0-9): 1
- Minimun number of non-alphanumeric characters (e.g. !$#,%): 1
Password cannot contain user name: Yes

Highest Minimum password length: 144
Maximum password length: 256
Minimum number of character sets required in the password: 4
- Minimum number of upper case characters: 1
- Minimum number of lower case characters: 1
- Minimum number of digits (0-9): 1
- Minimun number of non-alphanumeric characters (e.g. !$#,%): 1
Password cannot contain user name: Yes
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3-9-1 EZ configuration Wizard(continued)

NOTE: When user selects Lowest level, a warning message will 
display to inform that the current security policy will put your 
system at risk.

 Figure 3-58. Lowest policy level warning

2. Set ADM password in Admin Registration. And then set up 
3 password security questions and answers.
ADM is the administrator of the ultrasound system and has 
the highest authority for the software. ADM can create other 
accounts, import and export data and make some sensitive 
settings.

NOTE: The passwords are critical for your system. Please store the 
passwords safely.

NOTE: Record your answers for the 3 questions. The answers are 
required when you need to reset ADM password.

NOTE: ADM password and security questions can be empty if 
password policy level is selected as LOWEST.
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3-9-1 EZ configuration Wizard(continued)

 Figure 3-59. ADM password setting

NOTE: If you didn’t set ADM password during software upgrade 
procedure, you could also set operator password later by 
Utility -> Admin -> Users.

Figure 3-60. Set ADM password
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3-9-1 EZ configuration Wizard(continued)

3. Set Disk Encryption Password for Drive D&E (including 
Archive of patient information, temp files, user defines, 
logs). The password is set by user. It is required for reading 
the data on the hard disk when software is running. System 
will remember the password automatically.

NOTE: Disk Encryption Password setting is required when turning 
on the system for the first time or after the software 
installation.

NOTE: The passwords are critical for your system. Please store the 
passwords safely.

NOTE: When the HDD is removed from the unit, it will need 
password to decode.
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3-9-1 EZ configuration Wizard(continued)
Set Disk Encryption Password and press Next.

 Figure 3-61. Disk Encryption Password

An information window of Change Password Success will 
display, press OK to continue.

Figure 3-62. Change Password Success
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3-9-1 EZ configuration Wizard(continued)
4. Set System Password. System password is the Windows 

password. User needs to initialize it for logging on the 
system Windows desktop for the first time. 
Set system password by Install wizard -> System 
Password OR Utility -> Admin -> System Admin -> 
Change System Password.

NOTE: System password setting is required when turning on the 
system for the first time or after the software installation.

NOTE: The passwords are critical for your system. Please store 
your passwords safely.
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3-9-1 EZ configuration Wizard(continued)
Set System Password and press Next.

 Figure 3-63. System Password Setting

An information window of Change Password Success will 
display, press OK to continue.

Figure 3-64. Change Password Success
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3-9-1 EZ configuration Wizard(continued)
5. Select the appropriate language for system language and 

keyboard language from the drop-down list. 

 Figure 3-65. System Language Setting
NOTE: If you select Exit, you will exit the installation wizard.

• If you do not change the language, press Next to 
continue.
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3-9-1 EZ configuration Wizard(continued)
• If you change the language setting and press Next, a 

window will pop out. Under Formats select desired 
language and select Cancel.

Figure 3-66. Formats selection

Click Ok to restart the system.

 Figure 3-67. System Language settings (2)

NOTE: If you press Previous, you will go to the previous page.
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3-9-1 EZ configuration Wizard(continued)

6. This screen shows the hospital and time information, and 
you can set the system date and time here.

 Figure 3-68. General Information

7. Press Next to continue.
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3-9-1 EZ configuration Wizard(continued)

8. The Network Information screen shows the configuration 
of wireless and local network:

 Figure 3-69. Wireless Network Information
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3-9-1 EZ configuration Wizard(continued)

 Figure 3-70. Local Network Information

9. Press Next to continue.

Table 3-18:  Network settings

Preset Parameter Description

Enable DHCP Select to set TCP/IP.
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3-9-1 EZ configuration Wizard(continued)
10. The Insite - Remote Assistant screen shows the 

configuration of Agent and Proxy.

 Figure 3-71. InSite - Remote Assistant

Table 3-19:  Agent and Proxy Configuration

Element DESCRIPTION

CRM No Customer Relationship Management (CRM) number. System identifier assigned to the 
customer unit by the service region. CRM is pre-populated by adding Versana Active to the 
CRM number. The CRM number of the Versana Active is editable.

Serial No Serial number of the agent (read-only). If the agent is not registered with a serial number, 
this field is populated with the serial number of the Versana Active. The serial number of 
the agent is tied to the serial number of the Versana Active.

Proxy Server When Enable Proxy is selected, name of the proxy server IP.

Proxy Port When Enable Proxy is selected, number of the proxy server port.

Username When Proxy is selected, name of the user.

Password When Proxy is selected, password for the user.
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3-9-1 EZ configuration Wizard(continued)

After InSite - Remote Assistant has been successfully 
configured, these elements will have the corresponding 
values:
• Agent Registered will be Yes
• Agent Quarantine will be No
• Agent CRM Verified will be Yes

The information on System Information is available to all 
service class licenses.
To access System Information, navigate to Utility > 
Service > Home.

Figure 3-72. System Information

11. After having set the InSite - Remote Assistant, press Next to 
continue.
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3-9-1 EZ configuration Wizard(continued)

12. This screen shows the report of the previous settings. You 
can export it to the database.

 Figure 3-73. Summary Information
Press Export and select OK to store the report.

Figure 3-74. Export Summary
13. Press Exit to exit Installation Wizard.
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3-9-2 TCP/IP Screen

1. Press Utility on the control panel and login as admin, refer 
to See 4-2-5 ‘Logging on to Versana Active as “ADM”’ on 
page 4-11 for more information..

2. Select Connectivity on the screen.
3. Select TCP/IP tab, the screen gives an overview of the 

network settings for Versana Active.

 Figure 3-75. TCP/IP Screen

4. By clicking MACAddressQRCode, there will be a QR code 
poping out on the screen. You can get MAC address here.

 Figure 3-76. MAC Address QR Code
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3-9-2 TCP/IP Screen(continued)

MAC Address can also be found in OAC system as showing 
in Figure 3-77. 

 Figure 3-77. MAC Address in OAC system
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3-9-2-1 Changing the AE title and/or Port Number

1. To change AE Title and/or Port No, edit the respective 
fields.

Figure 3-78. AE Title/Port No

2. Select Save to store your changes. This will bring up a new 
warning screen.

Figure 3-79. Warning Message

3. Select OK to save your changes or Cancel to return without 
saving any changes.

4. Reboot the system to activate the settings or continue with 
other TCPIP setup tasks.



System Setup

3-84 Versana Active – Basic Service Manual
5840775-100 English Rev.10

3-9-3 Network setup

For network connection setup, See 7-6-1 ‘Network 
Configuration’ on page 7-37 for more information.

3-9-4 Setup connection to a DICOM server

Versana Active is configured to work with DICOM servers in a 
network environment. Images are first saved on the local image 
butter on the system. At the end of the examination the images 
are sent to the DICOM server via a DICOM spooler and to the 
local database, depending on dataflows.

To connect to the DICOM server, the following information has to 
be entered in the system.

• The DICOM server IP address
• The DICOM server port number
• The DICOM server AE title (the server application's name)

Table 3-20:  Utility ->Connectivity ->TCP/IP screen

1 Enter the Versana Active computer name. This may be the same as the station name.

2 Enter the Versana Active IP address, subnet mask, default gateway and network speed. For 
automatic assignment of IP address, subnet mask and default gateway, select DHCP.

Note: If possible, set the Versana Active network Speed to match that of the Network 
switch. if in doubt, set it to AutoDetect. Otherwise, transfer times can be two or five times 
longer, during which the Versana Active will appear to be locked up. (If the Hard Drive 
activity light on the front of the console is lit steady or blinks quickly, the Versana Active is 
most likely not hung.)
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3-9-4 Setup connection to a DICOM server(continued)

Table 3-21:  Utility ->Connectivity ->Device screen

1 Select MyComputer.

2 Assign an AE title to the Versana Active. (AE stands for Application Entity. DICOM 
services use this to identify the Versana Active.) AE title is case-sensitive. This title 
may contain the Computer Name from the TCP/IP page, if desired.
 
Note: It is NOT recommended to use the factory default. This is not prohibited, but 
more than one system with the same AE title can cause confusion.

3 Edit Port Number if needed. 104 is typical. Save your changes and reboot the system.
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3-9-5 How to get the Versana Active to recognize another Device on 
the Network

Table 3-22:  Utility ->Connectivity ->Device screen

1 Select Add. The system creates a device called “NewDevice”.

2 Change the name to one of your choosing.

3 Enter the IP address of the device.

4

Save your changes and then press Ping. A “Smiley Face” indicates successful 
communication between your Versana Active and the device. A “Frown” indicates failed 
communication. Check the following:
• Is the device running?
• Is it connected to the network?
• Did you enter the right IP address?
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3-9-6 How to Setup and Use a DICOM Image Storage Service

An Image Storage Service provides a place to store patient and 
exam data from Versana Active and corresponding images. The 
Image Storage Service, or the device that hosts it, is often called 
a Patient Archiving and Communication System (PACS).

Table 3-23:  Setup an Image Storage Service

1 In Utility -> Connectivity -> Service, from the Destination Device drop-down menu, select the 
device on which the service resides. (This assumes you have already setup the device in the 
Device tab in  ‘How to Setup and Use a DICOM Image Storage Service’ on page 3-87 .

2 From the Select Service Type to add drop-down menu, select DICOM Image Storage and press 
Add.

3 Change the name of the service to one of your choosing.

4 Enter the AE Title and port Number of the service. AE Title is case-sensitive.

5 Save your changes and then press Verify. A “Smiley Face” indicates successful communication 
with the service.
Note: If you get a successful Ping (Smiley Face) at the device level but not at the 
service level, it is possible that the AE Title or Port Number of the service settings are 
incorrect. Ensure that these are correct then re-verify. Be sure that the service type 
(Store, Print, etc) is correct and supported by the device.
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3-9-7 Dataflow

A dataflow is a set of pre-configured services. When you select 
a dataflow, the ultrasound system automatically works according 
to the services associated with the dataflow. The Dataflow tab 
allows you to select and review information about dataflows. You 
can also create, change, and remove dataflows.

Set up dataflows for the services. 

NOTE: You must be logged on as Administrator to use the Dataflow tab.

CAUTION DO NOT rename the factory default dataflow. 

Table 3-24:  Setup an Image Storage Service

1 Select the dataflow from the list.

2 Select to store data directly to archive (no buffer storage).

3 Select so that this dataflow does not appear as a Dataflow on the Patient menu. 

4 Select to use this dataflow as the default dataflow when you start the system.
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3-9-8 Button

You can assign print buttons via the Utility --> Connectivity --> 
Button page. 

Assigning print buttons. First select the print button to configure 
on the upper, left corner of the page. Then select the device you 
want to add in the middle part of the page, under Available Input/
Outputs. Then click on the right arrow in the top right corner of 
the page. 

NOTE: You can configure each print key to multiple output devices/
dataflows. 

NOTE: Only attach one DICOM service per print key (e.g., PACS and 
DICOM printer). Multiple DICOM devices should be configured 
via a dataflow.

NOTE: When using a print key to send an image directly to a DICOM 
device, this causes a single DICOM association per image. Most 
devices (all known printers) work fine with this. However, some 
storage devices, such as ALI, Kodak Access, and Cemax, 
assume that the end of each association is the end of the exam 
and can result in a new folder for each image. In the Utility 
menu, select a single association or open PR for the desired 
DICOM storage device. 

 Figure 3-80. Botton Preset Menu
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3-9-8 Button(continued)

Table 3-25:  Physical Print Buttons

Preset Parameter Description

M&A only (no images) Configures the system to send a DICOM structured report only; no image 
isgenerated or sent. 

Table 3-26:  Still Images

Preset Parameter Description

Format RawDICOM, DICOM, or M&A. 

Compression Always set to None. 

Table 3-27:  Cllips/Volumes

Preset Parameter Description

Cllips: Add Multiframe Data Checkbox

Compression None, Rle, Jpeg, Jpeg2000

Quality Lossless, 99, 98, 97, ... 50
Note: The default Compression for Clips is JPEG85. It is strongly 
recommended to keep the Compression set to JPEG85.

Volume File Format 2- Standard DICOM with Raw Data

Table 3-28:  Active Images Page

Preset Parameter Description

Standard Print Lets you send to a Windows-based printer. 
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3-9-9 Removable Media

The Removable Media tab allows you to:

• Verify the DICOM directory on removable media.
• Verify the free space of the media.
• Verify that the media is finalized or unfinalized.
• Verify that the media is formatted or unformatted.
• Format removable media (rewritable CD/DVD or USB 

device).

 Figure 3-81. Removable Media Preset Menu

The bottom of the screen lists properties of the selected media.

Table 3-29:  Tools

Preset Parameter Description

Removable Media Select the removable media to format or verify.

Label Type a label for a new removable media (free text).

Verify • Select to verify DICOM directory on removable DICOM disk.
• Verify the free space of the media.
• Verify that the media is finalized or unfinalized.
• Verify that the media is formatted or unformatted.

Format Select to format removable media.

Quick Format To format the media quickly, check this box. If you uncheck this box, the 
media is formatted with a full format. New media should always be formatted 
with a full format. 
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3-9-9 Removable Media(continued)

Formatting removable media

1. Select the removable media from the Media list.
2. Type a name for the removable media in the Label field.

NOTE: Do not use the following characters for labelling:

\ / : ; . , * < > | + = [ ]
3. Select Format. Confirm OK or Cancel. 
4. An information window confirms when the format has been 

completed. Select OK to exit. 

Verifying removable media

1. Select the removable media from the Media list.
2. Select Verify.



Connectivity setup

Versana Active – Basic Service Manual 3-93
5840775-100 English Rev.10

3-9-10 Miscellaneous

The Miscellaneous tab allows you to configure tools related to 
patient management and print and store options. You can 
specify default system functionality, such as whether patient ID 
is required when you archive data, or if you want the system to 
automatically search the archive for a patient when you enter 
patient data.

 Figure 3-82. Miscellaneous Preset Menu

Table 3-30:  Patient/Exam Menu Options

Preset Parameter Description

Use birthdate In the Patient information window, enter either the patient age or the 
birthdate:When selected, enter birth date, then the age is 
calculated.Whencleared, enter age (birth date field not available).

Auto search for patient In the Search/Create Patient window: When selected, the system 
automatically searches through the selected patient archive, while the user 
enters patient information.When cleared, the automatic search tool is turned 
off. If you are trying to keep the past patient data confidential, DO NOT use 
this feature. 

Automatic generation of 
patient ID

In the Search/Create Patient window: When selected, the Patient ID is 
notrequired when entering a new patient in the archive. The 
systemautomatically generates an ID number. When cleared, the Patient ID 
isrequired when entering a new patient in the archive.
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Auto Archiving patient data Archives patient data automatically. 

After [End Current Patient], 
go to

Select go to Worklist screen or Patient screen when ending the current 
patient. 

Keep Search String Search string is kept rather than cleared. 

Worklist Auto Query Automatically queries the worklist server. 

Show BBT Show BBT field on the OB patient screen to input the basal body 
temperature.

Double click on patient list 
to start 

Select Review or New Exam to display each time you double click on the 
patient name in the patient list on the Patient menu.

Detail Mode Select to display Detail Mode, rather than Exam View, when you select the 
patient name in the patient list on the Patient menu. You can also type 
comments while in Detail Mode.

Export to USB HDD: 
Create DICOMDIR

Create DICOMDIR is a DICOM file format which contains how the directory 
and DICOM files structured for diagnostic portable media behave. It is 
important for portability between the Versana Active to PACS. If you want to 
save exams to the USB Hard drive and look at it on the PACS, the 
DICOMDIR is a must.

Export to Network storage: 
Create DICOMDIR

Automatic Disable Patient 
Data

Select to automatically disable patient data. 
If selected, locks the patient name, date of birth and gender (like Patient ID). 
The Factory Default for this preset is unchecked.

Remember Cursor Position 
on the Transfer Screen

To set a default cursor location on the Data Transfer screen: 
1. Select the “Remember cursor position in the Transfer screen” preset and 

press Save. 
2. On the Data Transfer screen, move the cursor to the desired field. 
3. Exit out of the Data Transfer screen. When returning to the Data Transfer 

screen, the cursor location is in the position your selected. 

Quick New Patient Entry Select to store new patient automatically by pressing the Patient key.

Table 3-31:  Patient/Exam Message Options

Preset Parameter Description

Patient info exist in logfile Check box to select.

Request acknowledge of 
End Exam action

When selected, the user is asked to confirm action when ending an 
examination.

Warn Image Store without 
Patient

Select to receive a warning when you press the Print key without an active 
patient.

Warn Register to No 
Archive

Select to receive a warning when you register a patient to the “No Archive” 
data flow. Select a different data flow for permanent storage of patient data.

Warn image store to Read 
Only dataflow

The system posts a warning message if you attempt to store images to a 
read-only Dataflow. 

Table 3-30:  Patient/Exam Menu Options (Continued)

Preset Parameter Description
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Warn video titles exist in 
the internal storage

The system posts a warning if the video titles exist on the internal DVR flash 
memory. 

Table 3-32:  Print and Store Options

Preset Parameter Description

P[1-2] Key Sound Select None, Click, Chimes, Ding, Ding-Dong, or Whoosh. 

Store Dual as Dicom Only Select to always store dual images as a DICOM (secondary capture) store, 
rather than Raw DICOM. 

Dual When Color Support 
is Mixed

Dataflow Mixed is not available. While transferring dual images to the PACS, 
send black and white images as gray; send color images as color. Set up 2 
services (one gray and one color), set up 2 dataflows, and set up 2 buttons. 
Each button needs to be tied to a different service.
Select if you want to keep the user preset for Color Photometric Interpretation 
while in Dual mode.

Store Multiframe for Sec 
Capture Loops

Select if you want the CINE loop stored as secondary capture.

Enable Whizz Capture 
Area

Check box to select. 

Store 2D Loop with 
Timeline Data

Check box to select. 

Patient List Print-Font Size Select font size. 

Image Order Scheme Select to Direct Store images in Acquisition Order, Scan Coach/Assistant 
Order, or Off.
• Off. The clipboard on the Ultrasound system shows the image in the order it 

was acquired. Therefore, re-stored images appear where you’d expect. 
However, on the PACS system, images appear in arrival order or in image 
number order. 

• Acquisition Order. From the Ultrasound system perspective, the same as 
“Off.” But on the PACS system (if based on image number order), images 
are displayed consistently with the way they are stored on the Ultrasound 
system. 

• Scan Coach/Assistant Order. You can define the storage order (reading 
order) via Scan Coach/Assistant Creator. Therefore, based on the order 
defined in Scan Coach/Assistant, images are re-ordered and displayed in 
this manner both on the Clipboard and on the PACS system. 

Tip for USB Quick Save 
only First time

Check box to select. 

Table 3-31:  Patient/Exam Message Options

Preset Parameter Description
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Table 3-33:  Other ID Options 

Preset Parameter Description

Enable Other ID Not selected is the Default.
If selected, allow entering Other ID, such as Citizen Service Number, Burger 
Service Number (BSN), National Health System (NHS) number, along with 
patient ID information on the Patient Screen.

Validation Format If the Enable Other ID preset is selected, the system validates the format of 
“Other ID” when an ID is entered. Choose: NHS Number *** ** *****, Letters 
and Numbers, Numbers, or Any (no restriction)
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3-9-11 Bluetooth

To add a new bluetooth device, 

1. Press Add New Device. 
2. Type the device name in the Name field. 

 Figure 3-83. Connectivity Bluetooth Preset Menu

Table 3-34:  Device

Preset Parameter Description

Add New Device/Remove Press Add new device to add a new device; press Remove to delete a 
device. 

Properties: Name Type the name of the device. 

Properties: MAC Address Unique network card address. NOTE: Only available for MyComputer.

Properties: Date Added Display the new device added date.
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3-9-12 Tricefy

New GE Versana ultrasound systems have Tricefy pre-installed. 
Additional software is not necessary for using Tricefy; simply 
activate your account using the following steps.

1. Press Utility -> Connectivity -> Tricefy.
NOTE: The Tricefy tab is only available on machines that have 

Tricefy option.

 Figure 3-84. Tricefy Menu

2. Enable Tricefy checkbox, and enter the email address to 
authorize the account. Press “ Activate account” to 
activate your account, this process may take up to 30 
seconds, and a dialog will pop up if succeeded. And you will 
receive a notification email, click the link to complete the 
whole activating process.

 Figure 3-85. Activate Tricefy Account
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3-9-12 Tricefy(continued)

3. Add Tricefy to Print workflow.
• Click Button to configure the P- Bottons for sending 

and sharing images.

 Figure 3-86. Button Menu

• Select Print1 (or Print2, Print3) which you would like to 
use. Then Select Trice Archive and press >> button to 
add it to Printflow View, press Save. Now when you 
press the P1 button, the image will be sent to your 
Tricefy cloud.

 Figure 3-87. Configure the P-Button for Tricefy
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3-9-12 Tricefy(continued)

4. If you want to share the images to patient, please add Trice 
Patient to Printflow View. And also remember input the 
patient’s Phone number or email address.

 Figure 3-88. Share Images to Patient

NOTE: If you have any problem with Tricefy settings, please contact 
your GE service/sales representative.
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3-10 Option Setup

3-10-1 Software Option Installation Procedure

NOTE: Not all features described in this section may be available or 
cleared for sale in all markets. Please contact with your local GE 
Ultrasound representative to get the latest information.

1. Power on the system.
NOTE: Keep the power cord connection during the installation.

2. After the power-up sequence is complete, press Utility on 
the control panel, and then select Admin-> System Admin.

3. Enter the new SW Option key and then select Add.

Figure 3-89. New Option Key

WARNING For software Option Installation, the operator must login as 
Administrator.
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3-10-1 Software Option Installation Procedure(continued)

4. To activate the changes, press Restart now to restart the 
system.

Figure 3-90. Dialog Window

NOTE: There is no need to restart the system after each 
installation, if several option keys are installed at one time. 
Select Restart later for the first several times, and select 
Restart now after the last installation to activate all the 
changes.

5. After the system is powered on, check the option status.

Figure 3-91. Check Option Status

The option status explanation:
• Permanent: This option is enabled in the system.
• Disabled: This option is disabled in the system.
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3-10-1 Software Option Installation Procedure(continued)

6. Configure the user define key in utility. On the screen, the 
user defined key name will be displayed.

 Figure 3-92. User define key display on the screen

7. This completes the option installation of Versana Active.

NOTE: Installing corresponding hardware is a prerequisite of 
loading software option successfully. Please check below 
table for correspondence.

Table 3-35:  Software Corresponding Hardware

Software Option Hardware

CW_Doppler CWD PWA
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3-11 Paperwork after setup

NOTE: During and after setup, the documentation (i.e. CDs with 
documentation, User Manuals, Installation Manuals, etc.) for the 
Versana Active and the peripherals must be kept as part of the 
original Ultrasound system documentation. This ensures that all 
relevant safety and user information is available during the 
operation and service of the complete Ultrasound system.

3-11-1 Contents in this Section

• 3-11-2 ‘User’s Manual(s)’ on page 3-104
• 3-11-3 ‘Product Locator Installation Card’ on page 3-105

3-11-2 User’s Manual(s)

User Check that the correct User Manual(s) for the system and 
software revision, is included with the installation. Specific 
language versions of the User Manual may also be available. 
Check with your GE Sales Representative for availability. 
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3-11-3 Product Locator Installation Card

NOTE: The Product Locator Installation Card shown may not be the 
same as the provided Product Locator card.

 Figure 3-93. Product Locator Installation Card (Example)
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3-12 Cart Setup

3-12-1 Purpose of this section

This section contains information needed to install 3 types of 
Versana Active Cart:

• VSN A Base Cart
• Versana Active Advanced Fixed Cart
• Versana Active Advanced Height-Adj Cart

3-12-1-1 Contents in this chapter

• 3-12-1 ‘Purpose of this section’ on page 3-106
• 3-12-1-1 ‘Contents in this chapter’ on page 3-106
• 3-12-2 ‘Safety Consideration’ on page 3-107
• 3-12-3 ‘Set Up the Cart’ on page 3-108
• 3-12-4 ‘Cart Using’ on page 3-117
• 3-12-5 ‘Peripheral Installation’ on page 3-121
• 3-12-6 ‘Paperwork’ on page 3-141
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3-12-2 Safety Consideration

NOTE: Please refer to Chapter 1 and Chapter 2 for the safety 
information and site requirement for the Cart. Chapter 1 and 
Chapter 2 should be read before conducting any installation 
work on Cart.

NOTE: Special care should be taken when transporting the Cart in a 
vehicle.

CAUTION Care must be used when moving the Cart or replacing its parts.

Failure to follow the precautions listed below could result in 
injury, uncontrolled motion and costly damage.

ALWAYS:

• be sure the pathway is clear
• use slow, careful motions
• Limit movement to a slow careful walk. 
Need two people to work together when moving on inclines or 
lifting more than 16 kg (35 lbs). 

WARNING When the cart is raised for a repair or moved along any incline, 
use external caution since it may become unstable and tip 
over.

CAUTION

Do

Do not move Cart with big incline angle.

CAUTION The Cart is not water proof. Do not expose the Cart to water or 
any kind of liquid.

Never set liquids on the Cart to ensure that liquid does not drip 
into the unit.

CAUTION Put peripherals in correct position to avoid Cart overload.
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3-12-3 Set Up the Cart

3-12-3-1 Safety Reminders

 Figure 3-94. Environmental Labels

DANGER
 

WHEN USING ANY TEST INSTRUMENT THAT IS CAPABLE 
OF OPENING THE AC GROUND LINE (I.E., METER’S 
GROUND SWITCH IS OPEN), DON’T TOUCH THE UNIT!

CAUTION Two people should unpack the unit because of its weight. Two 
people are required whenever a part weighing 19kg (42 lb.) or 
more must be lifted.

CAUTION To avoid damage to the ultrasound system, do not place the 
cart close to the wall or heating devices.

CAUTION OPERATOR MANUAL(S) 
The User Manual(s) for the Cart should be fully read and 
understood before operating the Cart and kept near the unit for 
quick reference.
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3-12-3-2 Receiving and Unpacking the Equipment

When a new Cart arrives, check that any components are not 
damaged and are not in short supply. If shipping damage or 
shortage occurs, contact the address shown in Chapter 1.

3-12-3-2-1 Unpacking Cart
NOTE: The unpacking procedure is the same for 3 types of Cart. Take 

VSN A Base Cart as an example.

Table 3-36:  Procedure to take out Cart

No. Steps Corresponding Graphic

1. Tear the stop open mark.

2. Cut the two packing straps 
around the carton.
Note: To avoid injury, with one 
hand holding the strap clasp 
when cutting the strap.
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3. Open the carton cover and 
remove it.

4. Remove the stretch film.

Table 3-36:  Procedure to take out Cart

No. Steps Corresponding Graphic
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5. Flip up the lock and remove the 
belt and the cushion pad.

6. Remove the dust bag from the 
cart.
Note: There is no dust bag if the 
system is transported by sea. 
Ignore this step if there is no dust 
bag.

Table 3-36:  Procedure to take out Cart

No. Steps Corresponding Graphic
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7. Remove the cushion pad.

8. With one hand holding the front 
handle and the other hand 
holding the rear handle, move the 
whole cart down to the ground.

Table 3-36:  Procedure to take out Cart

No. Steps Corresponding Graphic
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3-12-3-2-1 Unpacking Cart(continued)

Figure 3-95. Remove Foam

1. Pallet with foam
2. Fefco 0452 BC-flute
3. Fefco 0501 BC-flute
4. Support foam 1
5. Support foam 2
6. Support foam 3
7. Top foam
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3-12-3-2-2 Moving into Position

In general, a single adult can move the Cart along an even 
surface with no steep grades. At least two people should move 
the machine when large humps, grooves, or grades will be 
encountered. (It is better to pull from the rear rather than push 
from the front of the unit). Before moving, store all loose parts in 
the unit. Wrap transducers in soft cloth or foam to prevent 
damage.

3-12-3-3 Preparing for Installation

3-12-3-3-1 Verify Customer Order
Compare items received by the customer to that which is listed 
on the delivery order. Report any items that are missing, back 
ordered or damaged.

3-12-3-3-2 Physical Inspection
Verify that Cart arrived intact (visual inspection).
If the Cart has been damaged, please refer to ‘Damage in 
transportation’ on page i-16 in the beginning of this manual.

3-12-3-3-3 EMI Protection
This Unit has been designed to minimize the effects of Electro 
Magnetic Interference (EMI). Many of the covers, shields, and 
screws are provided primarily to protect the system from image 
artifacts caused by this interference. For this reason, it is 
imperative that all covers and hardware are installed and 
secured before the unit is put into operation.

CAUTION Do not tilt the unit more than 5 degrees to avoid tipping it over.
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3-12-3-3-4 Physical Dimension and Weight
The physical dimension of the Cart is summarized in Table 3-37 
on page 3-115. 

The weight of VSN A Base Cart is 21 kg (46.3 lbs).

Figure 3-96. VSN A Base Cart

Table 3-37:  Physical Dimensions of Cart

Length Depth Height Unit

VSN A Base Cart 556 517 890 mm

Versana Active Advanced Fixed Cart 556 585 920 mm

Versana Active Advanced Height-Adj Cart 556 585 from 900 to 1190 mm
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3-12-3-3-4 Physical Dimension and Weight(continued)

Figure 3-97. Versana Active Advanced Fixed Cart

Figure 3-98. Versana Active Advanced Height-Adj Cart
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3-12-4 Cart Using

3-12-4-1 Lock/Unlock Wheels

1. Press the lever down to lock the wheel. 
2. Press the “ON” pedal on the wheel to unlock the wheel. 

NOTE: All four wheels have brakes.

 Figure 3-99. Wheels



System Setup

3-118 Versana Active – Basic Service Manual
5840775-100 English Rev.10

3-12-4-2 Mount the system to Cart

Table 3-38:  Mounting Procedure of Versana Active

No. Step Corresponding Graphic

1. Align the system with the two Locate Blocks and 
place the system on the top panel of the cart.
Caution: Except the cart, always use the system 
on a flat surface to avoid any damage for the 
outer covering.

2. If the top panel has two ground bosses, and the 
system has the corresponding notch at the rear 
of the handle, earth grounding will be 
automatically connected. Otherwise, please 
follow step 3~4 to assure adequate grounding 
for the system.
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3. Take out the screwdriver from the bottom of top 
panel.

4. Screw 1 screw under the top panel.

5. Connect AC adapter to Versana Active.
Or connect Cart Power Cable (a) to the system if 
Versana Active Advanced Cart has installed 
power transformer (optional).

6. For Versana Active Advanced Cart only, connect 
Cart USB Cable (b) to the system.

Table 3-38:  Mounting Procedure of Versana Active

No. Step Corresponding Graphic
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NOTE: Refer to the ultrasound system user manual for more 
information on connecting the power cord and probe.

3-12-4-3 Remove the system from Cart

Remove the system in the reverse order of installation, refer to  
‘Mount the system to Cart’ on page 3-118 .

NOTE: Press down the release button by hand before removing the 
system from Cart.

Figure 3-100. Press down the release button

7. Flip up the monitor and begin scanning. To avoid 
damage, DO NOT push the LCD beyond its 
maximum angle (170 degrees).

Table 3-38:  Mounting Procedure of Versana Active

No. Step Corresponding Graphic

CAUTION Be sure that the system is fixed correctly on the Cart to avoid 
falling down.
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3-12-5 Peripheral Installation

3-12-5-1 On-Board Optional Peripherals

See each option setup instructions for installation and 
connection procedures.

NOTE: Sony UP-D898DC printer is only applicable for Versana Active 
Advanced Cart (including Versana Active Advanced Fixed Cart 
and Versana Active Advanced Height-Adj Cart).

3-12-5-2 Install Sony UP-D898MD on VSN A Base Cart

3-12-5-2-1 Tools
• Common Hex driver
• common Phillips screwdriver

3-12-5-2-2 Needed Manpower
• 1 person, 5 minutes

3-12-5-2-3 Preparations
• Turn off all the power supply.

Table 3-39:  Peripherals Validate for Cart

Device Manufacturer Model Interface Video Signal

B/W Printer SONY UP-D898MD USB Interface N/A (* USB 
Interface)

B/W Printer SONY UP-D898DC USB Interface N/A (* USB 
Interface)

DVD-RW Transcend Transcend 
TS8XDVDS-K 
DVDRW kit

USB Interface N/A (* USB 
Interface)

WARNING Serious injuries may result. To prevent the Cart from becoming 
unstable, please use the peripherals with the recommended 
specifications. DO NOT install peripheral devices that are too 
large or too heavy for the location on the cart.
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3-12-5-2-4 Installation Procedure

Table 3-40:  Installation Procedure of Printer 

No. Step Corresponding Graphic

1. If the DVD-RW is installed on the DVD-RW 
shelf, remove the DVD-RW first before 
installing the printer, refer to 
3-12-5-5-5 ‘Removal Procedure’ on 
page 3-135

2. Align two holes on the bracket with the two 
holes on the bottom of the printer, then place 
the bracket on bottom of the printer. Screw 2 
screws.
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3. Place the printer on the Printer shelf and 
push the printer into the shelf completely.

4. Screw 2 screws at the bottom of the Printer/
DVD-RW shelf. You can view the two screws 
through the DVD-RW shelf.

5. Connect the Power cable(b) and the USB 
cable(a) to the back of the printer. 

Table 3-40:  Installation Procedure of Printer 

No. Step Corresponding Graphic
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3-12-5-2-5 Removal Procedure
Remove the printer in the reverse order of installation.

6. Connect USB cable to the system through 
the isolated USB printer port.

Table 3-40:  Installation Procedure of Printer 

No. Step Corresponding Graphic
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3-12-5-3 Install Sony UP-D898MD on Versana Active Advanced Cart

3-12-5-3-1 Tools
• None.

3-12-5-3-2 Needed Manpower
• 1 person, 5 minutes

3-12-5-3-3 Preparations
• Turn off all the power supply.

3-12-5-3-4 Installation Procedure

Table 3-41:  Installation Procedure of AC Printer 

No. Step Corresponding Graphic

1. Remove rear window cover with 
hand.

2. Align the arrow on the Printer/
DVD-RW Shelf to the arrow on the 
cart.
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3. Press down the Printer/DVD-RW 
Shelf using both hands.

4. Screw 4 screws to install Printer 
Base Plate on the bottom of the 
printer.

5. Place the printer in the Printer/
DVD-RW Shelf and completely 
push the printer into the shelf.

6. Connect the USB cable (a) and 
Power cable (b) to the back of the 
printer and the cart.

Table 3-41:  Installation Procedure of AC Printer 

No. Step Corresponding Graphic
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7. Install the shelf by hand.

8. Connect the cart USB cable to the 
system.

Table 3-41:  Installation Procedure of AC Printer 

No. Step Corresponding Graphic
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3-12-5-3-5 Removal Procedure
Disconnect the cables and remove the shelf in the reverse order 
of step 7~9.Then lift the locking pin(1) and push the printer (with 
Printer Base Plate) out of the Printer/DVD-RW Shelf.

Figure 3-101. Lift the locking pin

Unscrew 4 screws to seperate the printer from Printer Base 
Plate.

Figure 3-102. Remove Printer Base Plate

To remove the Printer/DVD-RW Shelf:

1. Pull out the locking pin with one hand and lift up the Printer/
DVD-RW Shelf with the other hand.

Figure 3-103. Pull out the locking pin

2. Remove Printer/DVD-RW Shelf.
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3-12-5-4 Install Sony UP-D898DC on Versana Active Advanced Cart

3-12-5-4-1 Tools
• None

3-12-5-4-2 Needed Manpower
• 1 person, 5 minutes

3-12-5-4-3 Preparations
• Turn off all the power supply.

3-12-5-4-4 Installation Procedure

Table 3-42:  Installation Procedure of DC Printer 

No. Step Corresponding Graphic

1. Remove rear window cover with hand.

2. Connect the DC printer power extend cable 
to Cart.

3. Install Printer/DVD-RW Shelf on the cart, 
refer to step 2~4 of 3-12-5-3-4 ‘Installation 
Procedure’ on page 3-125.
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4. Screw 4 screws to install Printer Base Plate 
on the bottom of the printer.

5. Place the printer in the Printer/DVD-RW 
Shelf and completely push the 
printer into the shelf.

6. Connect the USB cable (a) to the back of the 
printer and the cart.
Connect the power extend cable (b) to the 
back of the printer.

7. Install the shelf by hand.

8. Connect the cart USB cable to the system.

Table 3-42:  Installation Procedure of DC Printer 

No. Step Corresponding Graphic
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3-12-5-4-5 Removal Procedure
Disconnect the cables and remove the shelf in the reverse order 
of step 6~8.Then lift the locking pin(1) and push the printer (with 
Printer Base Plate) out of the Printer/DVD-RW Shelf.

Figure 3-104. Lift the locking pin

Unscrew 4 screws to seperate the printer from Printer Base 
Plate.

Figure 3-105. Remove Printer Base Plate

Remove the Printer/DVD-RW Shelf, refer to 
3-12-5-3-5 ‘Removal Procedure’ on page 3-128.
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3-12-5-5 Install DVD-RW on VSN A Base Cart

3-12-5-5-1 Tools
• NA

3-12-5-5-2 Needed Manpower
• 1 person, 8 minutes

3-12-5-5-3 Preparations
• Turn off all the power supply.
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3-12-5-5-4 Installation Procedure

Table 3-43:  Installation Procedure of DVD-RW

No. Step Corresponding Graphic

1. Align the arrow mark(b) on the bracket with the 
open/close button(a) on DVD-RW, then mount 
the bracket to DVD-RW.

2. Place the DVD-RW to the DVD-RW shelf and 
push it into the shelf completely until it is fixed. 
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3. Connect USB cable to DVD-RW through the 
hole under the Printer/DVD-RW shelf. 

4. Connect both USB connectors to the USB ports 
on the system. 
Note: Be sure both of the USB cables are 
connected to the system at the same time.

Table 3-43:  Installation Procedure of DVD-RW

No. Step Corresponding Graphic
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3-12-5-5-5 Removal Procedure

Table 3-44:  Removal Procedure of DVD-RW

No. Step Corresponding Graphic

1. Use the tool to push the button inside the slot at 
the side of the shelf.

2. When the bracket is loosened, use the figure tip 
to pry off the bracket and remove it.

3. Take out the DVD-RW. 
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3-12-5-6 Install DVD-RW on Versana Active Advanced Cart

3-12-5-6-1 Tools
• NA

3-12-5-6-2 Needed Manpower
• 1 person, 8 minutes

3-12-5-6-3 Preparations
• Turn off all the power supply.
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3-12-5-6-4 Installation Procedure

Table 3-45:  Installation Procedure of DVD-RW

No. Step Corresponding Graphic

1. If the Printer is installed on the Printer/DVD-RW 
Shelf, remove the printer first before installing 
the DVD-RW.

2. Route DVD-RW cable through Printer/DVD-RW 
Shelf.

3. Connent the DVD-RW cable to DVD-RW.

4. Place the DVD-RW into the Printer/DVD-RW 
Shelf and push it to the end of shelf.
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3-12-5-6-5 Removal Procedure
Remove the DVD-RW in the reverse order of installation.

5. Mount the bracket onto Printer/DVD-RW Shelf.

6. Connect both USB cables to the USB ports on 
the cart.

7. Install the shelf cover by hand.

8. Connect the cart USB cable to the system.

Table 3-45:  Installation Procedure of DVD-RW

No. Step Corresponding Graphic
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3-12-5-7 Peripheral Cable Routing

Gather the peripheral cables together and place them on the 
hook on the cart.

1. AC cable
2. ECG cable
3. Probe cable

Figure 3-106. Cable Route1
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3-12-5-7 Peripheral Cable Routing(continued)

Figure 3-107. Cable Route 2
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3-12-6 Paperwork

NOTE: During and after setup, the documentation (i.e. User Manuals...) 
for the peripheral units must be kept as part of the original 
system documentation. This will ensure that all relevant safety 
and user information is available during the operation and 
service of the complete system.

3-12-6-0-1 Product Locator Installation Card
NOTE: The Product Locator Installation Card shown in this manual may 

not be same as the provided Product Locator card.

 Figure 3-108. Product Locator Installation Card

3-12-6-0-2 User Manual
Check that the correct User Manual(s) for the Cart is included 
with the installation. Specific language versions of the User 
Manual may also be available. Check with your GE Sales 
Representative for availability.
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Chapter 4

General Procedures and
Functional Checks

This chapter provides procedures for quickly checking 
major functions of the Versana Active and diagnostics 
instructions using the built-in service software.
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4-1 Overview

4-1-1 Purpose of this chapter

This chapter provides procedures for quickly checking major 
functions of the scanner and diagnostics instructions using the 
built-in service software.

4-1-2 Contents in this chapter

• 4-1 ‘Overview’ on page 4-2
• 4-2 ‘General procedures’ on page 4-3
• 4-3 ‘Disk Encryption/Decryption’ on page 4-36
• 4-4 ‘Functional checks’ on page 4-50
• 4-5 ‘Power supply test & adjustments’ on page 4-72
• 4-6 ‘Application Turnover Check List’ on page 4-73
• 4-7 ‘Site Log’ on page 4-74
• 4-8 ‘My Trainer’ on page 4-75

4-1-3 Special Equipment required

To perform these tests, you'll need any of the sector, linear, or 
convex probes. (Normally you should check all the probes used 
on the system).
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4-2 General procedures

CAUTION Ultrasound system requires all covers.

Operate this Ultrasound system only when all board covers and 
frame panels are securely in place. The covers are required for 
safe operation, good Ultrasound system performance and 
cooling purposes.

WARNING Energy Control and Power Lockout for Versana Active.

When servicing parts of the Ultrasound system where there is 
exposure to voltage greater than 30 volts:

1. Follow LOCK OUT/TAG OUT procedures. 
2. Turn off the breaker.
3. Unplug the Ultrasound system.
4. Maintain control of the Ultrasound system power plug.
5. Wait for at least 30 seconds for capacitors to discharge as 

there are no test points to verify isolation.   

Ultrasound System components may be energized. 
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4-2-1 Overview

Some procedures are used more often than other. The intention 
with this section is to keep the most used procedures in one 
place.

4-2-1-1 Contents in this section

• 4-2-1 ‘Overview’ on page 4-4
• 4-2-2 ‘Power ON/Boot Up’ on page 4-5
• 4-2-3 ‘Power off’ on page 4-8
• 4-2-4 ‘Check System Date and Time’ on page 4-10
• 4-2-5 ‘Logging on to Versana Active as “ADM”’ on page 4-11
• 4-2-6 ‘Change Password’ on page 4-12
• 4-2-7 ‘Forgot Password’ on page 4-14
• 4-2-8 ‘Service Key (SSA)’ on page 4-18
• 4-2-9 ‘Exit to Windows Desktop from the Versana Active 

application software’ on page 4-19
• 4-2-10 ‘Removable media’ on page 4-19
• 4-2-11 ‘Backup and Restore Database, Preset 

Configurations and Images’ on page 4-19
• 4-2-12 ‘Data Management’ on page 4-28
• 4-2-13 ‘Backup’ on page 4-28
• 4-2-14 ‘Restore the factory defaults’ on page 4-28
• 4-2-15 ‘Installation and Setup Procedure for Peripherals’ on 

page 4-28
• 4-2-16 ‘Where are the User Manuals and the Service 

Manual?’ on page 4-29
• 4-2-17 ‘How to display or print the PDF files from the 

Manual CD?’ on page 4-29
• 4-2-18 ‘Cleaning the Trackball’ on page 4-30
• 4-2-19 ‘Cleaning the air filter’ on page 4-32
• 4-2-21 ‘Monitor’ on page 4-35
• 4-2-22 ‘Operator Control Panel’ on page 4-35
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4-2-2 Power ON/Boot Up

4-2-2-1 Warnings

DANGER
 

ALWAYS CONNECT THE ULTRASOUND SYSTEM TO A 
FIXED POWER SOCKET WHICH HAS THE PROTECTIVE 
GROUNDING CONNECTOR.

DANGER
 

NEVER USE A THREE-TO-TWO PRONG ADAPTER; THIS 
DEFEATS THE SAFETY GROUND.

DANGER
 

ENSURE THAT THE POWER CORD AND PLUG ARE 
INTACT AND THAT THE POWER PLUG IS THE PROPER 
HOSPITAL-GRADE TYPE (WHERE REQUIRED).

CAUTION Ultrasound system requires all covers.

Operate this Ultrasound system only when all board covers and 
frame panels are securely in place. The covers are required for 
safe operation, good Ultrasound system performance and 
cooling purposes.

CAUTION Use only power supply cords, cables and plugs provided by or 
designated by GE.
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4-2-2-2 Connect AC (mains) Power to Versana Active

Connecting AC Power to the Versana Active ultrasound unit, 
involves preliminary checks of the power cord, voltage level and 
compliance with electrical safety requirements.

If the system is powered by AC adapter:

1. Ensure that the wall outlet is of appropriate type.
2. Uncoil the power cable, allowing sufficient slack so that the 

unit can be moved slightly.
3. Verify that the power cable is without any visible scratches 

or any sign of damage.
4. Verify that the on-site mains voltage is within the limits 

indicated on the rating label on the bottom of the unit.
5. Plug the AC adapter output connector into the system DC 

input port (located on the system’s side conenctor panel).
6. Plug the AC adapter power cord into a ground, protective 

earth outlet. And the unit is ready for Power ON/Boot up.

Figure 4-1. Connect AC Adapter

If the system is powered by Versana Active Advanced Cart, 
please refer to Versana Active Advanced Cart User Instruction 
for detailed information.
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4-2-2-3 Switch ON the AC Power to Versana Active

Press once on the On/Off key on the Operator Panel to boot the 
unit.

During a normal boot, you may observe that: 

a. The unit’s ventilation fan starts on full speed, but slows 
down after a few seconds (listen to the fan sound).

b. Power is distributed to the peripherals, Operator Panel 
(Console), Monitor, Front End Processor and Back End 
Processor.

c. Back End Processor and rest of scanner starts with the 
sequence listed in the next steps:

d. Back End Processor is turned ON and starts to load the 
software.

e. The Start Screen is displayed on the monitor.
f. A start-up bar indicating the time used for software 

loading, is displayed on the monitor.
g. The software initiates and sets up the Front End 

electronics and the rest of the instrument.
h. The backlight in the keyboard is lit.
i. As soon as the software has been loaded, either a 2D 

screen is displayed on the screen, indicating that a 
probe has been connected, or a No Mode screen is 
displayed, indicating that no probe has been connected.

NOTE: Total time used for start-up is typical one and a half minutes 
or less. If starting after a power loss or a lock-up, the 
start-up time may be up to four minutes.

NOTE: Diagnostic LEDs on the side connector panel indicate the 
boot up status, refer to “Normal Status” in Table 7-13 on 
page 7-57.

NOTE: Set up Drive D password and System password. See 
3-9-1 ‘EZ configuration Wizard’ on page 3-64 for more 
information.



General Procedures and Functional Checks

4-8 Versana Active – Basic Service Manual
5840775-100 English Rev.10

4-2-3 Power off 

When you switch off the unit, the system performs an automatic 
shutdown sequence.

The SYSTEM - EXIT menu, used when switching off the unit, 
gives you these choices:

Figure 4-2. System Exit Window

• Exit
(Only available when logged in as GE Service with Service 
Dongle)
Select this button when you want to exit to Windows.

• Standby
Use this button to select Standby mode. 
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4-2-3 Power off(continued)

• Logoff
Use this button to log off the current user. 
The system remains ON and ready for a new user to log on.
If the Logoff button is dimmed, it indicates that no user is 
logged on to the unit at the moment.

• Shutdown
Use this button to shut down the system. The entire system 
will shut down. It is recommended to perform a full shutdown 
at least once a week.
If the Shutdown button is dimmed, use the key-combination 
<Ctrl+Alt+Delete> to shut down the unit.

NOTE: To enable the key-combination <Ctrl+Alt+Delete>, the 
dongle should be connected to the system.

• Cancel

Use this button to exit from the System-Exit menu and 
return to the previous operation.

4-2-3-1 System shutdown

Disconnect the Mains Power Cable is necessary. For example: 
Relocating the scanner.

CAUTION DO NOT unplug and/or transport the unit until after the power 
off sequence has been completed. Failure to do so may result 
in corrupted patient files.
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4-2-4 Check System Date and Time

A warning message "Please check the system date and time are 
correct" appears on the screen when the system is powered on. 
This warning message appears for the possible reasons:

• The system is not boot up for over 14 days.
• The system time has been changed by 24 hours earlier than 

the current system time of last boot-up.
• The BIOS time is changed by 24 hours earlier than the 

current system by resetting BIOS time,replacing BIOS 
module or changing BIOS time.

This warning message is to remind the user to check the system 
date in case the system date and time is incorrect.

 Figure 4-3. Check system date and time message

Move the cursor to OK and press Set key on the control panel to 
select OK. The system enters.

Check the system date and time. If it is incorrect, follow below 
steps to reset the system date and time.

• Enter Utility -> System -> General -> Date/Time(restart 
needed).

• Reset the system date and time.
• Select Apply and then select OK.
• Select Save.
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4-2-5 Logging on to Versana Active as “ADM”

Select Utility on the control panel, then select Admin. 

It will bring up the Operator Login dialog where you must log 
on.

Figure 4-4. Operator Login Window

1. Operator: Enter the Operator ID.
2. Password: Enter Operator’s password (optional).
3. Select type of Logon or Cancel.

• OK: Proceed with the logon
• Cancel: Cancel logon

4. Forgot Password?: User can reset a password.
5. Reset Logon Accounts To Factory Default (Reboot 

needed): Plug in SSA Dongle to reset Logon accounts.

NOTE: When you login as administrator for the first time, you are 
prompted to set a password.
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4-2-6 Change Password

User can change ADM password in Utility -> Admin -> Users 
-> Identity.

NOTE: The new password should meet the password complexity rules 
for selected Policy Level. Password Level could be set in Utility 
-> Admin -> User policies.

Figure 4-5. Change Password
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4-2-6 Change Password(continued)

NOTE: If user can change the empty password to a new password 
(non-empty). When first logging into the Versana Active, the 
user will be prompted to set up 3 password security questions 
and answers. Record the answers as they’re required for 
password reset.

 Figure 4-6. Set Password Security Questions
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4-2-7 Forgot Password

If you forgot the ADM login password, the system will help you 
reset a new password.

To reset your password,

1. Select Forgot password?

Figure 4-7. Select Forgot password?
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4-2-7 Forgot Password(continued)

2. Reset password pop-up appears. Input user name and 
press Next to continue.

Figure 4-8. Input user name

If user types the wrong user name or has not set up 
password security questions yet, a warning message will 
appear on the screen. Press Cancel to exit to Operator 
Login window and the following steps will be skipped.

Figure 4-9. Warning Message
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4-2-7 Forgot Password(continued)

3. Answer 3 password security questions that you previously 
set up when creating ADM password (non-empty) for the 
first time.

Figure 4-10. Answer questions
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4-2-7 Forgot Password(continued)

4. Set up the new ADM password, based on the selected 
Policy Level.

Figure 4-11. Input a new password

NOTE: If the password you type doesn’t meet the password 
complexity rules of selected Policy Level, a warning 
message will appear on the screen and you will be 
prompted to correct the password.

Figure 4-12. Warning Message
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4-2-8 Service Key (SSA) 

A Service Key and a proprietary GE Service password are 
necessary for use by GE Service when performing proprietary 
level diagnostics like accessing the desktop on the BEP. The 
password used with the GE service key changes at specific 
intervals.

The SSA key provides secure access for GE service personnel 
to advanced tools to service the system.

SSA is a class M key with the following characteristics:

• Access to all service features
• Access to Windows Desktop
• Key must be renewed every 30 days
• Tied to SSO
• Password locked via key pad

Please complete the course on GE Learning before using SSA:

Course name: Secure Service Access Training

Course ID: GEHC-SVCS-63061025

NOTE: Press I Agree to enter the Maintenance Access Screen when 
below Information dialogue window appears. Press OK before 
the status bar completes, otherwise the system may enter 
scanning screen.

 Figure 4-13. Service Key Information
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4-2-9 Exit to Windows Desktop from the Versana Active application 
software 

If you want to exit to the Windows Desktop when the application 
software is running, please refer to Proprietary Service Manual.

4-2-10 Removable media 

Refer to the latest revision of the User Manual to perform the 
following tasks:

• Using Removable Media
• Labeling Removable Media
• Formatting Removable Media
• Verifying Removable Media

4-2-11 Backup and Restore Database, Preset Configurations and 
Images

NOTE: Always save presets before any software reload. This ensures 
the presets loaded after the software reload are as up–to–date 
as possible.

All user presets except changes to Summary, Anatomy, and 
Biometry pages, can be saved on an DVD-R disk (or USB 
memory device) for reloading on the system.

NOTE: Presets should NOT be saved on the same USB memory device 
(or DVD-R disk) as images. The Archive Menu lists the images 
but does NOT list the presets stored on a USB memory device 
(or DVD-R disk).
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4-2-11-1 Formatting Media

1. Select Utility -> Connectivity -> Removable Media.
2. Select the media type from the drop down menu.
3. Enter the label for the media. It is best to use all capital 

letters with no spaces or punctuation marks. Select Format.

Figure 4-14. Format and Verify Media

4. The system displays a pop-up menu, as shown in 
Figure 4-15, select OK to continue.

Figure 4-15. Format Warning Pop-up Window

5. If desired, verify that the format was successful by returning 
to Utility-> Connectivity->Removable Media and selecting 
Verify.
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4-2-11-2 Backup System Presets and Configurations

NOTE: Always backup any preset configurations before a software 
reload. This ensures that if the presets need to be reloaded, 
after the software update, they will be the same ones the 
customer was using prior service.

1. Insert a formatted media into the drive.
2. Enter enter Utility-> System-> Backup/Restore.

NOTE: If you are not logged in as GE Service or with administrator 
privileges, the Operator Login window is displayed. Log on 
with administrator privileges.

3. In the Backup list, select Patient Archive, User Defined 
Configuration and Service.

4. In the Media field, select CD/DVD (or USB memory device).
5. Select Backup.

The system performs the backup. As it proceeds, status 
information is displayed on the Backup/Restore screen.

 Figure 4-16. Backup/Restore Menu
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4-2-11-3 Restore System Presets and Configurations

1. Insert the Backup/Restore CD/DVD (or USB memory 
device) into the drive.

2. Enter enter Utility-> System-> Backup/Restore.
NOTE: If you are not logged in with administrator privileges, the 

Operator Login window is displayed.Log on with 
administrator privileges.

3. In the Restore list, select Patient Archive, User Defined 
Configuration and Service.

4. In the Media field, select the Backup/Restore CD/DVD (or 
USB memory device).

5. Select Restore.

The system performs the restore. As it proceeds, status 
information is displayed on the Backup/Restore screen.

 Figure 4-17. Restore message

CAUTION The restore procedure overwrites the existing database on the 
local hard drive. Make sure to insert the correct CD (or USB 
memory device).
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4-2-11-4 Archiving Images

1. Insert the archive media.
2. To format the archive media, enter Utility-> Connectivity-> 

Removable Media.
3. Format the CD. Verify the format if desired.
4. Images will be moved from the hard drive by date. 

Therefore, the best way is to label media by date.
NOTE: Images will be moved from the hard drive by date. 

Therefore, the best way to label media is by date. When 
images are moved to the archive media, they will be deleted 
from the system hard drive. However, the patient database 
(backed up earlier) maintains pointers to the location of the 
images on the archive media.

 Figure 4-18. Format Media Screen

5. Enter Utility-> System-> Backup/Restore.
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4-2-11-4 Archiving Images(continued)

6. Select “Move File Older Than in Days”.

 Figure 4-19. EZBackup/Move

7. Press EZBackup/EZMove.

 Figure 4-20. EZBackup Wizard 1
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4-2-11-4 Archiving Images(continued)

8. Verify the information on the first page of EZBack/EZMove 
wizard, then select Next.If you want to backup all of the 
exams in the range (even if the exam was previously 
backed up), check this option. If you uncheck this option, the 
system only backs up exams which have not yet been 
backed up.

Figure 4-21. EZBackup Wizard 1

9. It indicates the size of the data and the storage. Select Next 
to continue.

NOTE: The calculation for the number of backup CD is only an 
estimate. Allow for one additional CD when performing an 
EZBack/EZMove.

Figure 4-22. EZBackup Wizard 2
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4-2-11-4 Archiving Images(continued)

NOTE: This message “Please insert a blank media...” appears if 
you press Next without inserting the backup media. Insert 
the media and continue.

Figure 4-23. Insert Media Message

10. The status menu appears. When the backup/move has 
been complete, press Next.

Figure 4-24. EZBackup Wizard 3

NOTE: If you need to insert the next media, a message appears 
providing you with the media label.
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4-2-11-4 Archiving Images(continued)

11. When the backup is complete, the completion wizard page 
appears. Press Finish.

Figure 4-25. EZBackup Completion Window

All databases, presets and images should now be saved to 
removable media.

NOTE: After EZBackup completed, system will eject the removable 
media automatically. No need to press F3 key to eject it.
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4-2-12 Data Management

Refer to the latest revision of the Versana Active Basic User 
Manual to perform the following tasks:

• Configuring the Disk Management Function
• Setting the Disk Management Schedule
• Configuring Data Management Settings
• Configuringestination Device Setting
• Running the Disk Management Function
• Starting Disk Management Manually

4-2-13 Backup

For more information, refer to the latest revision of the Versana 
Active Basic User Manual.

4-2-14 Restore the factory defaults

For instructions, please see “Data Backup and Restore” in the 
Basic User Manual/User Guide.

4-2-15 Installation and Setup Procedure for Peripherals

Please refer to 3-8-3 ‘Peripherals Installation Instructions’ on 
page 3-31.

WARNING To avoid not being able to connect to Local Archive, 
connecivity.res and IPSave in 
“D:\Scanner\target\resources\userdefs” should not be deleted. 
If they are deleted, please rewrite the serial number.



General procedures

Versana Active – Basic Service Manual 4-29
5840775-100 English Rev.10

4-2-16 Where are the User Manuals and the Service Manual?

Online versions of the User Manuals are available via the help 
function.

Both the User Manuals and the Service Manual are delivered as 
PDF files on a CD-ROM. Paper copies may be ordered from 
GE.

4-2-17 How to display or print the PDF files from the Manual CD?

1. Insert the CD-R disk (CD-ROM) into the CD-drive on a PC 
or Laptop with Adobe Acrobat Reader.

2. Follow the instructions on the screen to display the manual 
of choice.

3. Before printing the complete manual, or pages from the 
manual, select File > Print.

4. Select the paper size and choose Portrait.
5. Select Print to start printing. In the pop up window, you may 

choose which pages to print and the number of copies you 
want to print (usually 1 copy).

CAUTION Do not try to use the Versana Active to read these files, it will 
not work!
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4-2-18 Cleaning the Trackball

4-2-18-1 Manpower

One person, 10 minutes

4-2-18-2 Tools

• Antistatic brush and/or antistatic vacuum cleaner

4-2-18-3 Preparations

To get access to the trackball for cleaning, you must perform the 
following steps:

1. Power down the system.
2. Disconnect the mains power cable from the wall outlet.

Follow these links if you need more information: See 
4-2-3 ‘Power off’ on page 4-8 for more information.

WARNING DO NOT touch any boards with integrated circuits prior to 
taking the necessary ESD precautions.

Always connect yourself, via an arm-wrist strap, to the advised 
ESD connection point located on the rear of the Ultrasound 
system (near the power connector).

Follow general guidelines for handling of electrostatic sensitive 
equipment.
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4-2-18-4 Clean the Trackball

Dust is often building up behind the ball, so it interferes with the 
ball rotation and for optical trackballs the light used for sensing. 
To get access for cleaning, you need to remove the ball. 

The ball is held in position by the Dust Gasket.

1. Power off the system.
2. Rotate the dust gasket counterclockwise until it can be 

removed from the keyboard.

Figure 4-26. Remove the Retainer

3. Separate the trackball and the gasket. Wipe off any oil or 
dust from the trackball, gasket and the trackball housing 
using a cleaner or cotton swab.

4. Assemble the trackball and gasket, then put it into the 
housing and rotate it clockwise until its notches are set in 
the position.

4-2-18-5 Test the Trackball

Power up the system and test that the trackball now works as 
intended.

CAUTION When cleaning, make sure not to spill or spray any liquid into 
the trackball housing (keyboard or system).
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4-2-19 Cleaning the air filter

Clean the system's air filter to ensure that a clogged filter does 
not cause the system to overheat and reduce system 
performance and reliability. It is recommended the filter be 
cleaned every two weeks, but the requirements will vary due to 
your system use.

4-2-19-1 Cleaning

1. Power off the system.
2. Remove the air filter with hand.

Figure 4-27. Remove the Air Filter

CAUTION DO NOT operate the unit without the air filter in place.

Allow the air filter to dry thoroughly before re-installing it on the 
unit.
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4-2-19 Cleaning the air filter(continued)

3. Dust the filter with a vacuum cleaner and/or wash it with a 
mild soapy solution.
If washed, rinse and dry the filters before re-installation.

4. Put back the air filter in the direction as marked on the 
bottom cover.

Figure 4-28. Install the Air Filter
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4-2-20 Cleaning the gel warmer

The reservoir of the gel warmer is designed to hold the 
redundant gel temporarily. User needs to clean the reservoir in 
time to avoid reservoir being full and leaking inside of the 
system.  

Follow below steps to remove and clean the reservoir:

1. Spin the reservoir counterclockwise to remove it from the gel 
warmer.
a. Clean the reservoir.
b. If there is already gel leaked to the inside of gel warmer, 

please clean it before re-install the reservoir.

 Figure 4-29. Remove the reservoir from gel warmer

2. Re-install the reservoir to the gel warmer.

CAUTION If the gel leaked in the gel warmer always cannot be cleaned 
on time, it may cause a short circuit in the internal board.
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4-2-21 Monitor 

To clean the monitor face:

Use a soft, folded cloth. Gently wipe the monitor face.

DO NOT use a glass cleaner that has a hydrocarbon base (such 
as Benzene, Methyl Alcohol or Methyl Ethyl Kentone) on 
monitors with the filter (anti-glare shield). Hard rubbing will also 
damage the filer.

NOTE: When cleaning the screen, make sure not to scratch the 
monitor.

4-2-22 Operator Control Panel

To clean the operator control panel:

1. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution.

2. Wipe down operator control panel.
3. Use a cotton swab to clean around keys or controls. Use a 

toothpick to remove solids from between keys and controls.

NOTE: When cleaning the operator control panel, make sure not to spill 
or spray any liquid on the controls, into the system cabinet, or in 
the probe connection receptacle.

NOTE: In case of SARS, use bleach, or Cidex in a normal diluted form 
for cleaning/disinfecting the operator panel. 

NOTE: DO NOT use T-spray or Sani Wipes on the control panel. 

NOTE: DO NOT remove AN Key Film when cleaning the operator 
control panel.

CAUTION Before cleaning the control panel, make sure the key cap is 
firmly in place. 
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4-3 Disk Encryption/Decryption

4-3-1 Overview

Disk Encryption is a function to protect the patient information on 
the device and prevent unauthorized access to PI/PHI, 
especially when the device is stolen. The encryption AES is 256 
bit.

NOTE: Disk Encryption can also protect the user data stored on 
removable device.

NOTE: The steps for Removable Media Encryption and Local Patient 
Data Drive Encryption are the same.

CAUTION The user must make backups and take care of the encryption 
password/passphrase and recovery key. It is the customer’s 
responsibility for storing the data. GE will have no back door or 
any responsibility or possibility of recovering the data.
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4-3-2 Disk Encryption

NOTE: Encryption is set as “ON” for Local patient data drive after 
software installation. User can not turn off the Disk Encryption. 
But user can turn on and off the Disk Encryption for Removable 
Media.

Figure 4-30. Encryption ON for R1.1.x

You could change password as you wish.

• Select Change Password and you will be prompted to enter 
old password/passphrase which you previously set up in EZ 
Configuration Wizard, refer to step 3 of 3-9-1 ‘EZ 
configuration Wizard’ on page 3-64.

Figure 4-31. Enter Current Password
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4-3-2 Disk Encryption(continued)

• Enter new password/passphrase,  and re-enter it to confirm.

Figure 4-32. Change Password 1

• Press OK.

Figure 4-33. Change Password 2
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4-3-2 Disk Encryption(continued)

Turn on Disk Encryption of Removable Media on R1.1.x.

1. Login as administrator. Press Utility -> Admin -> System 
Admin -> Disk Encryption.

 Figure 4-34. Disk Encryption 1

2. Select Encryption ON. A confirmation message pops up, 
press Continue to continue the encryption process.

Figure 4-35. Disk Encryption 
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4-3-2 Disk Encryption(continued)

3. Enter a password or a passphrase and re-enter to confirm. 
Press Continue.

Figure 4-36. Disk Encryption 3
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4-3-2 Disk Encryption(continued)

4. Insert a USB and select it to record the recovery key. You 
can also press Print recovery key to print the recovery key, 
or you can press Hide recovery key to hide the recovery 
key.
Press Continue.

Figure 4-37. Disk Encryption 4
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4-3-2 Disk Encryption(continued)

5. When the recording process is completed, a confirmation 
dialog pops up, press OK.

Figure 4-38. Disk Encryption 5

6. Encryption process begins.
You can press Pause to pause the encryption process.

Figure 4-39. Disk Encryption 6

7. When the encryption process completes, press Finish.

NOTE: The encryption process for patient data drive may take thirty 
minutes or more.

CAUTION Make sure to keep the password/passphrase, recovery key 
and any back up of these in secure place, not accessible 
for unintented audience.
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4-3-3 Pause Encryption

1. During encryption process, you can press Pause to stop the 
encryption process.

 Figure 4-40. Encryption Pause 1

2. A confirmation dialog pops up, press Yes to continue or No 
to cancel.

 Figure 4-41. Encryption Pause 2
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4-3-4 Resume Encryption

1. Press Utility -> Admin -> System Admin -> Disk Encryption. 
Press Resume.

Figure 4-42. Encryption Resume 1

2. A confirmation dialog pops up, press Yes to resume 
conversion or press No to cancel.

Figure 4-43. Encryption Resume 2
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4-3-4 Resume Encryption(continued)

3. Encryption of patient data is ongoing. Please do not use the 
system until the process is completed.

Figure 4-44. Encryption Resume 3

4-3-5 Change Encryption Password

After the encryption process is completed, you can change the 
password as you wish (for Disk Encryption of Removable Media 
on R1.1.x). 

1. Press Utility -> Admin -> System Admin -> Disk 
Encryption. Press Change Password.

Figure 4-45. Change Password 1
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4-3-5 Change Encryption Password(continued)

2. Enter new password/passphrase,  and re-enter it to confirm.

Figure 4-46. Change Password 2

3. Press OK.

Figure 4-47. Change Password 3
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4-3-6 Change Recovery Key

After the encryption process is completed, you can change the 
recovery key as you wish (for Disk Encryption of Removable 
Media on R1.1.x). 

1. Press Utility -> Admin -> System Admin -> Disk 
Encryption. Press Save/Change Recovery Key.

Figure 4-48. Change Recovery Key 1

2. Insert a USB to store the new recovery key.

Figure 4-49. Change Recovery Key 2
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4-3-6 Change Recovery Key(continued)

3. Press OK.

Figure 4-50. Change Recovery Key 3

Figure 4-51. Change Recovery Key 4

4-3-7 Unlock with user entered key & recovery key

When the patient data is in locked status, you can unlock it with 
user entered key and recovery key.

You can insert the USB with recovery key, or you can input the 
password or recovery key manually to unlock the system.

NOTE: If you press Cancel, the system will stay in locked status and 
some of the functions will be not available.

Figure 4-52. Unlock Dialog
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4-3-8 Disk Decryption

1. For Disk Encryption of Removable Media on R1.1.x, if you 
want to decrypt the patient data, you can press Utility -> 
Admin -> System Admin -> Disk Encryption. Select 
Encryption Off. 

Figure 4-53. Decryption 1

2. A confirmation dialog pops up, press Yes to continue.
3. Decryption of patient data is ongoing. Please don’t use the 

system until the process is completed.

 Figure 4-54. Decryption 2

4. When the decryption process is completed, press Finish.
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4-4 Functional checks

4-4-1 Overview

In this section, the functional checks for Versana Active are 
described. Functional checks are used to verify that the product 
works as intended. Functional checks may also be used during 
troubleshooting.

4-4-2 Contents in this Section

4-4-3 Preparation

Turn on power to Versana Active. For detailed description, See 
4-2-2 ‘Power ON/Boot Up’ on page 4-5 for more information.
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4-4-4 Basic Controls

4-4-4-1 Control Panel 

 Figure 4-55. Control Panel Map 

1. Power On/Off
2. Patient key
3. Probe key
4. Report key
5. End Exam key
6. Whizz key
7. Active/Gain key
8. M Mode
9. Cursor key
10.  Clear key
11. PW Mode

12. Measure key
13. Body Pattern key
14.  CF Mode
15. B Mode
16. Set key
17. Freeze key
18. Depth/Ellipse/Zoom key
19. Dual key
20. Quad key
21. Phycial print buttons (Utility 

-> Connectivity -> Button) 
22. CHI key

23. User Configurable Keys
24. Scan Coach key
25. Primary Menu keys
26. Up/Down keys
27. TGC
28. Trackball
29. Comment key
30. Utility
31. Alphanumeric Keyboard
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4-4-4-2 Primary Menu Keys Tour

Press primary keys to adjust the value of the softmenu 
associated with it.

Press up/down buttons to turn the menu page up and down.

 Figure 4-56. Primary Menu Keys Tour
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4-4-5 Control Panel 

 Figure 4-57. Monitor Display Tour 

1. Institution/Hospital Name, Date, Time, Operator 
Identification.

2. Patient Name, Patient Identification.
3. Power Output Readout.
4. Probe Identifier. Exam Preset.
5. Current date and time, Caps Lock: (lit when on), 

network connection indicator, system messages 
display, InSite status, InSite controls.     

6. Imaging Parameters by Mode.     
7. Cine Gauge. 
8. Active Images screen. 
9. Delete Image. 
10. Save As Menu.
11. Slide Show.
12. Follow-up tool.

13. Image Preview.
14. Primary menu.
15. Measurement Results Window.
16. Gray/Color Bar.
17. Image Clipboard.
18. Probe Orientation Marker.
19. Image.
20. Measurement Calipers.
21. Region of interest.
22. Depth Scale.
23. Focal Zone Indicator.
24. Body Pattern.
25. Measurement Summary Window.
26. User Configurable Key.
27. P1,P2.
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4-4-6 Performance Tests

4-4-6-1 Image Quality Check (IQC) preset for service

Image Quality Check (IQC) is intended to facilitate Image 
Quality checks during Quality Assurance Evaluation. Quality 
Assurance tests are used to determine whether a scanner is 
providing the same level of performance year after year.

By using the same setting year after year, this ensures that the 
data collection consistent, independently of who performs the 
test.

This preset only includes fundamental settings for 2D mode. 
Processing modes like SRI, Harmonics, etc., are turned off.

To do IQC, follow the steps below:

NOTE: The IQCforService is only visible when service dongle is 
connected to the system.

1. Activate IQC via Utility--> Admin--> System Admin. 
Check the “Enable IQC for Service” box. Select Save, then 
select Exit.

 Figure 4-58. Check “Enable IQC for Service”

2. Press Utility -> Preset Manager. Select IQC from the left 
column, and select  to move it to the Imaging 
Preset Selections. Then Select Exit. 
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4-4-6-1 Image Quality Check (IQC) preset for service(continued)

 Figure 4-59. Image Quality Check

3. Press Probe on the control panel. Then select IQC.

 Figure 4-60. Image Quality Check

4-4-6-2 Test Phantoms

The use of test phantoms is only recommended if required by 
your facility's (customer’s) QA program.
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4-4-7 B Mode Checks

4-4-7-1 Introduction

The B Mode is the system’s default mode.

4-4-7-2 Preparations

• Connect one of the probes. 
• Turn ON the scanner.

The B Mode is displayed (default mode).

4-4-7-3 Adjust the B mode controls

Press B Mode on the Operator Panel to access B mode.

These Image Controls are used to optimize the B Mode picture. 
Verify that all the listed controls are working as intended:

• Use Gain and TGC controls to optimize the overall image 
together with the Power control.

• Use Depth to adjust the range to be imaged.
• Use Focus to center the focal point(s) around the region of 

interest.
• Use Frequency (move to higher frequencies) or Line 

Density (move to higher line density) to increase resolution 
in image.

• Use Frequency (move to lower frequency) to increase 
penetration.

• Use the Rejection control to reduce noise in the image.
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4-4-8 M Mode Checks

4-4-8-1 Preparations

• Connect one of the probes to the scanner’s probe 
connector.

• Turn ON the scanner. 
The 2D Mode window is displayed (default mode).

• Press M Mode on the Operator panel to bring up an 
M-Mode picture on the screen.

Use the trackball to position the cursor over the required 
area of the image.

4-4-8-2 Adjust the M Mode controls

These Image Controls are used to optimize the M mode picture. 
Verify that all the listed controls are working as intended:

• Adjust Sweep Speed to optimize the display resolution.

Adjust Gain and TGC controls to adjust the range to be 
imaged.
Adjust Compression and Edge Enhance to further 
optimize the display.
Adjust Rejection to reduce noise while taking care not to 
eliminate significant low-level diagnostic information.
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4-4-9 Color Mode Checks

4-4-9-1 Introduction

Color Flow screens are 2D or M Mode screens with colors 
representing blood or tissue movement.

Color Flow may be selected both from 2D mode or from M mode 
or a combination of these.

4-4-9-2 Preparations

• Connect one of the probes to the scanner’s probe 
connector.

• Turn ON the scanner.

The 2D Mode window is displayed (default mode).

4-4-9-3 Select Color 2D Mode

1. From an optimized 2D image, press CF.
2. Use the trackball to position the ROI frame over the area to 

be examined.
3. Press Set. The instruction Size should be highlighted in the 

trackball status bar. Use the trackball to adjust the 
dimension of the ROI.
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4-4-9-4 Adjust the Color Mode controls

• Adjust the Active mode gain to set the gain in the color flow 
area.

Adjust Scale to the highest setting that provides adequate 
flow detection.

NOTE: The scale value may affect FPS, Low Velocity Reject, and 
Sample Volume.

Adjust Wall Filter to remove low velocity blood flow and 
tissue movement that reduces image quality.
Adjust Sample Volume to a low setting for better flow 
resolution, or a higher setting to more easily locate disturbed 
flows.
Adjust Frequency to optimize the color flow display. Higher 
settings improve resolution. Lower settings improve depth 
penetration and sensitivity. This does not affect the 
frequency used for 2D and M-Mode.

NOTE: Frequency setting may affect FPS, SV and Low Velocity 
Reject.

Adjust PowerOutput to obtain an acceptable image using 
the lowest setting possible.

NOTE: The Power setting affects all other operating modes.

Adjust the following settings to further optimize display of the 
image:

• Use Invert to reverse the color assignments in the color flow 
area of the display.

Use Threshold to emphasize either the color flow overlay, 
or the underlying grey scale tissue detail.
Use Baseline to emphasize flow either toward or away from 
the probe.
Use Spatial Filter to reduce noise in the color flow area. 
Spatial Filter smooths the image by averaging collected data 
along the same horizontal line. An increase of the spatial 
filter will reduce noise, but this will also reduce the lateral 
resolution.
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4-4-10 Select Color M Mode

1. Select M Mode.
2. Use the trackball to position the ROI frame over the area to 

be examined.
3. Press Set. The instruction Size should be highlighted in the 

trackball status bar. Use the trackball to adjust the 
dimension of the ROI.

4-4-10-1 Adjust the Color M Mode controls

• Adjust the Active mode gain to set the gain in the color flow 
area.

Adjust Scale to the highest setting that provides adequate 
flow detection.

NOTE: The scale value may affect FPS, Low Velocity Reject, and 
Sample Volume.

Adjust Wall Filter to remove low velocity blood flow and 
tissue movement that reduces image quality.
Adjust Sample volume (SV) to a low setting for better flow 
resolution, or a higher setting to more easily locate disturbed 
flows
Adjust Frequency to optimize the color flow display. Higher 
settings improve resolution. Lower settings improve depth 
penetration and sensitivity. This does not affect the 
frequency used for 2D and M-Mode.

NOTE: NOTE: Frequency setting may affect FPS, SV and Low 
Velocity Reject.

Adjust PowerOutput to obtain an acceptable image using 
the lowest setting possible.

NOTE: The Power setting affects all other operating modes.

Adjust the following settings to further optimize display of the 
image:

• Use Invert to reverse the color assignments in the color flow 
area of the display.

Use Threshold to emphasize either the color flow overlay, 
or the underlying grey scale tissue detail.
Use Baseline to emphasize flow either toward or away from 
the probe.
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4-4-11 PW Doppler Mode Checks

4-4-11-1 Introduction

PW Doppler are used to measure velocity (most often in blood).

Doppler mode can be done with a special pencil probe or with 
an ordinary probe. By using an ordinary probe, you can first 
bring up a 2D picture for navigation purpose and then add PW 
Doppler.

4-4-11-2 Preparations

• Connect one of the probes to the scanner. 
• See 4-4-14 ‘Probe/Connectors Check’ on page 4-66 for info 

about connecting the probes.
For available probes, see 9-3-4 ‘Probe’ on page 9-7: 

• Turn ON the scanner.
The 2D Mode window is displayed (default mode).

• If needed, adjust the Display’s Brightness and Contrast 
setting. 

Press PW to start Pulsed Wave Doppler (PW).
Use the trackball to select the Area of Interest (Sample 
Volume) in PW.
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4-4-11-3 Adjust the PW Doppler Mode controls

Adjust the Active mode gain to set the gain in the spectral 
Doppler area.

• Adjust Wall Filter to reduce unwanted low velocity blood 
flow and tissue movement.

In PW mode, adjust Volume to low setting for better 
resolution, or higher setting to more easily locate the 
disturbed flows.
Adjust the Compression setting to balance the effect of 
stronger and weaker echoes and obtain the desired intensity 
display.
Adjust Frequency to optimize flow display. Higher setting 
will improve resolution and the lower setting will increase the 
depth penetration.
Adjust Frame rate to a higher setting to improve motion 
detection, or to a lower setting to improve resolution.

NOTE: Frequency and Frame rate settings may affect the Low 
Velocity Reject.

Adjust Power Output to obtain an acceptable image using 
the lowest setting possible. This is particularly important in 
CW mode, as the energy duty cycle is 100% (constant).

NOTE: The Doppler Power setting affects only Doppler operating 
modes.

Adjust the following settings to further optimize the display 
of the image.
Use the Sweep Speed to optimize the sweep speed. 
To view signal detail, adjust Scale to enlarge the vertical 
spectral Doppler trace.
Use Invert to reverse the vertical component of the spectral 
Doppler area of the display.
Use Angle Correct to steer the ultrasound beam to the 
blood flow to be measured.
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4-4-12 Tissue Velocity Imaging (TVI) Checks

4-4-12-1 Introduction

TVI calculates and color codes the velocities in tissue. The 
tissue velocity information is acquired by sampling of tissue 
Doppler velocity values at discrete points. The information is 
stored in a combined format with grey scale imaging during one 
or several cardiac cycles with high temporal resolution.

4-4-12-2 Preparations

• Connect one of the probes, to the scanner’s probe 
connector. 

• See 4-4-14 ‘Probe/Connectors Check’ on page 4-66 for info 
about connecting the probes.
For available probes, see 9-3-4 ‘Probe’ on page 9-7: 

• Turn ON the scanner.
The 2D Mode window is displayed (default mode).

• If needed, adjust the Display’s Brightness and Contrast 
setting. 

Press User Configurable Key to get into TVI.
Use the trackball (assigned function: Pos) to position the 
ROI frame over the area to be examined.
Press Set. The instruction Size should be highlighted in the 
trackball status bar.

NOTE: If the trackball control pointer is selected, press trackball to 
be able to select between Position and Size controls.

Use the trackball to adjust the dimension of the ROI.
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4-4-12-3 Adjust the TVI Controls

• To reduce quantification noise (variance), the Nyquist limit 
should be as low as possible, without creating aliasing. To 
reduce the Nyquist limit: Reduce the Scale value.

NOTE: The Scale value also affects the frame rate. There is a trade 
off between the frame rate and quantification noise.

TVI provides velocity information only in the beam direction. 
The apical view typically provides the best window since the 
beams are then approximately aligned to the longitudinal 
direction of the myocardium (except near the apex). To 
obtain radial or circumferential tissue velocities, a 
parasternal view must be used. However, from this window 
the beam cannot be aligned to the muscle for all the parts of 
the ventricle.

NOTE: PW will be optimized for Tissue Velocities when activated 
from inside TVI.
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4-4-13 Basic Measurements

NOTE: The following instructions assume that you first scan the patient 
and then press Freeze.

4-4-13-1 Check Distance and Tissue Depth Measurement

1. Press Measure once to display an active caliper.
2. Move the trackball to position the active caliper at the start 

point (distance) or the most anterior point (tissue depth).
3. Press Set to fix the start point.
4. The system fixed the first caliper and displays a second 

active caliper.
5. Move the trackball to position the second active caliper at 

the end point (distance) or the most posterior point (tissue 
depth).

6. Press Set to complete the measurement. The system 
displays the distance or tissue depth value in the 
measurement results window.

Before you complete a measurement:

To toggle between active calipers, rotate Cursor Select button.

To erase the second caliper and the current data measured and 
start the measurement again, press Clear.

NOTE: To rotate through and activate previously fixed calipers, rotate 
Cursor Select button.

NOTE: After you complete the measurement, to erase all data that has 
been measured to this point, but not data entered onto 
worksheets, press Clear.
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4-4-14 Probe/Connectors Check

NOTE: Probes can be connected at any time, whether the unit is ON or 
OFF.

4-4-14-1 To connect a Probe

1. Place the probe’s carrying case on a stable surface and 
open the case.

2. Carefully remove the probe and unwrap the probe cable.
3. Put the probe in the probe holder.

4. Hold the probe connector vertically with the cable pointing 
upward.

5. Align the connector with the probe port and carefully push 
into place.

6. Lock the probe latch upward.
7. Carefully position the probe cable in the probe cord holder 

spot so it is free to move, but not resting on the floor.

CAUTION DO NOT allow the probe head to hang free. Impact to the 
probe head could result in irreparable damage.

CAUTION TAKE THE FOLLOWING PRECAUTIONS WITH THE PROBE 
CABELS:

-KEEP AWAY FROM THE WHEELS

-DO NOT BEND

-DO NOT CROSS CABLES BETWEEN PROBES

Table 4-1:  Probe and Connectors Checks

Step Task Expected Results

1 Select the appropriate connected probe from the 
probe indicators.

The probe activates in the currently-selected 
operating mode. The probe’s default settings 
for the mode and selected exam are used 
automatically.

2 Launch the application. To change application, 
press Probe key on the Control Panel.

The selected application starts.

3 Verify there’s no EMI/RFI or artifacts specific to the 
probe.

No EMI/RFI or artifacts.

4 Test the probe in each active connector slot. It will display pictorial data each time.
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4-4-14-2 Activating the probe

The probe activates in the currently-selected operating mode. 
The probe’s default settings for the mode and selected exam are 
used automatically.

4-4-14-3 Deactivating the probe

1. Press the Freeze key.
2. Gently wipe the excess gel from the face of the probe. 

(Refer to the User Guide for complete probe cleaning 
instructions.)

3. Carefully slide the probe around the right side of the 
keyboard, toward the probe holder. Ensure that the probe is 
placed gently in the probe holder.

4-4-14-4 Disconnecting the probe

Probes can be disconnected at any time. However, the probe 
should not be active when disconnecting the probe.

1. Deactivate the probe.
2. Slide the conenctor lock downwards to unlock the probe.
3. Pull the probe connector straight out of the probe port 

carefully.
4. Ensure the cable is free.
5. Be sure that the probe head is clean before placing the 

probe in its storage box.

5 Do a leakage test on the probe, See 
10-7 ‘Electrical safety tests’ on page 10-21 for 
more information.

It passes the test.

6 Repeat this procedure for all available probes.

Table 4-1:  Probe and Connectors Checks

Step Task Expected Results

WARNING Take the following precautions with the probe cables: Do not 
bend, be sure to keep probe cables free from the wheels.
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4-4-15 ECG Check

4-4-15-1 Introduction

The ECG capability on this unit, is intended as use as a trigger 
for measurements, but can also be viewed on the screen.

4-4-15-2 Parts needed

• ECG Module 

4-4-15-3 Preparations

None

4-4-15-4 ECG Check

Table 4-2:  ECG Checks

Step Task Expected Result(s)

1 Connect the ECG harness to the connector 
under the control panel.

The unit displays a straight curve along the 
bottom edge of the image sector on the screen.

2 Connect the three leads to an ECG simulator,
or
Fasten the three ECG Pads to your body and 
connect the three leads to respective ECG 
Pad.

When connecting, the signal on the screen will 
be noisy.
When the connection is completed, a typical 
clean ECG signal is displayed.
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4-4-16 Cineloop Check

4-4-16-1 Introduction

A cineloop is a sequence of images recorded over a certain time 
frame. When using ECG the time frame can be adjusted to 
cover one or more heart cycles. When frozen, the System 
automatically displays the cineloop boundary markers on either 
side of the last detected heart cycle.

4-4-16-2 Preparation

• Connect one of the probes to the scanner. 
• See 4-4-14 ‘Probe/Connectors Check’ on page 4-66 for info 

about connecting the probes
For available probes, see 9-3-4 ‘Probe’ on page 9-7: 

• Turn ON the scanner. The 2D Mode is displayed (default 
mode).

4-4-16-3 Adjust the Cineloop controls

• Press Freeze.
The left and right markers are displayed on either side of the 
last detected heart cycle on the ECG trace.

• Press Freeze.
The selected heart beat is played back.

• Press Freeze to freeze the cineloop.
Use the trackball to scroll through the acquisition and find 
the sequence of interest.

• Adjust Cycle select to move from heart beat to heart beat 
and select the heart cycle of interest.

Adjust Num cycles to increase or decrease the number of 
heart beats to be played back.
Adjust Left marker and Right marker to trim or expand the 
cineloop boundaries.



General Procedures and Functional Checks

4-70 Versana Active – Basic Service Manual
5840775-100 English Rev.10

4-4-17 Back End Processor checks

• If all the previous tests have been passed successfully, the 
Back End Processor is most likely OK.

If the system seems to be operating erratically, please refer 
to ‘Diagnostics/Troubleshooting’ on page 7-1.

4-4-18 Operator Panel Test

• The Operator Panel is tested when the Versana Active is 
powered up as part of the start-up scripts, run at every 
start-up. 

For more info, please refer to ‘Diagnostics/Troubleshooting’ 
on page 7-1.

4-4-19 Peripheral checks

Check that peripherals work as described below:

4-4-19-1 Printer checks

The internal printer is controlled from the P1 and P2 keys on the 
Versana Active’s Operator Panel. 

The factory default is:

• P1 for the screen capture to clipboard

P2 for the standard printer

Table 4-3:  Peripheral Checks

Step Task to do Expected Result(s)

1. Press FREEZE Stop image acquisition.

2. Press P2 on the 
Control Panel

The image displayed on the screen is 
printed on B&W printer.

3. Connect with Foot 
Switch on USB port 
and press once.

To start image acquisition (the same 
function as FREEZE key).
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4-4-20 Turn OFF Power to Versana Active

See 4-2-3 ‘Power off’ on page 4-8 for more information.

4-4-21 Mechanical Functions Checks

4-4-21-1 Operator Panel Movement

Please refer to:

• 6-3 ‘Monitor Adjustments’ on page 6-5

4-4-21-2 Casters (Wheels) and Brakes Checks

Examine the wheels frequently for defects to avoid breaking or 
jamming.

Table 4-4:  Wheel Characteristics

Wheel Characteristics

Front and Rear Swivel and Brake
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4-5 Power supply test & adjustments

4-5-1 Power Supply Test Procedure

There is no need to do any special tests on the Power Supplies 
if there don’t seems to be a problem that may be related to the 
Power Supply. 

Refer to 7-7-1-2 ‘System Doesn’t Boot (Hang-up)’ on page 7-57, 
if you appear to have a problem that may be related to the 
Power Supplies. 

4-5-2 Power Supply Adjustment

There are no adjustments on the power supply. The DC Power 
is self-regulated. If a voltage is outside the specified range, it 
means that something is wrong, either with the power supply 
itself or with a unit connected to that specific power outlet. When 
an error occur, the power will be turned off immediately.

Refer to 7-7-1-2 ‘System Doesn’t Boot (Hang-up)’ on page 7-57, 
if you appear to have a problem that may be related to the 
Power Supplies. 
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4-6 Application Turnover Check List

Complete these checks before returning the scanner to 
customer for use:

4-6-1 Software Configuration Checks

Table 4-5:  Software Configuration Checks

Step Task to do Notes

1 Verify Date and Time is correct.

2 Verify that Location (Hospital Name) is correct.

3 Verify Language settings are correct.

4 Verify assignment of Print Keys.

5 Verify all of the customer’s options are set up 
correctly.

Demo Option strings turn on 
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4-7 Site Log

Table 4-6:  Site Log

DATE SRVICE PERSON PROBLEM COMMENTS
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4-8 My Trainer

4-8-1 Overview

My Trainer provides a quick guide to operate the system.

To access My Trainer,

1. Press Alt + H to enter My Trainer.
Or,

1. Press Utility -> System -> User Configurable Key. Check 
Enable Numeric Hot Key, then set My Trainer in the 
Keyboard Key or User Defined Key.

 Figure 4-61. Set My Trainer

2. Press defined key to access My Trainer.
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4-8-1 Overview(continued)

There are four sections in My Trainer. The four sections are 
displayed on the left side of the My Trainer interface. 

Figure 4-62. Sections display

1. Getting Started: Probe Connection
2. System Setting: EZ Configure, Enable Options Check, 

Enable Option Key Activation Workflow, Numeral Key Conf, 
User Defined Keys Conf, Create Preset, Preset Archive and 
Restore, Patient Archive and Restore, Images Archival, My 
Preset, Back-up/Restore the Patient Preset, System 
Software Update, Standby Mode, Software Version

3. Peripheral Connection: Back Panel Ports, Wired 
Connectivity, Wireless Connectivity, Bluetooth Connectivity, 
Connect to Thermal Printer, Connect to Network Printer, 
DICOM Worklist Setting, DICOM Image Storage

4. Maintenance: Contact GE service, Configure Insite Agent 
for Remote Service, Log Export, Trackball Cleaning, Air 
Filter Replacement, AN Key Film, Isolation USB 
Connection, Keycaps



My Trainer

Versana Active – Basic Service Manual 4-77
5840775-100 English Rev.10

4-8-1 Overview(continued)

 Figure 4-63. Interface Illustration

The interface of the My Trainer includes below information:

1. The product name of the system.
2. Sections. Select the button to expand the section to show 

the list of subsections.
3. Subsections.
4. The highlighted subsection shows this subsection is 

currently opened and displayed on the right side.
5. Exit. Press this button to exit this interface.
6. The left number shows the current page of the subsection. 

The right number shows the total pages of the subsection.
7. Illustration with graphic.
8. Previous, Next, Home, End icons.



General Procedures and Functional Checks

4-78 Versana Active – Basic Service Manual
5840775-100 English Rev.10

4-8-1 Overview(continued)

9. Step Description

Table 4-7:  Page turning

Select the arrow to go to the previous page.

Select the arrow to move to the next page.

Select the arrow to go to the home page.

Select the arrow to go to the end page.



Versana Active – Basic Service Manual 5-1
5840775-100 English Rev.10

Chapter 5

Components and Functions
(Theory)

This chapter explains Versana Active’s system 
concepts, component arrangement, and subsystem 
functions. 

It also describes the power distribution and the 
Common Service Desktop interface.
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5-1 Overview

5-1-1 Contents in this chapter

• 5-1 ‘Overview’ on page 5-2
• 5-2 ‘Block Diagram and Theory’ on page 5-3
• 5-4 ‘Common Service Desktop’ on page 5-7
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5-2 Block Diagram and Theory

5-2-1 General Information

Versana Active is an ultrasound imaging scanner.

The system can be used for:

• 2D Gray Scale 
• 2D Color Flow imaging
• M-Mode Gray Scale imaging
• Color M-Mode
• Doppler
• Different combinations of the above

Signal flow from the Probe Connector Panel to the Front End, to 
the Mid Processors and Back End Processor and finally to the 
monitor and peripherals.

System configuration is stored on a hard disk drive and all 
necessary software is loaded from the hard disk drive on power 
up.

5-2-2 Top Console

The Top Console includes a Standby/On switch, a keyboard, 
different controls for manipulating the picture quality, controls for 
use in Measure & Analyze (M&A), and loudspeakers for stereo 
sound output (used during Doppler scanning).
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5-2-3 Block Diagram

5-2-3-1 System Diagram

 Figure 5-1. Versana Active System Block Diagram
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5-2-3-2 Introduction

4D signal board provides 4D control signals from MST board to 
4D transfer board via communication cable.
4D transfer board provides power supply and control signals to 
4D module.

3PP board provides 3 ports for RS type probe and activates the 
related probe port analog/digital signals connection to the 
system under the control of MST.

Boost board provides constant power supply output with either 
AC input or big battery input, it also can communicate with CWI 
board to deliver battery information via USB bus.

Buck board provides 19V and 12V power supply to whole 
system.
Battery charger board can be used to charge battery 
independent.

LED board can be used to display the charge status information.

Video adapter board receives HDMI signals from console and 
transfers them into S-video and composite output.

USB HUB board shall receive USB signals from upstream port 
of console and provide USB downstream port to printer, DVD 
and boost board.

AC-DC module receives AC input and provides DC output to 
boost board. It also provides AC output to AC printer.

Big battery case can be used to charge big battery pack.
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5-3 Program  Diagram

5-3-1 Oveview

The AC Power assyís main tasks are to isolate and output to the 
DC/DC unit which is inside the system console. The input of AC 
power pack will be the AC outlet and itís universal, the range is 
AC 100V-240V, 50-60Hz. And no main power switch located on 
this power pack.

5-3-2 AC Power

Versana Active Power supply is an ACDC adapter which use 
100V-240V,(50-60Hz) as input and DC 19V (7.9A) as output.

Figure 5-2. ACDC Adapter

5-3-3 Power On Sequence

NOTE: During normal boot-up, the power supply is distributed to each 
board.

1. ACDC powered.
2. Power available from ACDC->CWI, CWI waiting for power 

on signal.
3. Power on signal from Keyboard->CWI .
4. CWI activated.
5. CWI supply power to MST and other parts.
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5-4 Common Service Desktop

5-4-1 Introduction

The Service Desktop is an interface that provides access to 
system information, status and diagnostics.

The Service Desktop has different content or views depending 
on the access level. The access level is determined by the user 
profile as well as the service options enabled on the Versana 
Active.

• Basic view is the standard view, restricted only by the user 
through the user profile settings. Administrator default user 
has access to the Service Desktop. Any user with "local 
Service access" in their user profile can have access to this 
view.

• Class C view is the view enabled by the service options 
purchased.

• Service Advanced
• Service Expert (requires Service Advanced)
• Service Pro (requires Service Advanced)
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Chapter 6

Service Adjustments

This chapter describes how to test and make 
adjustments to the Versana Active. You can use these 
to test the system for errors.
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6-1 Overview

6-1-1 Contents in this chapter

• 6-1 ‘Overview’ on page 6-2
• 6-2 ‘Preset Region’ on page 6-3
• 6-3 ‘Monitor Adjustments’ on page 6-5
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6-2 Preset Region

Only factory default presets are supported. User is allowed to 
selection region presets according to where the system is used 
with service support.

Table 6-1:  Preset Region

Region Preset Region

USA, Canada and Latin America USA_LA_Preset

Europe EU Preset

China China Preset

APAC Asia Preset

South Asia India Preset

Middle East, Africa and other countries EAGM Preset



Service Adjustments

6-4 Versana Active – Basic Service Manual
5840775-100 English Rev.10

6-2-1 Region presetting procedure

The Region Presetting procedure:

• In Utility--> System--> General, select the correct region 
from Preset Region (restart needed), refer to Figure 6-1 on 
page 6-4.

Figure 6-1. Region Preset

• The window below will display after the region being 
selected. Select "Ok", refer to Figure 6-2 on page 6-4.

Figure 6-2. Quesiton

• After "Ok" is selected, the window below will display.Select 
"Restart now" and then restart the system.

Figure 6-3. Restart the system
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6-3 Monitor Adjustments

6-3-1 Purpose of this section

This section describes how to test and adjust the scanner. 
These tests are optional. You may use them to check the 
system for errors.

6-3-2 Monitor Adjustments

Please refer to User Manual for how to adjust the Monitor 
Position, Brightness and Contrast.

To adjust the brightness and volume:

1. On the alphanumeric keyboard,
• adjust brightness with Ctrl +Up/Down keys;
• adjust volume with Ctrl +Left/Right keys.

Figure 6-4. Monitor Adjustment



Service Adjustments

6-6 Versana Active – Basic Service Manual
5840775-100 English Rev.10

6-3-3 Brightness and Contrast

1. Press Cursor key on the control panel. Move the trackball to 
position the cursor over the adjustment icon, then press Set 
to display the setting menu.

Figure 6-5. Setting Menu Icon

2. Follow the procedure below to adjust the Color 
Temperature, Contrast, Brightness and LED Light:
• To adjust the color temperature: press Standard, 

Brown, or Blue to choose the color temperature. The 
chosen color temperature displays in the Color Temp 
area.

Figure 6-6. Color Temperature

• To adjust the Contrast: Press Set to choose the 
adjustment button, hold down the Set key and move the 
trackball to move the adjustment button. Move the 
adjustment button to the left to decrease the  contrast or 
move the adjustment button to the right to increase the 
contrast.

Figure 6-7. Contrast



Monitor Adjustments

Versana Active – Basic Service Manual 6-7
5840775-100 English Rev.10

6-3-3 Brightness and Contrast(continued)

• To adjust the Brightness: Press Set to choose the 
adjustment button, hold down the Set key and move the 
trackball to move the adjustment button. Move the 
adjustment button to the left to decrease the brightness 
or move the adjustment button to the right to increase 
the brightness.

Figure 6-8. Brightness

3. Press Reset to return to the default setting; Press Exit to 
exit the setting menu.

NOTE: Press Reset button and the three color temperature settings 
will return to the default settings.
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Chapter 7

Diagnostics/Troubleshooting

This chapter describes how to setup Versana Active 
and run the tools and software that help maintain image 
quality and system operation. Very basic host, system 
and board levels are run whenever power is applied. 
Some Service Tools may be run at the application level. 
However most software tests are required.
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7-1 Overview

7-1-1 Contents in this chapter

• 7-1 ‘Overview’ on page 7-2
• 7-2 ‘Gathering Trouble Data’ on page 7-3
• 7-3 ‘Screen Capture’ on page 7-5
• 7-5 ‘Common Service Desktop’ on page 7-14
• 7-6 ‘Network and Common Diagnostics’ on page 7-37
• 7-7 ‘Troubleshooting’ on page 7-56
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7-2 Gathering Trouble Data

7-2-1 Overview

There may be a time when it would be advantageous to capture 
trouble images and system data (logs) for acquisition to be sent 
back to the manufacturer for analysis. There are different 
options to acquire this data that would give different results.

7-2-2 Collect Vital System Information

The following information is necessary in order to properly 
analyze data or images being reported as a malfunction or being 
returned to the manufacturer:

Product Name = Versana Active

From the Utility>System>About screen:

Applications Software

• Software Version
• Software Part Number

System Image Software

• Image Date
• Image Part Number

Additional Information
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7-2-3 Collect a Trouble Image with Logs

If the system should malfunction, press the Alt+D keys 
simultaneously. This will collect a screen capture of the image 
monitor, system presets and several log files in a date and time 
stamped “.zip” file.

NOTE: This function may also be used to make a Print Screen.

This Alt+D function is available at all times.

When Alt+D is pressed, a menu box appears that allows for:

• a place to enter a description of the issue
• a checkbox to indicate a System lockup
• a choice to Export a pre-formated CD-R/DVD-R or save to 

the Export directory D: drive (for remote viewing through 
FFA)

Figure 7-1. Alt+D Dialog Box
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7-3 Screen Capture

There may be times when the customer or field engineer will 
want to capture a presentation on the screen. This is 
accomplished by first saving the image(s) to the clipboard using 
a Print Key. 

7-3-1 Setting the P1 Key to Screen Capture

If the P1 Key is not set to screen capture:

1. Press Utility -> Connectivity -> Button.
2. Select Print1. Then Select Copy to Dataflow and press >> 

button to add it to Printflow View, press Save. Now when 
you press the P1 button, the image will be saved to the 
clipboard.

Figure 7-2. Configure the P1 Key
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7-3-2 Capturing a Screen

The following is a generic process to capture any screen from 
the scanner:

1. Navigate to and display the image/screen to be captured.
2. Press P1. This will place a snapshot of the screen on the 

“clipboard” displayed at the left side of the scan image 
display.

 Figure 7-3. Select Image to Capture

3. Select and highlight the snapshot to be stored.
4. Select Save As Icon on the lower left of the image screen.

Figure 7-4. Menu > Save As
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7-3-2 Capturing a Screen(continued)

5. A Save dialog box will be opened. Choose the archive 
location to save image on the USB Drive or CD/DVD.

Figure 7-5. Save Dialog Box

NOTE: Click Save -> Transfer To CD/DVD, if the archive location is  
DVD/CD; Click Save, if the archive location is USB.

NOTE: It is better to save the image in Jpeg format. Image of this 
format can be easily reviewed in the computer.
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7-3-3 Capturing a Screen with Service Key

The following is a generic process to capture the whole screen 
from the scanner:

1. Insert the Service Key in the system’s USB port.
2. Press Prtsc key on the control panel, the whole screen is 

captured.
3. Press Ctrl+Alt+Delete, the Start Task Manager dialog is 

displayed.
NOTE: It is also available to Exit to Windows and save the image on 

the system or removal media. For how to Exit to Windows, 
please refer to Proprietary Service Manual.

4. In Windows Task Manager, select File-> New Task 
(Run...).

Figure 7-6. Windows Task Manager

5. Type in the program name: mspaint.

Figure 7-7. Create New Task
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7-3-3 Capturing a Screen with Service Key(continued)

6. The paint screen is displayed, press Ctrl+V to paste the 
captured screen. And then save the image in the 
appropriate destination.

 Figure 7-8. Save Image
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7-3-4 Capturing a Screen by physical print buttons

The following is a generic process to capture the whole screen 
from the scanner:

1. Press Utility -> Connectivity -> Button to configure 
Physical Print Buttons for the button to capture screens.

2. Select any key from Print1, Print2, Print3 or Print4 from 
Physical Print Buttons.

3. Select Secondary Capture Screen from Format.
4. Select USB Quick Save, press >> to move to right column. 

Press Save and Exit.

 Figure 7-9. Windows Task Manager

5. After Print key configuration complete, press the configured 
Print key, the captured screen will be saved to the USB 
directly. 
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7-4 System Warning/Error and Logs

7-4-1 Temperature warning

Figure 7-10. Temperature Warning

• Cause: CPU temperature exceeds threshold (95 degrees)
• What to do: shut down the system and clean the filter.

7-4-2 Temperature exceeds threshold

Figure 7-11. Temperature exceeds threshold

• Cause: CPU temperature exceeds threshold (100 degrees) 
and therefore, system must be shutdown immediately.

• What to do: shut down the system and clean the filter.
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7-4-3 System voltage failure

Figure 7-12. System voltage failure

• Cause: Hardware and/or voltage error detected.
• What to do: Press OK and reboot the system.

7-4-4 Hardware configuration error

Figure 7-13. Hardware configuration error

• Cause: Hardware(s) is not detected as valid system. 
System is able to boot up but not able to scan.

• What to do

1. Press OK and reboot the system.
2. If the problem persists, shut down the system and analyze 

the log files in Technical Support Mode.
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7-4-5 System error

Figure 7-14. System error

• Cause: Hardware(s) is not detected as valid system. 
System is able to boot up but not able to scan.

• What to do

1. Press OK, turn off the system and then reboot it.
2. If the problem persists, shut down the system and analyze 

the log files.
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7-5 Common Service Desktop

7-5-1 Purpose of this section

This section describes the features of the Service desktop. 
These are the different levels of access to the Service desktop:

• Service Basic access (Class A) - a user locally logged into 
the machine with Local Service Access privilege. This level 
provides limited access to Service desktop widgets and 
utilities.

• Service Expert, Pro, and Advanced access (Class C) Local - 
Depending on the purchase level, includes an option string 
to control access.

• GE Service access (Class M) and an SSA key. For users 
with local Service Access privileges, this level provides 
unrestricted access to all Service desktop widgets and 
utilities.

• Remote access - a user remotely accessing the Versana 
Active. This level provides unrestricted access to all Service 
desktop widgets and utilities. Disruptive mode is limited to 
the user access privileges to Remote Service Access.
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7-5-2 Disruptive mode

Disruptive mode is a way to control interruptions to operation of 
the Versana Active. Disruptive mode is required whenever 
service performs a function that may disrupt a normal scan. 
Activating Disruptive mode results in a red message displayed 
on the task bar. This message indicates that the Versana Active 
needs to be restarted once the service activity is complete. The 
message remains until the Versana Active is restarted. This 
prevents patient scanning while the Versana Active is not 
operating at an optimal status. For example, running a 
diagnostic may leave the Versana Active in a state that is not 
good for imaging.

Specifically, Disruptive mode is required to run diagnostics, 
clean presets, and reset the patient database, and turn on 
Virtual Console Observation (VCO).

• When Disruptive mode is On, all service functionality on the 
Service desktop is allowed but user operation of the 
Versana Active may be limited.

• When Disruptive mode is Off, some service functionality on 
the Service desktop is not available and user operation of 
the Versana Active is normal.

Additionally, the ability to enable Disruptive mode depends on 
the logged in user.

• Local user - a user locally logged into the machine will be 
able to set the Versana Active to Disruptive mode or allow a 
Disruptive mode request from a remote user through the 
Service desktop. The local user must have Authorize 
Remote Service Access to allow Disruptive mode. If the 
local user does not have this right, the remote user’s 
request will be automatically denied

• Remote user - a user remotely accessing the Versana 
Active will not be able to automatically switch Disruptive 
mode to On. The logged in user (user actually logged on to 
the Versana Active) needs to have the ability to grant 
remote access. The logged in user will be notified through a 
dialog box and asked to allow Disruptive mode.

NOTE: Change Password and Disk Defragment are not available 
for the remote user whether Disruptive mode is On or Off.

For more information, see:7-5-2 ‘Disruptive mode’ on page 7-15
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7-5-3 Color statuses
Throughout the Service desktop, colors indicate the following:

• Green - Status is normal
• Orange - Status is a warning
• Red - Status is an error

7-5-4 Licenses
With Service Basic Access (Class A), these are the available 
options:

• HOME
• Utilities

• Change Password
• Data Transfer
• Delete Files
• Gather Logs
• Network Capture
• SSA License
• Thirty Party Licenses

• Options
• Agent Configuration

With Service Advanced (Class C), these are the available 
options:

NOTE: With a Class C license, options display according to these 
purchased level of access.

• HOME
• Diags

• Run Diags
• Diag History

• Utilities
• Change Password
• Checkpoints
• Delete Files
• Disk Defragment
• Data Transfer
• Gather Logs
• Network Capture
• SSA License
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7-5-4 Licenses(continued)

• System Shutdown
• Thirty Party Licenses

• Options
• Agent Configuration

With Service Advanced plus Service Expert (Class C), the Clean 
Userdefs, Reset Patient Database,and Software Reload utilities 
are added to the Service Advanced options listed.

With Service Advanced and Service Expert plus Service PRO 
(Class C), the probe assessment tool (ePAT) diagnostic is 
added to the Service Advanced and Service Expert options 
listed.

With GE Service access (Class M) and an SSA key, these are 
the available options:

• HOME
• Diags

• Run Diags
• Diag History

• Utilities
• Change Password (not available through a remote 

connection)
• Checkpoints
• Clean Userdefs
• Data Transfer
• Delete Files
• Disk Defragment (not available through a remote 

connection)
• Disruptive Mode Utility
• Gather Logs
• Network Capture
• Reset Patient Database
• Software Reload
• SSA License
• SSH
• Thirty Party Licenses
• Virtual Console Observation

• Options
• Agent Configuration
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7-5-5 Home

Home configurations vary depending upon the purchased 
service level.

 Figure 7-15. Home with Class C and Class M Access

For more information, see:

• 7-5-5-1 ‘System Information’ on page 7-19
• 7-5-5-2 ‘Software Status’ on page 7-21
• 7-5-5-3 ‘System Status’ on page 7-22
• 7-5-5-11 ‘Disk Drive Space’ on page 7-32
• 7-5-5-12 ‘Network Configuration’ on page 7-34
• 7-5-5-13 ‘Connected Probes’ on page 7-36
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7-5-5-1 System Information

System Information displays general information about the 
Versana Active. When the Versana Active has been successfully 
configured with the back office, these elements will have the 
corresponding values:

• Agent Registered will be Yes
• Agent Quarantine will be No
• Agent CRM Verified will be Yes

The information on System Information is available to all 
service class licenses.

To access System Information, navigate to Utility > Service > 
Home.

 Figure 7-16. System Information

This table shows all the elements available on System 
Information with descriptions.
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7-5-5-1 System Information(continued)

For more information, see:7-5-5 ‘Home’ on page 7-18

Table 7-1:  System Information

Element DESCRIPTION

CRM Number Customer Relationship Management (CRM) number. 
System identifier assigned to the customer unit by 
the region service team.

Agent Registered Registered status of the agent. Valid values are:
• Yes - The agent is registered in the back office.
• No - The agent is not registered in the back office.
• Not Available - The agent is not running or has not 

been configured.

Agent Quarantine Quarantine status of the agent. Valid values are:
•  Yes - The agent has more than one device regis-

tered with the same CRM Number in the back 
office.

• No - The agent has one device registered with the 
listed CRM Number in the back office.

• Not Available - The agent is not running or has not 
been configured.

Agent CRM Verified CRM verified status of the agent. Valid values are:
•  Yes - The agent is verified in the back office.
• No - The agent is not verified in the back office.
• Not Available - The agent is not running or has not 

been configured.

Model Number GE part number for the Versana Active. The same 
number as listed on the rating plate.

Serial Number Serial number of the Versana Active. The same 
number as listed on the rating plate.

System Type Product name of the Versana Active.

Facility Name of the hospital or facility where the Versana 
Active is installed
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7-5-5-2 Software Status
Use Software Status to view general information about the 
software installed on the Versana Active.
The information on Software Status is available to all service 
class licenses.
To access Software Status, navigate to Utility > Service > 
Home.

Figure 7-17. Software Status
This table shows all the elements available on Software Status 
with descriptions.

For more information, see:
• 7-5-5 ‘Home’ on page 7-18

Table 7-2:  Software Status

Element DESCRIPTION

System Date Current date in the format <day>, <month> <date> <year>.

System Time Local time based on the last time the system desktop was 
refreshed in the format <hh:mm:ss>.

Application Built Date Date the application software was built. The application software 
includes the Versana Active product-specific software.

Base Image Built Date Date the base image software was built. The base image software 
includes the Windows operating system and other supporting 
software.

Base Image Version Version number of the base image software

Application Software Version Version number of the application software

Application Status Status of the application. Valid values are
• Running
• Stopped
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7-5-5-3 System Status

Use System Status to view status information on the Versana 
Active. Specifically, do the following:

• View the hardware configuration file
• View temperatures for FRUs, fans, and a graphical 

representation of the monitored temperatures
• View voltages for FRUs and AC
• View the amount of time the Versana Active has been 

running
• View the amount of time since the Versana Active has last 

been rebooted

The information on System Status is available to Class C and 
Class M licenses.

To access System Status, navigate to Utility > Service > Home.

Figure 7-18. System Status

This table shows all the elements available on System Status 
with descriptions.
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7-5-5-3 System Status(continued)

Table 7-3:  System Status

Element DESCRIPTION

Hardware Configuration Displays the contents of the hardware configuration 
file.

Temperature Displays the temperature monitoring of the Versana 
Active as normal, warning, or error using the 
standard colors and icons. Includes temperature 
out-of-spec events including an overall count of 
event warnings and errors for the last 30 days or the 
last status checkpoint whichever is sooner. 
Temperature displays temperature a graph for the 
configured monitoring points.

Voltage Displays the voltage monitoring of the Versana 
Active as normal, warning or error using the 
standard colors and icons. Includes voltage 
out-of-spec events including an overall count of the 
event warnings and errors for the last 30 days or last 
status checkpoint whichever is sooner.

System On Time Displays the time the Versana Active was turned on.

Time Since Last Reboot Displays the time the Versana Active was last 
rebooted.
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7-5-5-4 Hardware Configuration

Hardware Configuration displays the contents of the hardware 
configuration file which includes all the vital product data (VPD).

To access Hardware Configuration, navigate to Utility > 
Service > Home, and then under System Status, select 
Hardware Configuration.

 Figure 7-19. Hardware Configuration

This table shows all the elements available on Hardware 
Configuration with descriptions.

For more information, see:

• 7-5-5-3 ‘System Status’ on page 7-22
• 7-5-5 ‘Home’ on page 7-18

Table 7-4:  Hardware Configuration

Element DESCRIPTION

Component Hardware component.

Item Parameter with the vital product data (VPD).

Value Actual value of the Item.
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7-5-5-5 Temperature

Use Temperature to troubleshoot problems with monitored 
FRUs and the fans. Specifically, use these pages:

• FRU Status
• Graphs

To access Temperature, navigate to Utility > Service > Home, 
and then under System Status, select Temperature.

For more information, see:

• 7-5-5-6 ‘FRU Status’ on page 7-26
• 7-5-5-7 ‘Graphs’ on page 7-28
• 7-5-5-3 ‘System Status’ on page 7-22
• 7-5-5 ‘Home’ on page 7-18
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7-5-5-6 FRU Status
FRU Status displays a summary of the FRUs being monitored 
and the details for each FRU.
To access this page, under System Status, select Temperature 
and then select FRU Status.

 Figure 7-20. FRU Status
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7-5-5-6 FRU Status(continued)

This table shows all the elements available on FRU Status with 
descriptions.

For more information, see:

• 7-5-5-5 ‘Temperature’ on page 7-25
• 7-5-5 ‘Home’ on page 7-18

Table 7-5:  FRU Status

Element DESCRIPTION

FRU Status Summary Number of the FRUs being monitored.

FRU Status Details

Name • Name of the FRU.

Status Status of the FRU. Valid values are:
• Normal - Indicates that the FRU is operating within the allowable range.
• Warning - Indicates that the FRU is operating close to the limit of the allow-

able range.
• Error - Indicates that the FRU is operating outside the allowable range.

Lower Limit Warings Number of low limit temperature warnings.

Upper Limit Warnings Number of high limit temperature warnings.

Lower Limit Errors Number of low limit temperature errors.

Upper Limit Errors Number of high limit temperature errors.
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7-5-5-7 Graphs

Graphs displays trend graphs for selected elements which have 
been selected as key indicators of overall temperature status 
inside the card rack.

To access this page, under System Status, select Temperature 
and then select Graphs.

 Figure 7-21. Graphs

For more information, see:

• 7-5-5-5 ‘Temperature’ on page 7-25
• 7-5-5 ‘Home’ on page 7-18
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7-5-5-8 Voltage

Use Voltage to troubleshoot problems with monitored FRUs and 
the AC voltage of the Versana Active.

Specifically, use these pages:

• FRU Status
• AC Voltage

To access Voltage, navigate to Utility > Service > Home, and 
then under System Status, select Voltage.

For more information, see:

• 7-5-5-6 ‘FRU Status’ on page 7-26
• 7-5-5-10 ‘AC Voltage’ on page 7-31
• 7-5-5-3 ‘System Status’ on page 7-22
• 7-5-5 ‘Home’ on page 7-18
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7-5-5-9 FRU Status

FRU Status displays a summary of the voltages for the FRUs 
being monitored and the details for each FRU.

To access this page, under System Status, select Voltage and 
then select FRU Status.

 Figure 7-22. FRU Status

This table shows all the elements available on FRU Status with 
descriptions.

For more information, see:

• 7-5-5-8 ‘Voltage’ on page 7-29
• 7-5-5 ‘Home’ on page 7-18

Table 7-6:  FRU Status

Element DESCRIPTION

Name Name of the FRU.

Status Status of the voltage for the FRU. Valid values are:
• Normal - Indicates that the fan is  within the allowable range.
• Warning - Indicates that the voltage is close to the limit of the 

allowable range.
• Error - Indicates that the voltage is outside the allowable range.

Lower Limit Warnings Number of low limit voltage warnings.

Upper Limit Warnings Number of high limit voltage warnings

Lower Limit Errors Number of low limit voltage errors

Upper Limit Errors Number of high limit voltage errors
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7-5-5-10 AC Voltage

AC Voltage graphically displays the voltage input over a period 
of time to help identify instabilities,or fault conditions, over time.

To access this page, under System Status, select Voltage and 
then select AC Voltage.

 Figure 7-23. AC Voltage

For more information, see:

• 7-5-5-8 ‘Voltage’ on page 7-29
• 7-5-5 ‘Home’ on page 7-18
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7-5-5-11 Disk Drive Space

Use Disk Drive Space to view the hard drive partitions including 
total size and available free space in GB. Includes the overall 
health of the drive in one of these colors:

• Red - Available free space is less than 10% of the total size.
• Orange - Available free space is more than 10% and less 

than 20% of the total size.
• Green - Available free space is more than 20% of the total 

size.

The information on Disk Drive Space is available to Class C 
and Class M licenses.

To access Disk Drive Space, navigate to Utility > Service > 
Home.

Figure 7-24. Disk Drive Space

This table shows all the elements available on Disk Drive 
Space with descriptions.

Table 7-7:  Disk Drive Space

Element DESCRIPTION

C: Drive C: partition shows the graphical representation of the 
following:
• Used space in GB
• Available free space in GB
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For more information, see:

• 7-5-5 ‘Home’ on page 7-18

D: Drive D: partition shows the graphical representation of the 
following:
• Service
• Logs.
• Temp
• Export
• Service configuration
• Misc
• Available free space in GB

E: Drive E: partition shows the graphical representation of the 
following:
• Patient images
• Archive
• Printer spooler
• Clipboard
• Dicom spooler
• Misc
• Available free space in GB

F: Drive F: partition shows the graphical representation of the 
following:
• Serial Number
• Available free space in MB

Z: Drive Z: partition shows the graphical representation of the 
following:
• Package repository
• Misc
• Available free space in GB

Table 7-7:  Disk Drive Space
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7-5-5-12 Network Configuration

Use Network Configuration to view network (wired and 
wireless) information (the full ipconfig details)for the network 
configured with the Versana Active.

The information on Network Configuration is available to Class 
C and Class M licenses.

To access Network Configuration, navigate to Utility > 
Service > Home.

Figure 7-25. Network Configuration

Figure 7-26. Network Configuration with More Details
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7-5-5-12 Network Configuration(continued)

This table shows all the elements available on Network 
Configuration with descriptions.

For more information, see:

• 7-5-5 ‘Home’ on page 7-18

Table 7-8:  Network Configuration

Element DESCRIPTION

Host Name Name of the local host for the Versana Active.

More Details Displays the ipconfig details

Wired Connection

lpV4 Address Local IP address for the wired network connection.

lpV6 Address Local IP address for the wired network connection.

Subnet Mask Local subnet mask for the wired network.

Default Gateway Default gateway for the wired network.

MAC Address Address for the MAC for the wired network.

Speed (Mbps) Speed of the wireless connection.

Wireless Connection

IP Address IP address for the wireless network connection.

Subnet Mask Subnet mask for the wireless connection.

Default Gateway Default gateway for the wireless connection.

MAC Address Address for the MAC for the wireless connection.

Speed (Mbps) Speed of the wireless connection

Status Current status of the wireless connection.
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7-5-5-13 Connected Probes

Connected Probes shows probes connected to the Versana 
Active. The order on the user interface is top down matching the 
left-to-right order on the Versana Active.

The information on Connected Probes is available to all service 
class licenses.

To access Connected Probes, navigate to Utility > Service > 
Home.

Figure 7-27. Connected Probes

This table shows all the elements available on Connected 
Probes with descriptions.

For more information, see:7-5-5 ‘Home’ on page 7-18

Table 7-9:  Connected Probes

Element DESCRIPTION

Active Probe Temperature (Celsius) When available, temperature of the active probe.
Not all probes report temperature. The most common probe 
to report temperature is the TEE probe.

Probe Name Name of the probe connected to the Versana Active.

Probe ID Identifier of the probe connected to the Versana Active.

Status Statuses of the probe connected to the Versana Active. Valid 
values are:
• Active
• Non Active
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7-6 Network and Common

Diagnostics

7-6-1 Network Configuration

7-6-1-1 Wire-LAN Network

1. Connect system with network.
2. Enter Utility-> Connectivity-> TCP/IP, in IP settings 

window, check Enable DHCP, and select the proper 
network speed in Network Speed.

 Figure 7-28. Enable DHCP
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7-6-1 Network Configuration(continued)

NOTE: If user wants to setup static IP address, uncheck Enable 
DHCP option, input static address in IP-Address box, MAC 
Address, Subnet Mask and Default Gateway box. In 
Network Speed, choose the proper speed available.

Figure 7-29. Network Settings

3. Select Save, and a popup window displays. Select Restart 
Now to restart the system and activate the changes.

Figure 7-30. System Restart inquiry dialog
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7-6-1 Network Configuration(continued)

4. After the system restarts, the network icon on the right top of 
the screen shows that the network is available.

Figure 7-31. Network icon
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7-6-1-2 Wireless-LAN Network

NOTE: To configure the Wireless-LAN network, the operator must login 
as administrator.

1. Connect the wireless adapter in the USB port.
2. Enter Utility-> Connectivity-> TCP/IP, press 

Configuration.
3. Double click Wireless network. you chosen, or click the 

Connect at the left bottom of screen. 

 Figure 7-32. Wireless Network Conection
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7-6-1-1 Wire-LAN Network(continued)

4. Enter Internet Wireless Network Properties, select Security 
type and Encryption type. Then input Network security key 
and click OK.

Figure 7-33. Connection Status

5. The network icon at the left bottom of screen shows that the 
wireless network is available.

Figure 7-34. Wireless-LAN Connection
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7-6-2 Remote Access

Remote Access is a feature designed to enable OLE’s access to 
customer’s desktop remotely, service engineers don’t have to be 
on site to connect the physical dongle to exit to desktop, it’s 
doable remotely by using this feature.

1. In the server side, type the CRM No. of the system which 
the OLE would remotely connect to, and select Get Started.

NOTE: Remote FFA link:https://stg-ffa.am.health.ge.com/#/di/
home.

Figure 7-35. Input System ID
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7-6-2 Remote Access(continued)

2. Select Connect. Then the Connect page is displayed.

 Figure 7-36. Connect Page

3. Select HTTPS to Connect. Then the OLE is remotely 
connected to the system.

 Figure 7-37. Select HTTPS to Connect

NOTE: RDP is not available in Versana Active.
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7-6-2 Remote Access(continued)

4. Enter Otpions to add service option key.
NOTE: Please delete the added service option key when your 

service work is done.

 Figure 7-38. Add Service Option Key

5. Enter Utility-> Disruptive Mode Utility, select Enable.

Figure 7-39. Enable Disruptive Mode
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7-6-2 Remote Access(continued)

6. If we want to see the Scan screen or have control of the unit, 
we have to go to Virtual Console Observation and start it. 
Enter Utility-> Virtual Console Observation, select Start.

Figure 7-40. Start VCO

7. Select Desktop to Connect. Then the OLE is remotely 
connected to the system.

 Figure 7-41. Select Desktop to Connect

NOTE: You need to reboot the system before clinical scanning is 
resumed. 
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7-6-3 Service Diagnostics

7-6-3-1 MST board

• MST Swept Demodulator Test performs a signal path test of 
the swept demodulator FPGA on the MST.

• MST Front End Interface Test tests that the MST can access 
Front-End boards.

• MST Analog Test.
• MST Memory Access Test tests that MST can access to the 

internal, external, external cache memory spaces.
• Front End Interface FPGA Test reads the version of the GFE 

FPGA.
• MST Fixed Demodulator Test: MST Fixed Demodulator 

signal path test.
• DSP Master Clock Check checks  DSP Master Clock.
• MST Swept Demodulator Long Test.
• MST Temperature Test.
• MST Voltage.
• FPGA Internal Memory Test.

NOTE: The FPGA Internal Memory test may fail if it is performed 
with other tests at the same time. 

• FPGA Version.

7-6-3-2 CWI board

• HV STOP Test tests HV-STOP mechanism and checks each 
board is able to assert HV_STOP using its HV_STOP 
source.

• CWI Voltage.
• Other Voltage test point.
• Memory tests the memory on the mother board.
• Network Interface.
• Network Interface Reliability Test.
• CPU Temperature Test.
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7-6-3-3 Front End Path

• AFE IF Test checks digital path between AFE chips and 
FPGA.

• Complex Mixer Test checks the Mixer process chain of 
FPGA.

• CE Decoder Test checks the Code Excitation Decoder 
process chain of FPGA.

• Analog CW checks I-Q symmetry of pedof CW beamformer 
receiving signal.

• When AFE IF Test/Complex Mixer Test/CE Decoder Test 
fail, please try to replace MST. If it doesn’t work, please try 
other PWA. When aCW IQ Symmetry Test fail, please try to 
replace MST. If it doesn’t work, please try CWD or other 
PWA.

7-6-3-4 PC Test

• Hard Drive Test Long tests functionality of the hard drive.
• Hard Drive Test Short tests functionality of the hard drive.
• RTC clock: 
• AVI playback tests playing back an AVI file.

• Click “Play” to run the test. If the test is successful, you 
will see a brief video clipo with audio. For more 
information about the test, click “More Information”.

• Click “Pass” if the test successfully reproduces the 
video clip.

• Click “Fail” if the test is unable to successfully reproduce 
the video clip.

• Click “Cancel” button to quit the test without recording a 
test result.

• Keyboard 
• Press each key on the keyboard and it will be added to 

the History. Hold down a key to test the repeat of that 
key. To cancel, click Cancel or press Alt-X.

• Special purpose keys like volume control or Internet 
access keys may not be detected. To test the Fn key of 
a notebook computer, hold down the Fn key while 
pressing another key.

• Note: This diagnostic is intended to verify keyboard 
keys are in good working order. It is not intended to 
veriy that keyboards produce desired characters.
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7-6-3-4 PC Test(continued)

• Monitor Test Patterns
• This test is composed of various elements that verify a 

monitor functions correctly. To test a monitor feature, 
click the appropriate button. You can return to this dalog 
by clicking the mouse button or pressing any key.

• The Combination Test helps you verify your monitor is 
properly aligned, and set at the correct color depth and 
resolution. Use the crosshair pattern in each corner of 
the screen to visually determine if the monitor aligns 
correctly. If the crosshairs appear distored or out of 
focus, a problem may exist with the monitor alignment. 
Use the color spectrum array for visually verifying the 
monitor color depth capacity. If the colors in the color 
spectrum do no blend smoothly together, a problem 
may exist with the monitor color depth. Use the 
graduated horizontal and vertical alignment bars to 
determine the monitor resolution capabilities. The better 
you can discern individual lines as they move closer 
together, the higher the resolution capabilities of the 
monitor.

• The Solid Color Test helps point out malfunctioning or 
dysfunctional pixels using five basic colors: red, green, 
blue, black, and white. Fill the screen with an 
appropriate color by clicking the associated button. If a 
pixedl is malfunctioning, the pixel color will contrast with 
the color of all other pixels.

• The VESA Test Patterns allow you to test the monitor for 
proper luminance, geometry and focus. Click the 
appropriate button to fill the screen with the associated 
test pattern. You can return to this dalog by clicking the 
mouse button or pressing any key.
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7-6-3-4 PC Test(continued)

• Trackball
• The Mouse Status Test verifies the cursor position and 

mouse button state. When a mouse button is pressed, 
the corresponding button on the picture will change 
color. If the mouse is a wheel or scroll mouse, an arrow 
will indcate the direction the wheel is being rotated. 
Clicking the wheel will flash the picture of the mouse in 
the Mouse Status Test area.

• The Drag and Drop Test verifies a mouse can 
successfully perform drag and drop operations. Left 
click the picture of the CD and drag is onto the picture of 
the drive. If successful, the picture will change.

• The Double Click Test verifies a mouse can successfully 
perform double-click operations. Double-click on the 
picture of the monitor. If successful, the picture will 
change.

• Sound Test generates sounds for testing the speakers.
• USB Ports Test lists USB Devices.
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7-6-3-5 Battery

7-6-3-5-1 Battery Pack (Used in Versana Active console system)
Parameters for Battery Pack:

• Capacity:5.36Ah
• Rating:14.4V   77.18Wh
• Limited charging Voltage:16.4V

Battery Pack has a test function about the remaining fuel gauge. 
User can press TEST button, and then Fuel Gauge LEDs shall 
display below pattern for 5 seconds, refer to Table 7-10 on 
page 7-50. 

NOTE: The test fuction won’t be activated until the battery has been 
used in the system.

Figure 7-42. Press TEST Button

NOTE: The graphic above is for illustration purpose only. 

Table 7-10:  Fuel gauge LED indication

SOC LED1 LED2 LED3 LED4

0-30% ON OFF OFF OFF

31-50% ON ON OFF OFF

51-75% ON ON ON OFF

76%-100% ON ON ON ON
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7-6-3-5-2 Internal Battery (Used in Big Battery Case for VSN A Adv Cart)
Parameters for Internal Battery:

• Capacity:5.4Ah
• Rating:18V   97.2Wh

Internal Battery has a test function about the remaining fuel 
gauge. User can press TEST button, and then Fuel Gauge 
LEDs shall display below pattern for 5 seconds, refer to 
Table 7-11 on page 7-51. 

NOTE: The test fuction won’t be activated until the internal battery has 
been used in the system.

Figure 7-43. Press TEST Button

NOTE: The graphic above is for illustration purpose only. 

Table 7-11:  Fuel gauge LED indication

SOC LED1 LED2 LED3 LED4

0-25% ON OFF OFF OFF

26-50% ON ON OFF OFF

51-75% ON ON ON OFF

76%-100% ON ON ON ON
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7-6-3-6 Assessment Utility

7-6-3-6-1e-PAT
e-PAT is a probe assessment tool that evaluates each probe 
element response scanning on the air. Probes have to be clean, 
any gel residue will provide incorrect data. This test is an 
assessment that is intended to be used comparatively during the 
life of the probe to evaluate possible probe deterioration over 
time.

NOTE: Probe diagnostics is available to Class C (Service Pro) license. 

1. Check that the probe to be tested is thoroughly clean and 
dry. Connect it to the probe port on the scanner, then hold 
the probe in the air ready for testing.

Figure 7-44. The probe port

NOTE: Prior to inserting the probe, ensure that the connector 
locking handle is positioned to the unlock state.

NOTE: Ensure the probe is locked to the system before you start 
the probe diagnostics.

CAUTION DO NOT allow the probe head to hang free. Impact to the 
probe head could result in irreparable damage.



Network and Common Diagnostics

Versana Active – Basic Service Manual 7-53
5840775-100 English Rev.10

7-6-3-6-1e-PAT(continued)
2. Insert the SSA key and press Insite ExC  > Service 

Desktop > Diags > Run Diags > Probe Assessment. 

3. Select Start.
The Probe Diagnostics commence. While the test proceeds, 
the name of the test currently in progress is displayed in the 
Selected Diagnostics field. As the testing sequence 
progresses, the progress bar in the Total Progress field will 
advance to reflect the test progress.

4. At any stage, press Stop or Reset button, if required.
5. When the probe diagnostics is completed, there will be 

Pass/Fail information listed in the Diognostic Results 
Summary field to indicate whether the probe diagnostic is 
completed successfully or not.

6. If you want to review all Reports to ensure the probe is fully 
functional and has no damaged elements, go to In the Insite 
ExC  > Service Desktop > Diags > Diags History to 
check the probe diagnostic results.
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7-6-3-6-1e-PAT(continued)
7. All the probe diagnostics you have run will be displayed in 

Runs field. Select one and press Get History button, the 
corresponding reports will be shown in the Diagnostic 
Results History field.

8. Press Details button if you want to see the detailed Reports 
of the selected diagnostic.

NOTE: The above detailed information is just for reference and not 
used to decide probe defect or not. 

CAUTION Reboot the system after the probe diagnostics.
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7-6-3-6-2 Supported probes

7-6-3-6-3 Restart the system after diagnostics
Always shutdown the system and reboot after a diagnostics 
session.

Table 7-12:  Supported probes

Item Probe Name HCAT

1. 4C-RS H4000SR

2. 8C-RS H40402LS

3. E8C-RS H40402LN

4. E8Cs-RS H48062AF

5. 9L-RS H40442LL

6. 3Sc-RS H45041DL

7. 6S-RS H45021RP

8. 12S-RS H44901AB

9. 12L-RS H40402LY

10. LK760-RS
Note: The 
probe is for 
veterinary use.

H44901AF

11. L8-18i-RS H40462LF

12. L6-12-RS H48062AC

13. RAB2-6-RS H48681WR
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7-7 Troubleshooting

7-7-1 Console Troubleshooting

7-7-1-1 Bootup Sequence Theory

Figure 7-45. Bootup Sequence
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7-7-1-2 System Doesn’t Boot (Hang-up)

Table 7-13:  Hang-up black screen diagnostic table

LED2 LED1 HDD LED

KBD On/
Off 

button 
LED

Checklist (only 
for reference) Note

Before 
pressing 
power 
On/Off 
button

Blink 
Slowly

Blink Slowly  OFF Normal status 

Not Blink Not Blink OFF 1. Check ACDC 
adaptor and 
related cable

2. Check battery
3. Check CWI PWA

1. No power supply 
to system.

2. CWI internal logic 
error.

After 
pressing 
power 
On/Off 
button, 
the 
system 
monitor 
still 
keeps 
black. 
(After at 
least 2 
minutes)

Blink 
Slowly

Blink Slowly Not Green 1. Check KBD 
board

2. Check KBD cable
3. Check CWI PWA

1. KBD board LED 
failure

2. KBD cable failure
3. CWI board boot 

up failure

Blink 
Quickly

Blink 
Quickly

1. Check CWI PWA
2. Check the 

monitor and 
related eDP 
cable

1. Remove eDP 
cable from CWI 
PWA. Then power 
on system and 
observe the LED1 
and LED2 status 
again.

Blink 
Slowly

Blink Slowly Green 1. Check MST PWA
2. Check CWI PWA

1. Remove MST 
board from CWI 
board. Then 
power on system 
and observe the 
LED1 and LED2 
status again.

Blink 
Slowly

OFF Blink when 
reading and 
writing data.

Green 1. Check CWI PWA 1. CPU PWM_EN 
signal failure.

2. Connect a normal 
external monitor to 
HDMI port.

Blink 
Slowly

ON Green 1. Check eDP cable 
and monitor 
connection

2. Check eDP cable
3. Check monitor

1. Connect a normal 
external monitor to 
HDMI port.
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Chapter 8

Replacement Procedures

This chapter describes how to remove and install, or 
replace, modules and subsystems in the Versana 
Active. It also includes instructions for installing and 
re-installing the software.
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8-1 Overview

8-1-1 Contents in this chapter

• 8-1 ‘Overview’ on page 8-2
• 8-2 ‘Warnings and important information’ on page 8-3
• 8-3 ‘Disassembly/Re-assembly’ on page 8-5
• 8-4 ‘Loading the software’ on page 8-9
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8-2 Warnings and important

information

8-2-1 Warnings

WARNING Energy Control and Power Lockout for Versana Active.

When servicing parts of the Ultrasound system where there is 
exposure to voltage greater than 30 volts:

1. Follow LOCK OUT/TAG OUT procedures. 
2. Turn off the breaker.
3. Unplug the Ultrasound system.
4. Maintain control of the Ultrasound system power plug.
5. Wait for at least 30 seconds for capacitors to discharge as 

there are no test points to verify isolation.   
6. Remove/disconnect the battery, if present. 

Ultrasound System components may be energized. 

WARNING Because of the limited access to cabinets and equipment in the 
field, placing people in awkward positions, GE has limited the 
lifting weight for one person in the field to 16 KG (35 LBS). 
Anything over 16 KG (35 LBS) requires 2 people.

WARNING DO NOT touch any boards with integrated circuits prior to 
taking the necessary ESD precautions.

Always connect yourself, via an arm-wrist strap, to the advised 
ESD connection point located on the rear of the Ultrasound 
system (near the power connector).

Follow general guidelines for handling of electrostatic sensitive 
equipment.
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8-2-1 Warnings(continued)

NOTE: Use an ESD compatible work space or the ESD-kit during parts 
replacement.

8-2-2 Returning/shipping probes and repair parts

Equipment being returned must be clean and free of blood and 
other infectious substances.

GE policy states that body fluids must be properly removed from 
any part or equipment prior to shipment. GE employees, as well 
as customers, are responsible for ensuring that parts/equipment 
have been properly decontaminated prior to shipment. Under no 
circumstance should a part or equipment with visible body fluids 
be taken or shipped from a clinic or site (for example, body coils 
or an ultrasound probe). The purpose of the regulation is to 
protect employees in the transportation industry, as well as the 
people who will receive or open this package.

NOTE: The US Department of Transportation (DOT) has ruled that 
“items that were saturated and/or dripping with human blood 
that are now caked with dried blood; or which were used or 
intended for use in patient care” are “regulated medical waste” 
for transportation purposes and must be transported as a 
hazardous material.

NOTE: Please remove the battery pack before system shipment to 
avoid any potential danger.  

WARNING The waste of electrical and electronic equipment must not be 
disposed as unsorted municipal waste and must be collected 
separately.

Please contact the manufacturer or other authorized disposal 
company to decommission your equipment.
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8-3 Disassembly/Re-assembly

8-3-1 Warning and Caution

WARNING For FRU (Field Replaceable Unit), only qualified service 
personnel should remove any covers or panels. Electrical 
hazards exists at several points inside. Become thoroughly 
familiar with all hazardous voltages and high current levels to 
avoid accidental contact.

CRU (Customer Replaceable Unit) can be replaced by 
customers, as these parts are not related to any electrical 
hazards, no tool is needed for the replacement.

WARNING Remove/disconnect the battery before disassembling or 
re-assembling the parts. 

CAUTION DO wear the ESD wrist strap when you work on circuits.
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8-3-2 Tools needed for servicing Versana Active

NOTE: Please use the correct Screwdrivers listed in Table 8-1.

Table 8-1:  Standard tools list for Versana Active

No
Part 

Name Part No. QTY Screw Description
Screwdriver 
Description

1 screw 2327785 5 D2 SCREW M2x4, NYLOK Common Phillips 
Screwdriver

2 screw 5801820 57 SCREW FH M2.5x5-NL_BLACK Common Phillips 
Screwdriver

3 screw 5138465 2 Screw FH M2.5x5-NL Common Phillips 
Screwdriver

4 screw 2327793 54 D2 SCREW SJ2836-87 M3x8 Common Phillips 
Screwdriver

5 screw 2327766 5 Screw M3x5 Common Phillips 
Screwdriver

6 screw 5478161 34 Taping SCREW M3x6 Common Phillips 
Screwdriver

7 screw 5138468 3 Screw BN5687 M3x10_NL Common Phillips 
Screwdriver

8 screw 5162727 6 D2 SCREW BN5687 M3x25 Common Phillips 
Screwdriver

9 screw 5237561 4 Screw GB T9074.4-1988 M4x12 Common Phillips 
Screwdriver

10 screw 5826240 4 Screw M3x10L_Zn Common Phillips 
Screwdriver

11 screw 5439265 36 Screw M4X10 Common Phillips 
Screwdriver

12 screw 5495588 2 M3X6 CSK SCREW Common Phillips 
Screwdriver

13 screw 5476387 4 M6x15 with washer #5 Inner Hexangular Set
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8-3-3 Overview of Versana Active

 Figure 8-1. System Overview

Montior Assy

Keyboard Assy

Bottom Assy
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8-3-3 Overview of Versana Active(continued)

1. Port for DC In (AC Adapter)
2. 2 general USB 2.0 ports
3. Network Port
4. HDMI port

5. 2 general USB 3.0 prots
6. 1 Probe Connector Port
7. Probe Connector Locking Level
8. Security Lock
9. 4D port (only for Versana Active R1.1.x)
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8-4 Loading the software

8-4-1 Purpose of this section

This section describes how to reinstall software on Versana 
Active.

8-4-2 Customer provided prerequisite

• Formatted and labelled media for Images storage.
• Formatted and labelled media for Patient Archive and 

Presets (User Defined Settings).
• Password for the user ADM. 

8-4-3 Data Management - moving all images

• Move the images to a remote server or to removable media.

For instructions, please see “Disk management” in the Basic 
User Manual/User Guide.

CAUTION An error, or a power loss may occur. 

Always backup the Patient Archive and the Presets (System 
Configurations) before loading the software! 

In order to complete a successful restore of the Patient 
Database, as needed after a hard disk replacement, or if all the 
content on the hard disk has been erased, the images must be 
moved away from Versana Active before doing backup of the 
Patient Database. 

Depending on the location set-up, either move the images to a 
remote server or to removable media like DVD or CD discs.
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8-4-4 Backing up the Patient Archive and System Configurations

• Backup the Patient Archive and System Configurations. 

8-4-5 Restoring up the Patient Archive and System Configurations

NOTE: It is not suggested to manually delete the files in 
D:\Scanner\target\resources\userdefs.

CAUTION An error, or a power loss may occur. 

Always backup the Patient Archive and the Presets (System 
Configurations) before loading the software! 

In order to complete a successful restore of the Patient 
Database, as needed after a hard disk replacement, or if all the 
content on the hard disk has been erased, the images must be 
moved away from Versana Active before doing backup of the 
Patient Database. 

Depending on the location set-up, either move the images to a 
remote server or to removable media like DVD or CD discs.

WARNING To avoid not being able to connect to Local Archive, 
connecivity.res and IPSave in 
“D:\Scanner\target\resources\userdefs” should not be deleted. 
If they are deleted, please rewirte the serial number.
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8-4-6 Recording important settings and parameters

8-4-6-1 Overview

Always keep a record of the settings for the Versana Active on 
paper. Verify if it is current before starting a software loading! If 
needed, record the settings.

8-4-7 Data Backup

NOTE: The screen graphics in this manual are only for illustrational 
purposes. Actual screen output may differ with different users' 
systems.

NOTE: For the upgrade option Load the complete disk or Load the 
bootable C: partition only, the information for Computer name 
and IP setting will be lost. Before upgrade, backup these 
information.

CAUTION An error, or a power loss may occur. 

It is considered to be best practice to always keep a record on 
paper of the settings for the Versana Active. Verify if it is current 
before you start to load software!

CAUTION An error, or a power loss may occur. 

Always backup the Patient Archive and the Presets (System 
Configurations) before loading the software! 
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8-4-7 Data Backup(continued)

1. Record the information for Computer name and IP setting in 
Utility -> Connectivity -> TCP/IP. Refer to Table 8-2 on 
page 8-12.
• If “Enable DHCP” is not selected, record all the 

information about IP setting. Refer to a) in Figure 8-2 on 
page 8-12.

• If “Enable DHCP” is selected, only record Computer 
name and Network Speed. Refer to b) in Figure 8-2 on 
page 8-12.

Figure 8-2. Record IP Setting

Table 8-2:  Record Table

Item Name Setting

Computer Name

IP-Address

Subnet Mask

Default Gateway

Network Speed
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8-4-7 Data Backup(continued)

2. Record the installed option keys in Utility -> Admin -> 
System Admin.

 Figure 8-3. Option Key

3. Insert the backup media. Go to Utility -> System -> 
Backup/Restore -> Media to select the media.

 Figure 8-4. Media Menu
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8-4-7 Data Backup(continued)

4. Go to Utility -> System -> Backup/Restore, select Patient 
Archive, User Defined Configuration and Service under 
Backup by placing a check mark in front of them. Then 
select Backup to backup the information.

 Figure 8-5. Backup Menu
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8-4-7 Data Backup(continued)

5. Select OK to backup the system information when the 
following pop-up warning windows display.

NOTE: After Patient Archive, User Defined Configuration and 
Service backup, remove all the external USB devices.

Figure 8-6. Backup Confirmation message

6. Go to Utility -> System -> General, record the Preset 
Region and the Language. Then select Regional Options.

 Figure 8-7. Preset region
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8-4-7 Data Backup(continued)

7. In Format tab, record the Format. In the Location tab, 
record the current location. And in the Administrative -> 
Change system locale..., record current system locale.

Figure 8-8. Region and Language
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8-4-7 Data Backup(continued)

8. Press Patient key on the control panel, and then select 
Data Transfer. Select the task as Export and specify the 
destination to backup the patient information and images.

Figure 8-9. Data Transfer

9. Select Select All, and then select Transfer to backup all the 
patient information and images. 

 Figure 8-10. Export Patient Information
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8-4-8 Loading the System Software

NOTE: Before loading the system software, please ensure that the 
power can be continuously supplied and there is no risk of 
power cut off during loading procedure.

NOTE: Before loading/reload the system software, please change 
system language to English, refer to Figure 3-65 on page 3-73. 
Otherwise, there will be garbage on the system after software 
reload/loading.

There is one method to load the system software:

• Load the system software with USB memory stick.

NOTE: Find the system software USB memory stick in the 
accessory box.

WARNING While the software install procedure is designed to 
preserve data, you should save any patient data, images, 
system setups and customer presets to CD, DVD, USB 
Flash Drive, or USB Hard Disk before doing a software 
upgrade.
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8-4-8-1 Loading the System Software with USB memory stick

This section describes how to upgrade the software.

1. Insert the Upgrade USB memory stick labeled “System & 
Application Software” to the USB port of the system.

2. Properly turn off the system by momentarily pressing the 
Power On/Off Switch. Then select Shutdown in the System 
Exit Window.

NOTE: If the system does not shutdown normally, hold down the 
Power On/Off Switch until the light turns off.

3. Power on the system and it will detect the USB memory 
stick automatically.

NOTE: A window will pop out. Do not close the window, or the 
upgrade process will be terminated.

4. Select the option Load the complete disk or Load the 
bootable C: partition only or Only Reload/Upgrade 
Application Software for software upgrade. Or select Exit 
to exit the upgrade process.

 Figure 8-11. Upgrade instruction
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8-4-8-1 Loading the System Software with USB memory stick(continued)

• Load the complete disk: the complete disk will be 
loaded. This option is recommended for application 
software upgrade.

NOTE: This option is used by service engineer only.

• Load the bootable C: partition only: this option is 
intended for recovery of a system that will not boot up. 
All patient data is preserved. 

NOTE: While the software installation procedure is designed to 
preserve data, select choice Load the bootable C: 
partition only to format disk C. 

• Only Reload/Upgrade Application Software: the 
application software will be loaded/upgraded only. This 
option is recommended for application software 
upgrade or reload. The software upgrade kit will 
automatically detect if the system compatible with this 
function and complete upgrading.

NOTE: If the current system base image does not support the 
application version of the upgrade USB disk, a message 
will be displayed on the screen and cancelled upgrading 
automatically.

WARNING If selecting Load the complete disk, all existing software and 
data will be erased. If backup has not been performed, all data 
like Patient Data, System Configuration and User 
Configurations (Customer Presets) will be lost. Please ensure 
that any patient data on the disk has been backed up before 
upgrading the system.
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8-4-8-1 Loading the System Software with USB memory stick(continued)

5. If Load the complete disk is selected, a confirmation 
window will pop out, then select Execute to continue.

NOTE: Before loading the complete disk, please ensure that any 
patient data on the disk has been backed up.

 Figure 8-12. Confirmation Window

6. System USB memory stick will be loading. Wait for the 
software installation to complete. Status bar on the screen 
indicates the progress (about 30 minutes).

WARNING

D

Do not interrupt the software loading at any time.
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8-4-8-1 Loading the System Software with USB memory stick(continued)

 Figure 8-13. Loading Process
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8-4-8-1 Loading the System Software with USB memory stick(continued)

7. The system will display upgrading result and shutdown 
automatically within 30 seconds. Or click the Shutdown in 
the screen to shut down the system immediately.

 Figure 8-14. System upgrade complete

If the upgrade fails, select Exit to exit the upgrade process, 
then remove the USB memory stick. Insert the USB memory 
stick again and repeat the upgrade process from step 2 on 
page 8-19.

 Figure 8-15. System upgrade fail
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8-4-8-1 Loading the System Software with USB memory stick(continued)

8. Remove USB memory stick. Then press Power On/Off 
switch to power on the system.

NOTE: Remove the USB memory stick before the system restarts. 
If you do not remove the USB memory stick, the software 
system upgrading process repeats when the system boots 
up.

NOTE: Ensure the USB memory stick is properly and securely 
connected. Once the USB memory stick is accidentally 
disconnected from the system during the upgrading 
process, the error message will pop up: “The volume for a 
file has been externally altered so that the opened file is no 
longer vaild.” Insert the USB memory stick again and restart 
the system to run the upgrading process from step 3 on 
page 8-19.

8-4-8-2 Rewrite the Serial Number

If selected to load the complete disk during the software loading 
process, when powering the system, the system will indicate to 
rewrite the serial number.



Loading the software

Versana Active – Basic Service Manual 8-25
5840775-100 English Rev.10

8-4-8-3 Set Password

After the serial number is reset, the system will shutdown 
automatically. Power on the system and complete the password 
setting for use. For more information, please refer to 3-9-1 ‘EZ 
configuration Wizard’ on page 3-64.

NOTE: For R1.1.x, selecting password policy level, ADM password 
setting, Disk Encryption setting, System Password setting is 
required when turning on the system for the first time or after the 
software installation.

NOTE: Software upgrade will cause password reset, see Table 8-3 for 
more information.

NOTE: Please save the system password properly. User is required to 
provide the system password to back office for remote 
connection.

Table 8-3:  Password Reset Policy

System Upgrade
Disk Encryption 

password
System 

password
ADM User 
password

Database 
password

Whole disks Yes Yes Yes Yes

Only C disk No Yes No No

Reload Apps No No No No
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8-4-8-4 Secure Wipe

Secure wipe is intended to erase all the patient data with the 
software on the system before the system will be shipped for 
service. 

NOTE: This tool is not BAM approved.

NOTE: Before starting this procedure, remove all probes and 
peripherals and remove them from the system.

NOTE: While it is believed to be unnecessary, it would not hurt to 
disconnect the system from the network and remove all 
transducer.

NOTE: Please ensure AC adapter is connected during system upgrade!

1. Insert the USB memory stick labeled “System & Application 
Software” to the system.

2. Properly turn off the scanner by momentarily pressing the 
Power On/Off Switch. In System-Exit window, select 
Shutdown to shutdown the system.

NOTE: If the system will not shutdown normally, hold down the 
Power On/Off Switch until the light turns off.

3. Power on the system. The system will detect the USB 
memory stick automatically.
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8-4-8-4 Secure Wipe(continued)

4. Select Secure Wipe. Or select Exit to exit the process.

 Figure 8-16. Upgrade screen

5. The system indicates all data will be erased, select Execute 
to continue.

Figure 8-17. Confirm Dialog

NOTE: All the patient data cannot be recovered after wipe process.
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8-4-8-4 Secure Wipe(continued)

6. The process may take twenty minutes or more.

 Figure 8-18. Wiping Process

7. The system will shutdown automatically when the wiping 
progress completes.

NOTE: As the SSD is empty after secure wipe, the system cannot 
boot up. The software should be loaded first after the wipe 
process.
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8-4-8-5 Software Version check out

8-4-8-5-1 Functional Check-out
1. Power on Versana Active system and wait until system 

booting to scanning screen.
NOTE: If selected to load C Disk only when loading the system 

software, the system will display a screen to restore 
Computer name before entering the scanning screen. 

2. Press Utility on the control panel.
3. Select the System -> About and check whether the 

software version is right.

 Figure 8-19. Software version
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8-4-8-6 Option Strings Check

NOTE: After the system software loading completion, please check the 
option strings to ensure that the options are activated and 
working.

1. Reboot the system.
2. Press Utility -> Admin, the following dialog is displayed. 

Select Acknowledge to continue.

Figure 8-20. Notification Window

3. Login to the Versana Active for the first time. Refer to 
4-2-5 ‘Logging on to Versana Active as “ADM”’ on 
page 4-11.
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8-4-8-6 Option Strings Check(continued)

4. Enter Utility -> Admin-> System Admin, ensure that all the 
installed option keys are displayed and the status of Options 
are valid.

• The status “Permanent” means the option keys are 
activated and working.

 Figure 8-21. Software Option
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8-4-8-7 Reload the Correct Preset Region

NOTE: After the software upgrade process, the system language and 
region preset will be set as the default. Change the settings if 
needed.

NOTE: Refer to step 6 on 8-15 and step 7 on 8-16 for the system 
Region Preset and Language settings.

1. When the system is powered on, go to Utility -> System -> 
General. Select Regional Options.

Figure 8-22. Preset Region

2. Under Formats select the desired language. 

Figure 8-23. Formats selection
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8-4-8-7 Reload the Correct Preset Region(continued)

3. Under Location, select the desired location.

Figure 8-24. Location selection

4. Under Administrative, select Change system locale.... 

Figure 8-25. Location selection
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8-4-8-7 Reload the Correct Preset Region(continued)

5. Select Apply when below message displays.

Figure 8-26. Change Regional Options

6. Select the language under Current system locale, then 
select OK.

Figure 8-27. Set Language
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8-4-8-7 Reload the Correct Preset Region(continued)

7. Select Cancel not to restart the system. 

Figure 8-28. Restart request

8. Select Close to close the window.

Figure 8-29. Installed service



Replacement Procedures

8-36 Versana Active – Basic Service Manual
5840775-100 English Rev.10

8-4-8-7 Reload the Correct Preset Region(continued)

9. Select Cancel to return to system setting. 

Figure 8-30. Installed service

10. In Utility -> System -> General, select the language as 
desired, and then select Save. 

Figure 8-31. Language

NOTE: Keep Input Language the same as system language, 
otherwise corrupted characters will incur.
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8-4-8-7 Reload the Correct Preset Region(continued)

11. Select Restart now to restart the system.

Figure 8-32. Question Window

12. When the system boots up, the system appears in the 
selected language.

NOTE: To have the settings take effect, you MUST restart the 
system.

NOTE: Press Alt+Shift to change the input language.
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8-4-8-8 Configuration Restore

1. When the system is powered on, go to Utility -> 
Connectivity -> TCP/IP. 
• If the original selection is that the "Enable DHCP" is 

selected, the selection is restored by default and the 
system will automatically get the IP address.

 Figure 8-33. Enable DHCP

• If the original selection is that the "Enable DHCP" is not 
selected, please uncheck “Enable DHCP”. Input the 
information about IP setting which have been recorded. 

 Figure 8-34. Disable DHCP
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8-4-8-8 Configuration Restore(continued)

2. Select Save, then the following pop-up window will display. 
Select Restart later.

Figure 8-35. Question Window

3. If Load the complete disk is selected for software upgrade, 
the user is required to restore the Patient Archive and 
System Configurations. 
Insert the media which is used to back-up.

4. Select System, then select Backup/Restore.
5. In the Media field, select the media. Refer to Figure 8-4 on 

page 8-13.
6. Restore user defined configuration. There are 2 options.

• If the user would restore all user defined configuration, 
in the Restore field, select User Defined 
Configuration.Then select Restore button in the 
Restore field. 

NOTE: If the user requires to restore all the User Defined 
Configuration, there is no need to select all the items of 
the Detailed Restore of User Defined to restore.

 Figure 8-36. Restore all user defined configuration
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8-4-8-8 Configuration Restore(continued)

Then the following pop-up Warning message will 
display, then select OK to continue.

Figure 8-37. Question Message

• If the user would not restore all user defined 
configuration, in the Detailed Restore of User Defined 
field , select the items the user would like to 
restore.Then select Restore button in the Detailed 
Restore of User Defined field. 

NOTE: According to the requirements from the User, restore 
the items in Detailed Restore of User Defined.

 Figure 8-38. Detailed Restore of User Defined
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8-4-8-8 Configuration Restore(continued)

During the restore process, the following pop-up 
message will display. Press OK to continue. Refer to 
Figure 8-39 on page 8-41  as an example.

NOTE: How many warning message windows show up 
depends on how many items of Detailed Restore of 
User Defined are selected to restore.

Figure 8-39. Restore Warning Message

7. After restoring the User Defined Configuration, the System 
will restart.
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8-4-8-8 Configuration Restore(continued)

8. After the system is powered on, go to Utility -> System -> 
Backup/Restore. Select Patient Archive, User Defined 
Configuration and Service under Restore field.

NOTE: If the user selects Patient Archive, the patient data will be 
restored but the exam images might be damaged thus 
unable to read.

NOTE: If the user already restores the detailed User Defined 
Configuration in step 6 on 8-39, DO NOT select User 
Defined Configuration in this step.

 Figure 8-40. Restore Menu

9. Select Restore. Then the following pop-up Warning 
message will display, then select OK to continue. 

Figure 8-41. Warning Message
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8-4-8-8 Configuration Restore(continued)

10. Then the following pop-up Warning message will display, 
then select OK to continue.

Figure 8-42. Question Message

11. During the restoring process, the following pop-up message 
will display. Press Ok to continue. 

Figure 8-43. Warning Message

NOTE: If User Defined Configuration is not selected to restore in 
step 8 on 8-42, the warning message (b) in Figure 8-43 on 
page 8-43 will not display.
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8-4-8-8 Configuration Restore(continued)

12. Press Patient key on the control panel, and then select 
Data Transfer. Select the task as Import and select the 
source as where the patient information is exported to.

 Figure 8-44. Data Import

13. Select Select All, and then select Transfer to restore all the 
patient information and images.

 Figure 8-45. Data Transfer
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8-4-8-8 Configuration Restore(continued)

14. Then the following pop-up question message will display, 
select YesToAll to continue. 

Figure 8-46. Overwrite Question Message

15. The following pop-up warning will display, select Ok to 
continue. 

Figure 8-47. Overwrite Warning
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8-4-8-8 Configuration Restore(continued)

16. The overwrite process is completed. 

 Figure 8-48. Overwrite Process
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8-4-8-9 Probe Recognition Check

NOTE: After the system software loading completion, please check to 
ensure that the system can recognize the probes.

Plug in the probe. In scanning mode, the probe information is 
displayed on the right top location of the screen. About the 
probe specification for intended use on Versana Active.

Plug in at least one of each type of the probes and check if each 
of the probes is recognized and the probe information is 
displayed correctly.

 Figure 8-49. Probe identification
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8-4-8-10 Peripheral Device Check

Check to ensure that all the peripheral devices work properly.

For instruction of peripheral device check, See 
4-4-19 ‘Peripheral checks’ on page 4-70 for more information.

8-4-8-11 Reinstall DICOM Devices

Reinstall any DICOM devices used by the customers and check 
to ensure these DICOM devices work properly.

The instruction about installing DICOM devices is not 
incorporated in this manual. To access the instruction about 
installing DICOM devices please refer to another manual Basic 
User Manual. Please use the latest revision of this document.
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Chapter 9

Renewal Parts

This chapter lists the renewal parts available for the 
Versana Active.
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9-1 Overview

9-1-1 Contents in this chapter 

• Overview
• List of Abbreviations
• Renewal Parts Lists
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9-2 List of Abbreviations

Table 9-1:  List of Abbreviations

ABBREVIATION DESCRIPTION

3D THREE DIMENSIONAL

Assy ASSEMBLY

FRU Field Replaceable Unit

CRU Customer Replaceable Unit

KBD Keyboard Assy

LCD Liquid Crystal Display

BnV Brightness and Volume

MST Master Board

CWI CPU / WDC / IO Board. WDC is DC Power Board for 
Wukong Platform.



Renewal Parts

9-4 Versana Active – Basic Service Manual
5840775-100 English Rev.10

9-3 Renewal Parts Lists

9-3-1 Operator Console Assy

 Figure 9-1. Operator Console Assy
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9-3-2 Cart

Figure 9-2. Versana Active Base Cart

Figure 9-3. Versana Active Advanced Fixed Cart
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9-3-2 Cart(continued)

Figure 9-4. Versana Active Advanced Height-Adj Cart

9-3-3 Renewal Parts List

Table 9-2:  Renewal Parts list

Section Page Number

Probe 9-7

Peripheral 9-8

Power Cord 9-10

Manuals 9-11
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9-3-4 Probe 

Table 9-3:  Probes for Versana Active

Item Part Name
Part 

Number

Commercial 
Part 

Number

Center Image 
Frequency 

(MHz)
Replaced 

By

1. 4C-RS 5488477 H4000SR 3.1 ± 10%

2. 8C-RS 5499508 H40402LS 6.5 ± 20%

3. E8C-RS 5499516 H40402LN 6.5 ± 20%

4. E8Cs-RS 5670375 H48062AF 6.5 ± 20%

5. 9L-RS 5499511 H40442LL 5.3 ± 20%

6. 3Sc-RS 5433833 H45041DL 2.75 ± 10%

7. 6S-RS 5499316 H45021RP 4.5 ± 10%

8. 12S-RS 5499321 H44901AB 7.75 ± 10%

9. 12L-RS 5499501 H40402LY 7.5 ± 20%

10. LK760-RS
Note: The probe is for 
veterinary use.

5548914 H44901AF 7.15 ± 10%

11. L8-18i-RS 5499609 H40462LF 9.5 ± 20%

12. L6-12-RS 5454332 H48062AC 7.75 ± 20%

13. RAB2-6-RS
Note: The probe is only 
used for Versana Active 
R1.1.x.

KTZ303982 H48681WR 3.3 ± 10%
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9-3-5 Peripheral

Table 9-4:  Peripherals for Versana Active

Item
Part 

Number
Commercial 
Part Number Description

Footswitch

1. 5151236 H41882LD Footswitch FSU-1000

2. 5338419 H41642LS Footswitch MKF 2-MED USB GP26

USB Stick

3. 5831001 H48442BK 32G USB MEMORY STICK

4. 5863937 NA USB3.0 stick for Storage(NEW FW) 

Printer

5. 5133106-2 H48542LY Sony UPD25 Color Printer Chinese kit

6. 5133107-2 H48542LZ Sony UPD25 Color Printer USA kit

7. 5133108-2 H48552LA Sony UPD25 Color Printer European kit

8. 5133109-2 H48552LB Sony UPD25 Color Printer Japanese kit

9. 5491253 H48312AN Sony UPD25 Color Printer Brazil kit

10. 5151259-2 H48492AF UP-D898MD B/W Printer USA kit

11. 5151261-2 H48492AG UP-D898MD B/W Printer Europe kit

12. 5151262-2 H48492AH UP-D898MD B/W Printer China kit

13. 5151263-2 H48492AJ UP-D898MD B/W Printer Japan kit

14. 5495509-2 H48492AK UP-D898MD B/W Printer Brazil kit

15. 5778615 H48052BG SONY UP-D898DC printer

16. NA NA HP Officejet Pro 200

  ECG

17. NA H48502AR USB ECG Module (IEC)-MFG Germany 

18. NA H41852LK USB ECG Module (AHA)-MFG Israel

19. NA H41852LL USB ECG Module (IEC)-MFG Israel

20. 5129487 H48492AY ECG module from Norav Isral, not applies to Muslim country 
and China

21. 5149641 H41852LM ECG Assy with Chinese label 

22. 5146056 H48502AA ECG detachable cable AHA Type USA

23. 5146739 H48502AB ECG detachable cable IEC type EURO and ASIA
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9-3-6 System and Application Software Update USB

For the latest revision of system and application software update 
USB, please contact your service partner for detail information.

24. 5146055 NA USB cable for ECG

  Others

25. 5434317-4 H48492AB 1TB mobile HDD-CRU

26. 5449275-4 H48442BG Transcend TS8XDVDS-K DVDRW kit

27. 5774524-S H48122BT Bluetooth Adaptor
Note: The HCAT and service part for Bluetooth Adaptor is 
not orderable now.

28. 5728576 H48832AC NetGear Wireless USB Adapter A6210 Kit-CRU

29. 5933000-S H48962CG NetGear Wireless USB Adapter A8000 for Service

Note: Only for software version R1.2.4 and above for New 
MST version
Note: Only for software version R1.1.11 and above for Old 
MST version

30. 5792464-S H48242BC Isolation USB kit-CRU

31. 5840530-S H48722BF Spare Battery Charger for Versana Active-CRU

32. 5840613-S H48722BE Video Output Adapter for Versana Active-CRU

33. 5835777-S NA HDMI for vedio adapter for Versana active

34. NA E8390AA Digital Expert Hardware Kit (includes Microsoft Surface 
Tablet)

35. NA E8390AC Digital Expert Cables and Video Grabber

36. NA HG11VCL Digital Expert Connect – License Term

Table 9-4:  Peripherals for Versana Active

Item
Part 

Number
Commercial 
Part Number Description
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9-3-7 Power Cord

NOTE: Cable clip for Table 9-5 power cord should be installed in the 
hole 1, refer to Figure 9-5.

Figure 9-5. Cable clip installation

Table 9-5:  Power Cord for Versana Active

Item
Part 

Number
Commercial 
Part Number Description

1000 5177123-2 H48482AF Europe Class AC powercord-CRU

1001 5176304-2 H48482AK China Class AC powercord-CRU

1002 5176773-2 H48482AH India class AC powercord-CRU 

1003 5177195-2 H48482AC Argentina Class AC powercord-CRU 

1004 5176907-2 H48482AG UK class AC powercord-CRU   

1005 6736102-2 H48512AD PWR SPLY CRD ANZ 10A 250V STRAIGHT 2.5M

1006 5177154-2 H48482AD Switzerland AC powercord-CRU

1007 5177187-3 H48482AE AC Power Cord Australia and New Zealand Class-CRU

1008 5177146-2 H48482AL USA class AC powercord-CRU

1009 5400868-2 H48482AN Brazil Class AC powercord-CRU

1010 5176753-2 H48482AJ Israel class AC powercord-CRU 

1011 5177126-2 H48482AB Japan class AC powercord for Cart-CRU 
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9-3-8 Manuals

Table 9-6:  Manuals for Versana Active

Item
Part 

Number
Commercial 
Part Number Description

1100 5840715-200 H48732BF Versana Active R1.5 Manual DVD

1101 5840769-100 H48732BJ Versana Active R1.5 Advanced Reference Manual English 
version

1102 5840775-100 H48732BG Versana Active R1.5 Basic Service Manual

1103 5840764-100 H48732BH Versana Active R1.5 Basic User Manual English version

1104 5840761-100 H48732BL Versana Active R1.5 User Guide English version

1105 5840761-101 H48732BM Versana Active R1.5 User Guide French version

1106 5840761-106 H48732BN Versana Active R1.5 User Guide Spanish version

1107 5840761-108 H48732BP Versana Active R1.5 User Guide German version

1108 5840761-111 H48732BR Versana Active R1.5 User Guide Italian version

1109 5840761-121 H48732BS Versana Active R1.5 User Guide Dutch version

1110 5840761-127 H48732BT Versana Active R1.5 User Guide Brazilian Portuguese 
version

1111 5840761-129 H48732BW Versana Active R1.5 User Guide Estonian version

1112 5840761-131 H48742BT Versana Active R1.5 User Guide Slovenian version

1113 5840761-140 H48732BY Versana Active R1.5 User Guide Japanese version

1114 5840761-141 H48732BK Versana Active R1.5 User Guide Simplified Chinese version

1115 5840761-142 H48732BZ Versana Active R1.5 User Guide Swedish version

1116 5840761-144 H48742BA Versana Active R1.5 User Guide Korean version

1117 5840761-145 H48742BB Versana Active R1.5 User Guide Russian version

1118 5840761-150 H48742BC Versana Active R1.5 User Guide Polish version

1119 5840761-151 H48742BD Versana Active R1.5 User Guide Greek version

1120 5840761-153 H48742BY Versana Active R1.5 User Guide Hungarian version

1121 5840761-154 H48742BE Versana Active R1.5 User Guide Slovakian version

1122 5840761-155 H48742BF Versana Active R1.5 User Guide Czech version

1123 5840761-159 H48742BG Versana Active R1.5 User Guide Turkish version

1124 5840761-160 H48742BH Versana Active R1.5 User Guide Danish version

1125 5840761-161 H48742BZ Versana Active R1.5 User Guide Norwegian version

1126 5840761-162 H48742BJ Versana Active R1.5 User Guide Finnish version
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1127 5840761-165 H48742BK Versana Active R1.5 User Guide Bulgarian version

1128 5840761-167 H48742BL Versana Active R1.5 User Guide Romanian version

1129 5840761-168 H48752BA Versana Active R1.5 User Guide Croatian version

1130 5840761-174 H48742BM Versana Active R1.5 User Guide Lithuanian version

1131 5840761-175 H48742BN Versana Active R1.5 User Guide Latvian version

1132 5840761-176 H48742BP Versana Active R1.5 User Guide Serbian version

1133 5840761-177 H48742BR Versana Active R1.5 User Guide European Portuguese 
version

1134 5840761-180 H48752BB Versana Active R1.5 User Guide Ukrainian version

1135 5840761-181 H48742BS Versana Active R1.5 User Guide Indonesian version

1136 5840761-183 H48752BC Versana Active R1.5 User Guide Vietnamese version

1137 5840761-184 H48742BW Versana Active R1.5 User Guide Kazakh version

1138 5808652-100 H48412BA Versana Active Release Notes English version

1139 5808652-101 H48422BB Versana Active Release Notes French version

1140 5808652-106 H48422BC Versana Active Release Notes Spanish version

1141 5808652-108 H48422BD Versana Active Release Notes German version

1142 5808652-111 H48422BE Versana Active Release Notes Italian version

1143 5808652-121 H48422BF Versana Active Release Notes Dutch version

1144 5808652-127 H48422BG Versana Active Release Notes Brazilian Portuguese version

1145 5808652-129 H48422BH Versana Active Release Notes Estonian version

1146 5808652-131 H48432BR Versana Active Release Notes Slovenian version

1147 5808652-140 H48422BJ Versana Active Release Notes Japanese version

1148 5808652-141 H48412BZ Versana Active Release Notes Simplified Chinese version

1149 5808652-142 H48422BK Versana Active Release Notes Swedish version

1150 5808652-144 H48422BL Versana Active Release Notes Korean version

1151 5808652-145 H48422BM Versana Active Release Notes Russian version

1152 5808652-150 H48422BN Versana Active Release Notes Polish version

1153 5808652-151 H48422BP Versana Active Release Notes Greek version

1154 5808652-153 H48432BJ Versana Active Release Notes Hungarian version

1155 5808652-154 H48422BR Versana Active Release Notes Slovakian version

Table 9-6:  Manuals for Versana Active

Item
Part 

Number
Commercial 
Part Number Description
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1156 5808652-155 H48422BS Versana Active Release Notes Czech version

1157 5808652-159 H48422BT Versana Active Release Notes Turkish version

1158 5808652-160 H48422BW Versana Active Release Notes Danish version

1159 5808652-161 H48432BK Versana Active Release Notes Norwegian version

1160 5808652-162 H48422BY Versana Active Release Notes Finnish version

1161 5808652-165 H48422BZ Versana Active Release Notes Bulgarian version

1162 5808652-167 H48432BA Versana Active Release Notes Romanian version

1163 5808652-168 H48432BL Versana Active Release Notes Croatian version

1164 5808652-174 H48432BB Versana Active Release Notes Lithuanian version

1165 5808652-175 H48432BC Versana Active Release Notes Latvian version

1166 5808652-176 H48432BD Versana Active Release Notes Serbian version

1167 5808652-177 H48432BE Versana Active Release Notes European Portuguese version

1168 5808652-180 H48432BM Versana Active Release Notes Ukrainian version

1169 5808652-181 H48432BF Versana Active Release Notes Indonesian version

1170 5808652-183 H48432BN Versana Active Release Notes Vietnamese version

1171 5808652-184 H48432BH Versana Active Release Notes Kazakh version

1172 5840769-101 H48752BF Versana Active R1.5 Advanced Reference Manual French 
version

Table 9-6:  Manuals for Versana Active

Item
Part 

Number
Commercial 
Part Number Description
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Chapter 10

Care and Maintenance

This chapter describes Care and Maintenance on the 
Ultrasound system and peripherals. These procedures 
are intended to maintain the quality of the Ultrasound 
system’s performance. Read this chapter completely 
and familiarize yourself with the procedures before 
performing a task.
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10-1 Overview

10-1-1 Contents in this chapter

• 10-1 ‘Overview’ on page 10-2
• 10-2 ‘Warnings’ on page 10-3
• 10-3 ‘Why do maintenance’ on page 10-4
• 10-4 ‘Maintenance task schedule’ on page 10-6
• 10-5 ‘Tools required’ on page 10-8
• 10-6 ‘System maintenance’ on page 10-12
• 10-7 ‘Electrical safety tests’ on page 10-21
• 10-8 ‘When there's too much leakage current …’ on 

page 10-32
• 10-9 ‘Inspection Paperwork’ on page 10-34
• 10-10 ‘Electrical Safety Tests Log’ on page 10-36
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10-2 Warnings

DANGER
 

BE SURE TO DISCONNECT THE ULTRASOUND SYSTEM 
POWER PLUG AND OPEN THE MAIN CIRCUIT BREAKER 
BEFORE YOU REMOVE ANY PARTS. BE CAUTIOUS 
WHENEVER POWER IS STILL ON AND COVERS ARE 
REMOVED.

CAUTION Practice good ESD prevention. Wear an anti–static strap when 
handling electronic parts and even when disconnecting/
connecting cables.

CAUTION Do not pull out or insert circuit boards while power is on.

CAUTION Do not operate this Ultrasound system unless all board covers 
and frame panels are securely in place. System performance 
and cooling require this.
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10-3 Why do maintenance

10-3-1 Periodic maintenance inspections

It has been determined by engineering that your Versana Active 
does not have any high wear components that fail with use, 
therefore no Periodic Maintenance inspections are mandatory. 

However, some customers’ Quality Assurance Programs may 
require additional tasks and or inspections at a different 
frequency than listed in this manual.

10-3-2 Keeping records

It is good business practice that ultrasound facilities maintain 
records of periodic and corrective maintenance. The Ultrasound 
Periodic Maintenance Inspection Certificate provides the 
customer with documentation that the Ultrasound system is 
maintained on a periodic basis.

A copy of the Ultrasound Periodic Maintenance Inspection 
Certificate should be kept in the same room or near the 
Ultrasound system.
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10-3-3 Quality assurance

In order to gain accreditation from organizations such as the 
American College of Radiology (USA), it is the customer’s 
responsibility to have a quality assurance program in place for 
each Ultrasound system. The program must be directed by a 
medical physicists, the supervising radiologist/physician or 
appropriate designee.

Routine quality control testing must occur regularly. The same 
tests are performed during each period so that changes can be 
monitored over time and effective corrective action can be 
taken.

Testing results, corrective action and the effects of corrective 
action must be documented and maintained on the site.

Your GE service representative can help you with establishing, 
performing and maintaining records for a quality assurance 
program. Contact GE for coverage and/or price for service.
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10-4 Maintenance task schedule

10-4-1 How often should maintenance tasks be performed?

The Care and Maintenance task schedule (provided in 
Table 10-1 on page 10-6) specifies how often your Versana 
Active should be serviced and outlines items requiring special 
attention.

NOTE: It is the customer’s responsibility to ensure the Versana Active 
care and maintenance is performed as scheduled in order to 
retain its high level of safety, dependability and performance.

Your GE Service Representative has an in-depth knowledge of 
your Versana Active and can best provide competent, efficient 
service. Contact GE for coverage information and/or price for 
service.

The service procedures and recommended intervals shown in 
the Care and Maintenance Task Schedule assumes that you 
use your Versana Active for an average patient load (depends 
on the clinical setting, typically daily or weekly) and not use it as 
a primary mobile Ultrasound system which is transported 
between diagnostic facilities.

NOTE: If conditions exist which exceed typical usage and patient load, 
then it is recommended to increase the periodic maintenance 
frequencies.

Table 10-1:  Customer Care Schedule 

Service at Indicated 
Time Daily Weekly Monthly

Per 
Facilities 

QA 
Program Notes

Clean Probes •* * or before each use

Inspect AC Mains Cable • Mobile Ultrasound 
system: Check 
Weekly

Inspect Cables and 
Connectors

•

Clean Console •
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NOTE: The maintenance may require specialized equipment to 
complete.

NOTE: The periodic maintenances are not mandatory. The table above 
is for reference only.

Clean Monitor •

Clean Filters •

Console Leakage Current 
Checks

See Notes Twice Annually

Peripheral Leakage 
Current Checks

See Notes Twice Annually

Surface Probe Leakage 
Current Checks

See Notes Twice Annually

Endocavity Probe Leakage 
Current Checks

See Notes Quarterly Annually

Surgical Probe Leakage 
Current Checks

See Notes Quarterly Annually

Measurement Accuracy 
Checks

See Notes Twice Annually

Functional Checks See Notes also after corrective 
maintenance

Table 10-1:  Customer Care Schedule  (Continued)

Service at Indicated 
Time Daily Weekly Monthly

Per 
Facilities 

QA 
Program Notes
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10-5 Tools required

NOTE: For a list of required tools for servicing the Versana Active, refer 
to chapter 8.

10-5-1 Standard GE tool kit

The following is a description of the “Standard” GE tool kit in the 
USA. Not all tools are required.

Table 10-2:  Overview of GE-1 tool kit contents 

Tool ID Description Tool ID Description

9-45358 Pliers Retaining Ring 9-XL9971MM Xcelite-hex Blade 1.27mm

9-4078 Scribe 9-XL9972MM Xcelite-hex Blade 1.5mm

9-44572 Wrench Open End 3/8 - 7/16 9-XL9973MM Xcelite-hex Blade 2 mm

9-44579 Wrench Open End 1/2 - 9/16 9-XL9974MM Xcelite-hex Blade 2.5mm

9-44579 Wrench Open End 1/2 - 9/16 9-XL9975MM Xcelite-hex Blade 3mm

9-45385 Pliers, Arc Joint 7 inch 9-XL9976MM Xcelite-hex Blade 4mm

9-45378 Pliers, Slip Joint 9-XL9977MM Xcelite-hex Blade 5mm

9-4518 Pliers, Long Nose, Miniature 9-XL991CM Handle

9-4518 Pliers, Long Nose, Miniature C2356E Screw starter - Kedman 
Quick Wedge

9-44776 Ignition Wrench Set, 10 pc. BLBO Box - 18 Compartment 

9-44601 Wrench, Adj., 4 inch DWL4283T Box - 5 Compartment

9-4151 Screwdriver, Blade, Stubby 9-41322 Pickup Tool, Claw type

9-41421 Screwdriver, Blade, Pocket 
clip

9-6757 6 pc Needle File Set

9-41594 Screwdriver, Blade 1/8 in. × 4 
in.

9-9487 Utility Knife

9-41581 Screwdriver, Blade 3/16 in. × 4 
in.

9-45341 Pliers Vice Grip 10 inch

9-39451 20' Steel Tape, locking Spring 
load

9-3001 Xacto Pen Knife
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9-GH807 Ratchet, Offset, Slotted 9-HT62002 Solder Aid, Fork and Hook

68-412 Ratchet, Offset, Phillips 9-4099 Mirror, Round, Telescoping

9-GH130 Tapered Reamer 9-GH3001 Steel Rule Decimal 6 inch

9-41584 Screwdriver, slotted 1/4 in. × 6 
in.

9-GH300ME Steel Rule Metric 6 inch

9-4118 Screwdriver, Phillips #2, 
Stubby

9-XL9920 Xcelite-hex Blade.050 inch

9-41293 Screwdriver, Phillips #0 9-XL9921 Xcelite-hex Blade 1/16 inch

9-41294 Screwdriver, Phillips #1 9-XL9922 Xcelite-hex Blade 5/16 inch

9-41295 Screwdriver, Phillips #2 9-XL9923 Xcelite-hex Blade 3/32 inch

9-46677 Hex Keys, 20 pc., Metric 9-XL9924 Xcelite-hex Blade 1/8 inch

9-34701 1/4 in. Standard Socket set (19 
pc)

9-XL9925 Xcelite-hex Blade 5/32 inch

9-43499 1/2 inch Socket 1/4 inch drive 9-XL9926 Xcelite-hex Blade 3/16 inch

9-4355 Flex Spinner 9-XL99764 Xcelite-hex Blade 7/64

9-43523 Breaker 9-XL99964 Xcelite-hex Blade 9/64

9-43531 6 inch Ext. 9-XLM60 Mini-screwdriver kit

9-65283 Case 8.5 in. × 4.5 in. × 2 in. 
Deep 

9-45072 Pliers 6 inch Diagonal

9-46696 Hex Keys 9-XL100X Wire Stripper/Cutter 5 inch - 
100X

9-39829 Torpedo Level, Magnetic 9-XL87CG Pliers - very fine needle 
nose-87CG

9-38461 Hammer, Ball Peen, 4 oz. 9-WEWDT-07 Weller-Soldering-Replacem
ent Tip(1)

9-4280 Universal Joint 1/4 inch 9-WS175-E Wiss - Surgical Scissors

9-WEW60P3 Weller - Soldering Iron, 3 wire KH174 Hemostat 5 inch Straight 

9-WECT5B6 Weller - Soldering Iron Tip KH175 Hemostat 5 inch curved

9-WEWDP12 Weller - Desoldering Pump 9-Z9480121 Alignment tool (red)

93383 Flashlight Mini-Mag Lite (AAA 
Bat.)

9-GH408 Tweezers

21576 Brush - Bristle

Table 10-2:  Overview of GE-1 tool kit contents  (Continued)

Tool ID Description Tool ID Description
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10-5-2 GE-2 tool kit

9-4516 Pliers 4 1/4 inch Diagonal

Table 10-3:  Overview of GE-2 tool kit contents 

GE-2 Sears Kit (#99034) 

Tool ID Description Tool ID Description

9-45381 Pliers, Arc Joint 9 1/2 inch 9-44067 Socket 1 1/16 in. for 1/2 in. 
drive

9-45092 Pliers, Linesman 8 1/2 inch 9-42679 Socket 10MM Hex for 1/2 in. 
drive (2273333) 

9-42882 Punch, Pin 3/32 inch 9-44262 Extension 10 inch for 1/2 in. 
drive (2273405)

9-42884 Punch, Pin 5/32 inch 9-4258 3/8 inch to 1/2 inch Adapter

9-42886 Punch, Pin 1/4 inch 9-34374 3/8 inch Metric Socket Set - 
12 PT

9-42973 Cold Chisel 1/2 inch 9-44311 16mm Socket 12 pt.

9-GH77 Center Punch Automatic 9-33485 Metal Socket Tray

9-GH890 File Handle, Adj. 9-33484 Metal Socket Tray

9-31276 File, Round, Bastard 8 inch 9-33484 Metal Socket Tray

9-31277 File, Half Round, Bastard 8 
inch

9-52068 Tap and Drill Set

9-31263 File, Flat Mill 8 inch 9-52722 #6 Tap

21045C Close Quarter Saw 9-52723 #8 Tap

9-44604 Wrench, Adj. 10 inch High Speed Drill Set

9-41587 Screwdriver 5/16 inch × 8 inch #36 Drill

9-41586 Screwdriver, Stubby 5/16 inch #29 Drill

9-GH19512 Countersink 1/2 inch 9-44046 3/8 inch Socket Set

9-44741 12 PC Combination Wrench 
Set

Table 10-2:  Overview of GE-1 tool kit contents  (Continued)

Tool ID Description Tool ID Description
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10-5-3 Special tools, supplies and equipment used for maintenance

Table 10-4:  Overview of tool requirements for periodic maintenance

Tool / kit Comments

Digital Volt Meter (DVM)

Anti Static Kit Kit includes anti–static mat, wrist strap and cables for 200 to 
240V system
3M #2204 Large adjustable wrist strap
3M #2214 Small adjustable wrist strap
3M #3051 conductive ground cord

Anti Static Vacuum Cleaner 120V
230V

Safety Analyzer The safety Analyzer tool should be calibrated and compliant 
with AAMI/ESI 1993 or IEC 60601 or AS/NZS 3551.

QIQ Phantom RMI Grayscale Target Model 403GS
NOTE! The use of a Phantom is not required during 
Preventive Maintenance. Customer may use it as part of 
their Quality Assurance Program tests.

B/W Printer Cleaning Sheet See printer user manual for requirements

Color Printer Cleaning Sheet See printer user manual for requirements

Disposable Gloves
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10-6 System maintenance

10-6-1 Preliminary checks

The preliminary checks take about 15 minutes to perform. Refer 
to the Ultrasound system user documentation whenever 
necessary.

Table 10-5:  System preliminary checks

Step Item Description

1. Ask and Listen Ask the customer if they have any problems or questions about the 
equipment.

2. Paperwork Fill in the top of Ultrasound Inspection Certificate (see Figure 10-5 on 
page 10-34). Record all probes and Ultrasound system options.

3. Power up • Turn the Ultrasound system power on and verify that all fans and 
peripherals turn on. 

• Watch the displays during power up to verify that no warning or error 
messages are displayed.

• Where applicable, confirm that the battery is charged. If no AC Input 
present, use the internal battery.  

4. Probes Verify that the Ultrasound system properly recognizes all probes.

5. Displays Verify proper display on the monitor.

6. FFA (server) Where applicable, for Warranty and Contract Customers only:
• Verify that InSite is functioning properly. 
• Ensure two-way remote communications.

7. Review Error Logs Where applicable, Error Logs can be reviewed via system diagnostics. 

8. Diagnostics Optional.

9. Presets Backup all Customer Presets to an appropriate media. 

10. Image Archive Back up the Image Archive onto appropriate media. 
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10-6-2 Functional checks

NOTE: See also Chapter 4

The functional checks take about 60 minutes to perform. Refer 
to the Ultrasound system user documentation whenever 
necessary.

10-6-2-1 System checks

Table 10-6:  System functional checks 

Step Item Description

1. B-Mode Verify basic B-Mode (2D) operation. Check the basic Ultrasound system 
controls that affect this mode of operation.

2. CF-Mode Verify basic CF-Mode (Color Flow Mode) operation. Check the basic 
Ultrasound system controls that affect this mode of operation.

3. Doppler Modes Verify basic Doppler operation (PW and CW if available). Check the basic 
Ultrasound system controls that affect this mode of operation.

4. M-Mode Verify basic M-Mode operation. Check the basic Ultrasound system 
controls that affect this mode of operation.

5. Probe Elements Perform an Element Test on each probe to verify that all the probe 
elements and system channels are functional. 

6. Applicable 
Software Options 

Verify the basic operation of all optional modes such as Contrast. Check 
the basic Ultrasound system controls that affect each options operation.

7. Xmit/Recv 
Elements

Use the Visual Channel Utility on the loop connect to verify that all system 
xmit/recv channels are functional.

8. Operator Panel 
test

Perform the Operator Panel Test Procedure.

9. Keyboard Do the interactive keyboard test.

10. Monitor Verify basic monitor display functions. Refer to Chapter 3 of the Basic 
User Manual.

11. Software Menu 
check

Verify Software Menu display functions. Refer to Chapter 3 of the Basic 
User Manual.

12. Peripherals See: 4-4-19 ‘Peripheral checks’ on page 4-70.

13. Measurements In measurement mode, make distance measurement, get result in result 
window. Verify the distance by graduate rule. Distance Accuracy should 
be within ±5%. (Name result from result window Result A, result from 
graduate rule Result B; Distance Accuracy = (Result B-Result A)/Result A)
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10-6-2-2 Peripheral/option checks

If any peripherals or options are not part of the system 
configuration, the check can be omitted. 

Refer to the User Manual for a list of approved peripherals/
options.

10-6-2-3 Mains cable inspection 

Table 10-7:  GE approved peripheral/hardware option functional checks

Step Item Description

1. Media Verify media drive(s) read/write properlty. Clean if necessary.

2. B/W Printer Verify hardcopy output of the B/W video page printer. Clean heads and 
covers if necessary.

3. Color Printer Verify hardcopy output of the Color video page printer. Clean heads and 
covers if necessary.

4. DICOM Verify that DICOM is functioning properly. Send an image to a DICOM 
device.

5. ECG Verify basic operation with customer

6. Footswitch Verify that the footswitch is functioning as programed. Clean as necessary. 

7. DVD Verify that the DVD is functioning properly. Clean heads and covers if 
necessary.

Table 10-8:  Mains Cable Inspection, As Appropriate

Step Item Description

1. Unplug Cord Disconnect the mains cable from the wall and Ultrasound system.

2. Inspect Inspect it and its connectors for damage of any kinds.

3. Verify Verify that the LINE, NEUTRAL and GROUND wires are properly attached 
to the terminals, and that no strands may cause a short circuit.

4. Verify Inlet connector retainer is functional.
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10-6-2-4 Cleaning

For general cleaning of the system, we recommended to use 
non-abrasive soap and water solution.

Table 10-9:  General Cleaning

Step Item Description

1. Console Remove the battery. Use a fluid detergent in warm water on a soft, damp 
cloth to carefully wipe the entire system. Be careful not to get the cloth too 
wet so that moisture does not enter the console.

2. Probe Holder Clean probe holders. (they may need to be soaked to remove excess gel).

3. Monitor Use a soft, non-abrasive folder cloth. Gently wipe the monitor face. DO 
NOT use a glass cleaner that has a hydrocarbon base (such as Benzene, 
Methy Alcohol or Methy Ethyl Ketone) on monitor with the filter (anti-glare 
shield).

Table 10-10:  Compatible Chemicals for Cleaning

System 
Cabinet

Operator 
Control Panel

Main 
display

Cart (top table/
body/base)

Cleaning agents

PDI Easy Screen Cleaning Wipe X X X X

70% isopropyl alcohol X X X X

Wet Wipe X X X X

Disinfectants [1]

PDI Sani-Cloth Plus X X X X

Protex X X X X

Tristel Wipes X X X X

Sono Ultrasound Wipes X X X X

Clorox wipes X X X X

CaviWipes X X X X

PDI Sani-Cloth HB X X X X

PDI Super Sani-Cloth Plus X X X X

[1]: Effective Disinfection is always a balance between safe inactivation of infectious agents and undesirable side 
effects. Due to the generally uneven and irregular surface of Ultrasound consoles, a comprehensive surface 
disinfection process cannot be recommended by the manufacturer.
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10-6-3 Physical inspection

NOTE: These features may not be present on all Ultrasound systems.  

Table 10-11:  Physical checks 

Step Item Description

1. Labeling Verify that all Ultrasound system labeling is present and in readable 
condition.

2. Scratches & Dents Inspect the exterior for dents, scratches or cracks.

3. Input Power Refer to: 10-6-2-3 ‘Mains cable inspection’ on page 10-14.

4. Cables & 
Connectors

Check all internal cable harnesses and connectors for wear and secure 
connector seating. Pay special attention to footswitch assembly and probe 
strain or bend reliefs.

5. Shielding & 
Covers

Check to ensure that all EMI shielding, internal covers, air flow panels and 
screws are in place. Missing covers and hardware could cause EMI/RFI 
problems while scanning.

6. Control Panel Inspect keyboard and control panel. Note any damaged or missing items.

7. Control Panel 
Lighting

Check for proper operation of all operator panel and Freeze Key light.

8. Monitor Inspect the monitor Display for scratches and bad pixels.
Verify proper operation of Contrast and Brightness controls. 
Where applicable, confirm that the monitor arm allows:
• swivelling the screen to the left and to the right
• folding the screen to the locked position
• release and adjustment backwards and forwards
• can be adjusted in the up/down positions.
Note: Monitor Arm movement may vary and is not applicable to all 
Ultrasound systems. 

9. External I/O Check all connectors for damage.

10. Power and 
System Status 
Indicators

Check for proper operation of all Power and System Status Indicators.

11. Battery Where applicable, check that the battery is not damaged, does not leak, 
does not emit an odor, and is not deformed or discolored. Observe all 
warnings and cautions for battery handling, recharging, storing, and/or 
disposal,
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10-6-4 Optional Diagnostic Checks

Optionally you can access the diagnostic software as described 
in Chapter 5 or 7. View the error logs and run desired 
diagnostics.

10-6-4-1 View the Log

1. Review the system error log for any problems.
2. Check the temperature log to see if there are any trends that 

could cause problems in the future.
3. Check the Configuration Log; update if needed.
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10-6-5 Probe maintenance

10-6-5-1 Probe related checks

10-6-5-2 Basic probe care

The Ultrasound system user manuals and various probe 
handling cards provide a complete description of probe care, 
maintenance, cleaning and disinfection. Ensure that you are 
completely familiar with the proper care of GE probes.

Ultrasound probes can be easily damaged by improper 
handling. See the User Manual and probe care cards for more 
details. Failure to follow these precautions can result in serious 
injury and equipment damage. Failure to properly handle or 
maintain a probe may also void its warranty.

Any evidence of wear indicates the probe cannot be used.

Do a visual check of the probe pins and Ultrasound system 
sockets before plugging in a probe.

The Interoperative probes often have special considerations and 
individual probe user manuals. For Interoperative probes also 
refer to their separate user manuals.

Table 10-12:  System preliminary checks

Step Item Description

1. Probe Holder Clean probe holders. (they may need to be soaked to remove excess gel).

2. Probes Thoroughly check the Ultrasound system probe connectors and remove 
dust from inside the connector sockets if necessary. Visually check for 
bent, damaged or missing pins.

3. Probes Verify that the Ultrasound system properly recognizes all probes.
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10-6-5-3 Basic probe cleaning

To clean the probe:

1. Disconnect the probe from the ultrasound console and 
remove all coupling gel from the probe by wiping with a soft 
cloth and rinsing with flowing water.

2. Wash the probe with mild soap in lukewarm water. Scrub the 
probe as needed using a soft sponge, gauze, or cloth to 
remove all visible residue from the probe surface. Prolonged 
soaking or scrubbing with a soft bristle brush (such as a 
toothbrush) may be necessary if material has dried onto the 
probe surface.

3. Rinse the probe with enough clean potable water to remove 
all visible soap residue.

4. Air dry or dry with a soft cloth.

CAUTION Do not submerge the probe above the probe as the strain relief 
is not sealed. Do not allow fluid into or onto the connector of 
the probe.

CAUTION Take extra care when handling the lens face of the Ultrasound 
transducer. The lens face is especially sensitive and can easily 
be damaged by rough handling. NEVER use excessive force 
when cleaning the lens face.

WARNING To help protect yourself from blood borne diseases, wear 
approved disposable gloves. These are made of nitrile derived 
from vegetable starch to prevent allergic latex reactions.

CAUTION Failure to follow the prescribed cleaning or disinfection 
procedures will void the probe’s warranty. 

DO NOT soak or wipe the lens with any product not listed in the 
User Manual. Doing so could result in irreparable damage to 
the probe. 

Follow care instructions that came with the probe.

CAUTION Disinfect a defective probe before you return it. Be sure to tag 
the probe as being disinfected.
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10-6-5-4 Disinfecting probes

Ultrasound probes can be disinfected using liquid chemical 
germicides. The level of disinfection is directly related to the 
duration of contact with the germicide. Increased contact time 
produces a higher level of disinfection.

For information about probe disinfectants, please refer to the 
latest version of the ultrasound system user manuals.

CAUTION Review the probe care card that is packed with each probe. 
The following website contains the most current and up-to-date 
recommendations:

http://www.gehealthcare.com/usen/ultrasound/products/
probe_care.html
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10-7 Electrical safety tests

10-7-1 Safety test overview

The electrical safety tests in this section are based on and 
conform to IEC 60601-1 Medical Equipment Safety Standards. 
They are intended for the electrical safety evaluation of 
cord-connected, electrically operated, patient care equipment. If 
additional information is needed, refer to the IEC 60601-1 
documents

WARNING THE USER MUST ENSURE THAT THE SAFETY 
INSPECTIONS ARE PERFORMED AT LEAST EVERY 
12 MONTHS ACCORDING TO HISTORICAL DATA. 
ONLY TRAINED PERSONS ARE ALLOWED TO 
PERFORM THE SAFETY INSPECTIONS MENTIONED 
ABOVE.

DANGER TO MINIMIZE RISK OF ELECTRICAL SHOCK, ONLY 
TRAINED PERSONS ARE ALLOWED TO PERFORM THE 
ELECTRICAL SAFETY INSPECTIONS AND TESTS.

DANGER TO AVOID ELECTRICAL SHOCK, THE ULTRASOUND 
SYSTEM UNDER TEST MUST NOT BE CONNECTED TO 
OTHER ELECTRICAL EQUIPMENT. REMOVE ALL 
INTERCONNECTING CABLES AND WIRES. THE 
ULTRASOUND SYSTEM UNDER TEST MUST NOT BE 
CONTACTED BY USERS OR PATIENTS WHILE 
PERFORMING THESE TESTS.

CAUTION Possible risk of infection. Do not handle soiled or contaminated 
probes and other components that have been in patient 
contact. Follow appropriate cleaning and disinfecting 
procedures before handling the equipment.
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10-7-1 Safety test overview(continued)

Prior to initiating any electrical test, the Ultrasound system must 
be visually inspected. Perform the following visual checks:

• Check for missing or loose enclosure covers that could 
allow access to internal live parts.

• Examine the mains cord, mains plug and appliance inlet for 
damaged insulation and adequacy of strain relief and cable 
clamps.

• Locate and examine all associated transducers. Inspect the 
cables and strain relief at each end. Inspect the transducer 
enclosure and lens for cracks, holes and similar defects.

Test the system, peripherals and probes for leakage current. 
Excessive leakage current can cause injury or death in sensitive 
patients. High leakage current can also indicate degradation of 
insulation and a potential for electrical failure. Do not use probes 
or equipment having excessive leakage current.

To minimize the risk that a probe may shock someone the 
customer should:

• Not use a probe that is cracked or damaged in any way.
• Check probe leakage current:

• Based on your facilities QA program for surface probes.
• Based on your facilities QA program for endocavitary 

probes.
• whenever probe damage is suspected.
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10-7-2 Leakage current limits

The following limits are summarized for IEC 60601-1 Medical 
Equipment Safety Standards. These limits are GEMS standards 
and in some cases are lower than the above standards listed.

WARNING Energy Control and Power Lockout for Versana Active.

When servicing parts of the Ultrasound system where there is 
exposure to voltage greater than 30 volts:

1. Follow LOCK OUT/TAG OUT procedures. 
2. Turn off the breaker.
3. Unplug the Ultrasound system.
4. Maintain control of the Ultrasound system power plug.
5. Wait for at least 30 seconds for capacitors to discharge as 

there are no test points to verify isolation.   
6. Remove/disconnect the battery, if present. 

Ultrasound System components may be energized. 

CAUTION Compare all safety-test results with safety-test results of 
previously performed safety tests (e.g. last year etc). In case of 
unexplainable abrupt changes of safety-test results consult 
experienced authorized service personnel or GE for further 
analysis. 

Table 10-13:  Chassis Leakage Current Limits - Accessible Metal Surface

Country
Normal 

Condition Open Ground
Reverse 
Polarity Open Neutral

All (Except USA & 
Canada)

0.1 mA 0.5 mA 0.5 mA 0.5 mA

USA & Canada 0.1 mA 0.3 mA 0.3 mA 0.3 mA

Table 10-14:  Type BF Applied Part Leakage Current Limits - Probes Surface

Country
Normal 

Condition
Open 

Ground
Reverse 
Polarity

Open 
Neutral

*Mains 
Applied

All 0.1 mA 0.5 mA 0.5 mA 0.5 mA 5.0 mA
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10-7-2 Leakage current limits(continued)

NOTE: *Mains Applied refers to the sink leakage test where mains 
(supply) voltage is applied to the part to determine the amount of 
current that will pass (or sink) to ground if a patient contacted 
mains voltage.

The following tests are performed at the factory and should be 
performed at the site. These tests are: chassis leakage current, 
and probe leakage current. All measurements are made with an 
electrical safety analyzer which should be calibrated and 
compliant with AAMI/ESI 1993 or IEC 60601 or AS/NZS 3551.

Table 10-15:  Type CF Applied Part Leakage Current Limits - ECG Connections

Country
Normal 

Condition
Open 

Ground
Reverse 
Polarity

Open 
Neutral

*Mains 
Applied

All 0.1 mA 0.5 mA 0.5 mA 0.5 mA 5.0 mA

Table 10-16:  Equipment Type and Test Definitions 

Applied 
Parts 
(AP)

Parts or accessories that contact the patient to 
perform their function. For ultrasound equipment, 
this includes transducers and ECG leads.

Type BF Body Floating or 
non-conductive ultrasound 
probes which are marked 
with the 'man in box' BF 
symbol. this includes all 
transducers.

Type CF Cardiac Floating or 
non-conductive 
intraoperative probes for 
direct cardiac contact and 
isolated ECG connections 
so marked with the 'heart in 
box' CF symbol.

Sink 
Leakage

The current resulting from the application of mains 
voltage to the applied part. This test is required 
test for Type CF applied parts.
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10-7-3 Outlet test - wiring arrangement

Test all outlets in the area for proper grounding and wiring 
arrangement by plugging in the neon outlet tester and noting the 
combination of lights that are illuminated. Any problems found 
should be reported to the hospital immediately and the 
receptacle should not be used.

 Figure 10-1. Typical alternate outlet tester

NOTE: No outlet tester can detect the condition where the Neutral 
(grounded supply) conductor and the Grounding (protective 
earth) conductor are reversed. If later tests indicate high leakage 
currents, this should be suspected as a possible cause and the 
outlet wiring should be visually inspected.

CORRECT WIRING OPEN GROUND WIRE

REVERSED POLARITY OPEN NEUTRAL WIRE

HOT AND GROUND 
REVERSED

OPEN HOT WIRE
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10-7-4 Grounding continuity

Measure the resistance from the third pin of the attachment plug 
to the exposed metal parts of the case. The ground wire 
resistance should be less than 0.2 ohms. Reference the 
procedure in the IEC60601-1.

NOTE: User needs to unscrew the GROUND PIN before releasing the 
Versana Active.

Figure 10-2. Ground continuity test

DANGER ELECTRIC SHOCK HAZARD. THE PATIENT MUST NOT BE 
CONTACTED TO THE EQUIPMENT DURING THIS TEST.

1. GROUND PIN
2. OHMMETER
3. Versana Active
4. ACCESSIBLE METAL PART:

• MONITOR HOUSING
• PEAR PANEL CONNECTOR
• ANY CASTER/WHEEL SUPPORT



Electrical safety tests

Versana Active – Basic Service Manual 10-27
5840775-100 English Rev.10

10-7-5 Chassis leakage current test

10-7-5-1 Generic procedure

The test verifies the isolation of the power line from the chassis. 
The testing meter is connected from accessible metal parts of 
the case to ground. Measurements should be made with the unit 
ON and OFF, with the power line polarity Normal and Reversed. 
Record the highest reading of current.

 Figure 10-3. Set Up for Chassis Source Leakage Current, IEC 601-1 Clause 19 - 
Continuos Leakage Currents and Patient, Auxiliary Currents

When using the Microguard or a similar test instrument, its 
power plug may be inserted into the wall outlet and the 
equipment under test is plugged into the receptacle on the panel 
of the meter. This places the meter in the grounding conductor 
and the current flowing from the case to ground will be indicated 
in any of the current ranges. The maximum allowable limit for 
chassis source leakage is shown in Table 10-13 on page 10-23.

DANGER ELECTRIC SHOCK HAZARD. WHEN THE METER'S 
GROUND SWITCH IS OPEN, DON'T TOUCH THE 
ULTRASOUND SYSTEM!.

CAUTION Equipment damage possibility. Never switch the Polarity and 
the status of Neutral when the Ultrasound system is powered 
ON. Be sure to turn the Ultrasound system power OFF before 
switching them using the POLARITY switch and/or the 
NEUTRAL switch. Otherwise, the Ultrasound system may be 
damaged.
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10-7-5-2 Data Sheet for enclosure Source Leakage Current

The test passes when all readings measure less than the value 
shown in Table 10-13 on page 10-23. Record all data on the PM 
Inspection Certificate.

Table 10-17:  Typical Data Sheet for enclosure Source Leakage Current

Unit 
Power

Tester 
Polarity 
Switch

Tester 
Neutral 

or 
Ground 
Switch

Test 1 
Speaker 
Cover

Test 2 Real 
Panel Metal 

Parts
Optional 

Test 3 
Optional 

Test 4

Enter Name of tested peripheral here:

ON NORM OPEN

ON NORM CLOSED

ON REV OPEN

ON REV CLOSED

OFF NORM OPEN

OFF NORM CLOSED

OFF REV OPEN

OFF REV CLOSED
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10-7-6 Probe leakage current test

10-7-6-1 Definition

This test measures the current that would flow to ground from 
any of the probes through a patient who is being scanned and 
becomes grounded by touching some other grounded surface.

NOTE: Some leakage current is expected on each probe, depending on 
its design. Small variations in probe leakage currents are normal 
from probe to probe. Other variations will result from differences 
in line voltage and test lead placement. It is abnormal if no 
leakage current is measured. If no leakage current is detected, 
check the configuration of the test equipment.

10-7-6-2 Tools

For needed tools, see: 10-5 ‘Tools required’ on page 10-8.

DANGER
 

DO NOT USE THE PROBE IF THE INSULATING MATERIAL 
HAS BEEN PUNCTURED OR OTHERWISE COMPROMISED.

INTEGRITY OF THE INSULATION MATERIAL AND PATIENT 
SAFETY CAN BE VERIFIED BY SAFETY TESTING 
ACCORDING TO IEC60601-1.

CAUTION Equipment damage possibility. Never switch the Polarity and 
the status of Neutral when the Ultrasound system is powered 
ON. Be sure to turn the Ultrasound system power OFF before 
switching them using the POLARITY switch and/or the 
NEUTRAL switch. Otherwise, the Ultrasound system may be 
damaged.
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10-7-6-3 Generic procedure on probe leakage current

Measurements should be made with the ground open and 
closed, with power line polarity normal and reversed, and with 
the unit Off and On. For each combination, the probe must be 
active to find the worst case condition.

 Figure 10-4. Set up for probe leakage current

NOTE: Each probe will have some amount of leakage current, 
dependent on its design. Small variations in probe leakage 
currents are normal from probe to probe. Other variations will 
result from differences in line voltage and test lead placement.

10-7-6-4 Meter Procedure Using Probe Adapter

Follow the Safety Analyzer tool instruction to test each 
transducer for leakage current.

The electrical Safety Analyzer tool should be calibrated and 
compliant with AAMI/ESI 1993 or IEC 60601 or AS/NZS 3551.

POWER
OUTLET

H   (BLACK)
POLARITY REVERSING SWITCH

MOMENTARY
SWITCH

N   (WHITE)

G   (GREEN)

LEAKAGE TEST
METER

CONSOLE

PROBE

DANGER TO AVOID PROBE DAMAGE AND POSSIBLE ELECTRIC 
SHOCK, DO NOT IMMERSE PROBES INTO ANY LIQUID 
BEYOND THE LEVEL INDICATED IN THE PROBE USERS 
MANUAL. DO NOT TOUCH THE PROBE, CONDUCTIVE 
LIQUID OR ANY PART OF THE UNIT UNDER TEST WHILE 
DOING THE TEST.
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10-7-6-5 No Meter Procedure Using Probe Adapter

Follow the Safety Analyzer tool instruction to test each 
transducer for leakage current.

The electrical Safety Analyzer tool should be calibrated and 
compliant with AAMI/ESI 1993 or IEC 60601 or AS/NZS 3551.

10-7-6-6 Data Sheet for Transducer Source Leakage Current

The test passes when all readings measure less than the values 
shown in Table 10-14 on page 10-23. Record all data on the PM 
Inspection Certificate.

CAUTION Equipment damage possibility. Never switch the Polarity and 
the status of Neutral when the Ultrasound system is powered 
ON. Be sure to turn the Ultrasound system power OFF before 
switching them using the POLARITY switch and/or the 
NEUTRAL switch. Otherwise, the Ultrasound system may be 
damaged.

Table 10-18:  Typical Data Sheet For Transducer Source Leakage Current

Transducer Tested:

 Unit Power
Tester Power Polarity 

Switch
Tester GROUND or 
NUETRAL Switch Measurement

ON NORM OPEN

ON NORM CLOSED

ON REV OPEN

ON REV CLOSED

OFF NORM OPEN

OFF NORM CLOSED

OFF REV OPEN

OFF REV CLOSED
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10-8 When there's too much leakage

current …

10-8-1 AC/DC Fails

Where applicable, check the AC/DC adapter and its cable. 
Replace a new one if any portion is defective.

10-8-2 Chassis Fails

Check the ground on the power cord and plug for continuity. 
Ensure the ground is not broken, frayed, or intermittent. Replace 
any defective part.

Where applicable, tighten all grounds. Ensure star washers are 
under all ground studs.

Inspect wiring for bad crimps, poor connections, or damage.

Test the wall outlet; verify it is grounded and is free of other 
wiring abnormalities. Notify the user or owner to correct any 
deviations. As a work around, check the other outlets to see if 
they could be used instead.

NOTE: No outlet tester can detect the condition where the white neutral 
wire and the green grounding wire are reversed. If later tests 
indicate high leakage currents, this should be suspected as a 
possible cause and the outlet wiring should be visually 
inspected.
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10-8-3 Probe Fails

Test the probe in another connector to isolate if the fault lies with 
the probe or the Ultrasound system. Or Change another probe 
to confirm if the fail is caused by console.

NOTE: Each probe will have some amount of leakage, dependent on its 
design. Small variations in probe leakage currents are normal 
from probe to probe. Other variations will result from differences 
in line voltage and test lead placement. The maximum allowable 
leakage current for body surface contact probe differs from 
inter-cavity probe. Be sure to enter the correct probe type in the 
appropriate space on the check list.

If excessive leakage current is slot dependent, inspect the 
system connector for bent pins, poor connections, and ground 
continuity.

If the problem remains with the probe, replace the probe.

10-8-4 Peripheral Fails

Tighten all grounds. Ensure star washers are under all ground 
studs.

Inspect wiring for bad crimps, poor connections, or damage.

10-8-5 Still Fails

If all else fails, begin isolation by removing the probes, external 
peripherals, then the on board ones, one at a time while 
monitoring the leakage current measurement.

10-8-6 New Unit

If the leakage current measurement tests fail on a new 
Ultrasound system and if situation can not be corrected, submit 
a Safety Failure Report to document the Ultrasound system 
problem. Remove Ultrasound system from operation.

10-8-7 ECG Fails

Inspect cables for damage or poor connections.
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10-9 Inspection Paperwork

10-9-1 Ultrasound Inspection Forms

 Figure 10-5. Ultrasound Inspection Certificate

* Scan Format: Phased Array, Linear Array, Curved Array, 
Mechanical Array or Other

ULTRASOUND INSPECTION CERTIFICATE  

* Scan Format: Phased Array, Linear Array,  Curved Array, Mechanical Array or Other

rebmuN hctapsiD:DI metsyS:emaN remotsuC  / Date Performed: Warranty/C ontract/HBS

System Type :etaD erutcafunaM:rebmuN laireS:rebmuN ledoM

:rebmuN laireS:rebmuN ledoM:*tamroF nacS:ycneuqerF:1 eborP

:rebmuN laireS:rebmuN ledoM:*tamroF nacS:ycneuqerF:2 eborP

:rebmuN laireS:rebmuN ledoM:*tamroF nacS:ycneuqerF:3 eborP

:rebmuN laireS:rebmuN ledoM:*tamroF nacS:ycneuqerF:4 eborP

:rebmuN laireS:rebmuN ledoM:*tamroF nacS:ycneuqerF:5 eborP
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10-9-1 Ultrasound Inspection Forms(continued)

 Figure 10-6. Functional Checks

 Figure 10-7. Electrical Safety

FUNCTIONAL CHECKS  SPECTION AND CLEANING 

COMMENTS: 
_________________________ ____________________________ _________________________
_________________________ ____________________________ _________________________
_________________________ ____________________________ _________________________
_________________________ ____________________________ _________________________

Functional Check (if applicable)
OK? or 

N/A
Physical Inspection and Cleaning 

(if applicable) Inspect Clean

elosnoCnoitcnuF edoM-B

DCLnoitcnuF sedoM relppoD

O/I lanretxEnoitcnuF edoM-FC

srotcennoC dna selbaCnoitcnuF edoM-M

Applicable Software Opti larehpireP devorppA EGsno s (DVD-RW, Printer)

ilebaLsnoitpO erawdraH elbacilppA ng (see User Manual for Labeling)

Control Panel

LCD

Measurement Accuracy

GE Approved Peripherals

PHYSICAL IN

ELECTRICAL SAFETY

Final Check. All system covers are in place. System scans with all probes as expected.

Accepted by: ______________________________________________________________________

Electrical Test Performed
Max Value 

Allowed
Value 

Measured OK? Comments

Outlet (correct ground &wiring config.)

Type BF Applied Part Leakage Current 
Limits- Probe

enclosure Source Leakage Current - 
Chassis Leakage Current Limits

Peripheral 1 Leakage Current

Peripheral 2 Leakage Current

PROBES

Probe Number 
(from previous page)

Max Value 
Allowed

Max Value 
Measured OK? Comments

Probe 1:

Probe 2:

Probe 3:
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10-10 Electrical Safety Tests Log

Table 10-19:  Electrical safety tests log 

Electrical test 
performed

Max 
value 
allowed

Value 
measured

OK? Comments

Outlet (correct ground 
and wiring config.)

System ground 
continuity

Chassis source 
leakage current - 
probe

Chassis source 
leakage current - 
wheel

Chassis source 
leakage current - 
monitor

Patient lead source 
leakage (lead to 
ground)

Patient lead source 
leakage (lead to lead)

Patient lead source 
leakage (isolation)

Peripheral 1 leakage 
current

Peripheral 1 ground 
continuity

Peripheral 2 leakage 
current
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Peripheral 2 ground 
continuity

Peripheral 3 leakage 
current

Peripheral 3 ground 
continuity

Table 10-19:  Electrical safety tests log  (Continued)

Electrical test 
performed

Max 
value 
allowed

Value 
measured

OK? Comments

Table 10-20:  Electrical safety tests (probes) log 

Probe

Max 
value 
allowed

Max value 
measured

OK? Comments
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Index

A
abbrevations, 9-3
acclimate time, 2-3
air filter

removing, 4-32
authorized representative in EU, 1-30
average setup time, 3-3

B
before installation (site preparations), 2-1
Boot Up, 3-20
Buttons screen

Connectivity, 3-89

C
cable inspection

mains cable inspection, 10-14
Care and maintenance

cleaning the system
operator controls, 4-35

care and maintenance, 10-1
warnings, 10-3

CE compliance, 1-26
change history, i-1
chapter 1

introduction, 1-1
chassis leakage current test, 10-27
cold or hot

if the unit is very cold or hot, 2-3
compatibility

hardware/software, 9-4
completing the setup, 3-14
compliance, 1-26
configuration, 3-21
connect

ethernet, 3-19
probe, 3-20
USB flash card, 3-19

connections
on the rear panel, 3-19

Connectivity
Buttons, 3-89

console environmental requirements, 2-3
console requirements, 2-3
contact information, 1-28

contents in this manual, 1-3
conventions used in book, 1-6
cooling, 2-5
copyrights, i-18
customer assistance, 1-28

phone numbers, 1-29
customer order

verification, 3-13
customer provided prerequisite, 8-9

D
damage

in transportation, 3-7
damage in transport, i-16
dangerous procedure warnings, 1-23
data network setup requirements, 2-18
desirable features, 2-14
DICOM network function, 2-18
DICOM setup requirements, 2-19
display PDF files

from manual CD-ROM
print PDF files

from manual CD-ROM, 4-29

E
electrical requirements, 2-6

EMI limitations
EMI limitations, 2-8

general requirements, 2-6
site circuit breaker

site circuit breaker, 2-7
site power outlets

site power outlets, 2-7
specific requirements for the unit, 2-6
unit power plug

unit power plug, 2-7
electrical safety, 1-19
electrical safety tests, 10-21
electrical specification, 3-16
electromagnetic interference

abatement, 2-9
prevention, 2-9

electrostatic discharge prevention, 1-27
EMC, 1-26

compliance, 1-26
what is EMC?, 1-26
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EMI, 1-26
abatement, 2-9
prevention, 2-9
protection, 3-13

environmental dangers, 2-21
environmental specifications for the unit, 2-4
errors, i-17
ESD, 1-26
ESD prevention, 1-27
ethernet

connect, 3-19
examine packages, 3-7
external I/O

connections, 3-19

F
facility needs, 2-11

desirable features, 2-14
DICOM network function, 2-18
DICOM setup requirements, 2-19
InSite requirements, 2-18
network setup requirements, 2-18
purchaser responsibilities, 2-12
recommended floor plan suggestion, 2-16
required facility needs, 2-13
suggested floor plan

scanner and EchoPAC in same room, 2-17
flash card

connect, 3-19
floor plan suggestion

recommended, 2-16
scanner and EchoPAC in same room, 2-17

functional checks, 10-13
mains cable inspection, 10-14
system checks, 10-13

G
GE Healthcare leakage current limits, 10-23
general console requirements, 2-3
generic procedure on probe leakage current, 10-30
grounding continuity, 10-26

H
hardware/software compatibility, 9-4
hardware-software

compatibility, 5-3, 5-6
hot or cold

if the unit is very cold or hot, 2-3
how often should maintenance tasks be performed?, 
10-6
human safety, 1-13

I
icons, 1-6
icons indicating a special procedure to be used, 1-9

if the unit is very cold or hot, 2-3
important precautions, i-3
InSite

network requirements, 2-18
installation

see "system setup", 3-1
installation warnings

see "setup warnings", 3-3
introduction (chapter 1), 1-1

L
legal notes, i-18
lighting, 2-5
list of abbrevations, 9-3
loading software, 8-9
lockout/tagout (LOTO) requirements, 1-24
LOTO

lockout/tagout requirements, 1-24

M
mains cable inspection, 10-14
maintenance

physical inspection, 10-16
preliminary checks, 10-12
system maintenance, 10-12

maintenance task schedule, 10-6
manufacturer, 1-29
mass

with monitor and peripherals, 3-15
mechanical safety, 1-16
model designations, 1-6
models covered by this manual, 1-4

N
network setup requirements, 2-18

O
omission and errors, i-17
operational and storage temperature for probes, 2-10
Operator controls, 4-35

P
packing materials

recycling information, 3-12
paperwork

after setup, 3-104
PDF files

display and print, 4-29
periodic maintenance inspection (PM), PM (periodic 
maintenance inspection), 10-4
phone numbers

customer assistance, 1-29
physical dimensions, 3-15
physical inspection
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at arrivel, 3-13
Power On, 3-20
precautions

certified electrical contractor statement, i-16
damage in transport, i-16
important precautions, i-3
service safety considerations, i-17
translation policy, i-3

prepeare for setup, 3-13
prerequisite

provided by customer, 8-9
print keys

assigning to a device or dataflow, 3-89
probe

connect, 3-20
probe cleaning, 10-19
probe leakage current test, 10-29
probe maintenance, 10-18

basic probe care, 10-18
basic probe cleaning, 10-19
probe related checks, 10-18

probe related checks, 10-18
probes environmental requirements, 2-10

operational and storage temperature for probes, 
2-10

product icons, 1-10
product locator installation card, 3-105
products covered by this manual, 1-4
proprietary to GE Healthcare, i-18
Purchaser responsibilities, 2-12

R
rear panel

connections, 3-19
receiving and unpacking, 3-6
receiving the product, 3-7
recycling information

packing materials, 3-12
removable media

verifying, 3-92
required facility needs, 2-13
requirements, 2-3
requirements verification, 3-15
returning/shipping probes and repair parts, 1-25
revision history, i-1

S
safety

human, 1-13
safety precaution messages, 1-7
safety test overview, 10-21
service safety considerations, i-17
setup

completion, 3-14
preparations, 3-13
reminders, 3-3

setup time, 3-3
setup warnings, 3-3
shipping/returning probes and repair parts, 1-25
site preparations, 2-1

time and manpower requirements, 2-10
software loading, 8-9
software/hardware compatibility, 9-4
software-hardware

compatibility, 5-3, 5-6
specifications, 3-15

electrical specifications, 3-16
physical dimensions, 3-15

standard GE tool kit, 10-8
standard hazard icons, 1-8
statement

certified electrical contractor statement, i-16
system

specifications, 3-15
system checks, 10-13
system maintenance, 10-12

physical inspection, 10-16
preliminary checks, 10-12

system manufacturer, 1-29
system requirements verification, 3-15
system setup, 3-1

T
time and manpower requirements

site preparations, 2-10
tools required, 10-8

special tools, supplies and equipment, 10-11
standard GE tool kit, 10-8

trademarks, i-18
translation policy, i-3
transport

damage, i-16
typical users of the service manual, 1-4

U
unpacking, 3-6
unpacking instructions, 3-8
USB

flash card
connect, 3-19

V
verification

system requirements, 3-15
verify customer order, 3-13
verifying

removable media, 3-92
voltage settings, 3-16

W
warnings, 10-3
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dangerous procedures, 1-23
receiving and unpacking, 3-6

what is EMC?, 1-26
when there’s too much leakage current, 10-32

chassis fails, 10-32
ECG fails, 10-33
new unit, 10-33
peripheral fails, 10-33
probe fails, 10-33
still fails, 10-33
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